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Please be sure to read this manual before using this product. 
Keep this manual in a safe place for future use. 
This printer should only be used by operators who are appropriately trained in its safe 
operation. 
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When you dispose of the machine  

Required Tools 
Phillips screwdriver: M3 to M5 
 
 

Disassembling 

(1) Remove the Cover of BACK SIDE bottom center. 

 

 

(2) Remove the Lithium Battery (1) by pulling out the holder in the direction of the arrow. 

 

 

(3) Pickup the Lithium Battery (1) to the direction of the arrow. 

 
 
 
 

(1)

(1) 

Note based on California law (USA) on the use and handling of Perchlorate 

This product contains a CR Coin Lithium Battery which contains Perchlorate Material – special handling may 
apply. 
See http://www.dtsc.ca.gov/hazardouswaste/perchlorate. 

http://www.dtsc.ca.gov/hazardouswaste/perchlorate
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SAFETY INSTRUCTIONS  

Thank you very much for buying a BROTHER printer. 
Before using your new printer, please read the "SAFETY INSTRUCTIONS" and handling instructions carefully. 

 

1. Safety indications and their meanings 

This instruction manual and the indications and symbols that are used on the printer itself are provided in order to ensure 
safe operation of this printer and to prevent accidents and injury to yourself or other people. 
The meanings of these indications and symbols are given below. 

 
Indications 

 DANGER The instructions which follow this term indicate situations where failure to follow the 
instructions will result in death or serious injury. 

 WARNING The instructions which follow this term indicate situations where failure to follow the 
instructions could result in death or serious injury. 

 CAUTION The instructions which follow this term indicate situations where failure to follow the 
instructions may result in minor or moderate injury. 

 

 IMPORTANT The instructions which follow this term indicate situations where failure to follow the 
instructions may result in damage to property. 

 NOTE The instructions which follow this term indicate precautions and restrictions for use. 

 
Symbols 

 · · · · ·  
This symbol ( ) indicates something that you should be careful of. 
The picture inside the triangle indicates the nature of the caution that must be taken. (For 
example, the symbol at left means "beware of injury".) 

 · · · · ·  This symbol ( ) indicates something that you must not do. 

 · · · · ·  
This symbol ( ) indicates something that you must do. 
The picture inside the circle indicates the nature of the thing that must be done. (For example, 
the symbol at left means "you must make a ground connection".) 

 
 

2. Notes on safety 

 DANGER 

 
Contact with high voltage sections may lead to a serious injury. Turn off the power, and remove the cover 5 
minutes later. 
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SAFETY INSTRUCTIONS

 

 WARNING 

Basic precautions 

 
This printer should only be used by operators who are appropriately trained in its safe operation. 

 
The printer is not suitable for use in places where children are present. 

 

 

 

To prevent accidents and problems, do not modify the machine by yourself. Brother will not be held 
responsible for any accidents or problems resulting from modifications made to the machine. 

 
Do not handle the power cord with wet hands. Otherwise, it may cause electric shocks. 

Installation 

 

 

 

Do not set up the printer in a dusty environment. If dust collects inside the printer, it may cause fire or electric 
shocks or problems with correct operation. 

 
Be sure to connect the ground. If the ground connection is not secure, you run a high risk of receiving a 
serious electric shock, and problems with correct operation may also occur. 

 

 

 

Do not bend the cords excessively or fasten them too hard with staples or anything similar to secure cords. 
Otherwise, it may cause fire or electric shocks. 

 

 

 

Do not connect power to the printer on the floor near the printer. Otherwise, it may cause a fire, electric 
shock, or malfunction if water drips from the printer. 
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SAFETY INSTRUCTIONS

 WARNING 

Printing 

 

 

 

If a foreign object gets inside the printer, immediately turn off the power, disconnect the power cord, and 
contact the place of purchase or a qualified technician. If you continue to use the printer while there is a 
foreign object inside, it may result in fire or electric shocks or problems with correct operation. 

 

 

 

 

Do not allow the printer to come into contact with liquids. Otherwise, it may cause fire or electric shocks or 
problems with correct operation. 
If any liquid gets inside the printer, immediately turn off the power, disconnect the power cord, and contact 
the place of purchase or a qualified technician. 

 

 

 

Do not use the printer when smoke or a bad odor is coming from the printer. Otherwise, it may cause fire or 
electric shocks or problems with correct operation. Immediately turn off the power, disconnect the power 
cord, and contact the place of purchase or a qualified technician. 

 
Keep your finger or any body part away from the rotating fan. Otherwise, it will be caught up, which results in 
injuries. 
Turn off the power when you approach the fan. 

 

 CAUTION 

Environmental requirements 

 
Use the printer in a place which is adequately ventilated. A slight odor is generated when the printed articles 
are being fixed by heat. 

Installation 

 

 

The printer machine weighs 680 kg (1499 lb). Transporting and setting up of the printer should be held in the 
proper way. Otherwise, the printer may topple over and cause injury. 

 

 

Unplug the printer and contact the dealer where you purchased the printer or a trained technician if the 
printer topples over. If you continue to use it, it may result in fire or electric shocks or poor printing quality. 

 
Do not set up the printer in a place where it will be affected by vibration. Otherwise the printing quality may be 
degraded or the printer may topple over, which causes injury or results in failure of the printer. 

 
Do not connect the power cord until installation is complete. The printer may operate if the power is turned on 
by mistake, which could result in injury. 

 
Do not climb onto the printer or place heavy objects on top of it. You may get injured if it becomes 
unbalanced and tips over. 
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 CAUTION 

Printing 

 
This printer should only be used by operators who are appropriately trained in its safe operation. 

 
Ensure there is adequate space left in front of the printer and avoid placing any objects. Otherwise, your 
hand may get caught between the platen and an object, which may result in injury. 

 
Do not handle the platen while printing. If your hand gets caught between the platen or the T-shirt tray and 
the covers, it may be injured. 

 
Do not put your hands inside the covers while the printer's power is turned on. Otherwise, your hands may 
touch against moving parts and this may result in injury. 

 
When the pretreatment is applied to printed objects (like a T-shirt) with a spray or pretreatment applicator, 
sprayed mist is generated. So, wear a pair of plastic gloves, a mask and protective glasses (or goggles) 
designed to shield against liquid splash, and fully take care of the air ventilation when you are working with it.

 
When a problem occurs with the operation of the printer, contact the place of purchase or a qualified 
technician. 

 
Be careful not to put your hands in the clearance of the cover of the lifting up/down mechanism. Doing so 
may cause injury. 

Maintenance 

 
Be careful not to pinch your fingers when closing each door and cover. You may get injured if you pinch your 
fingers. 

 
When you mount or replace the head, be careful not to get your hands or fingers caught. Otherwise, you may 
be injured. 

 
Do not drink liquids such as the ink, cleaning solution, pretreatment, or waste. They may cause diarrhea or 
vomiting. 
When handling liquids, such as the ink, cleaning solution, pretreatment, and waste, use protective glasses 
and gloves to avoid causing your eyes and skin to contact the liquids. It may cause inflammation. In case of 
contact with eyes, do not rub but immediately rinse the eyes with water. 
Keep the liquids out of the reach of children. 

 
Be sure to wear protective goggles and gloves when handling the grease, so that it does not get into your 
eyes or onto your skin. 
It can cause inflammation. Do not drink or eat the grease. It may cause diarrhea or vomiting. 
Keep the liquids out of the reach of children. 

 
When replacing parts and installing optional accessories, be sure to use only genuine Brother parts. Brother 
will not be held responsible for any accidents or problems resulting from the use of non-genuine parts. 

 
When replacing parts or installing optional accessories, be sure to follow the procedures described in the 
Instruction Manual. Incorrect procedures could cause injuries or problems. 

 
Follow the corresponding instructions in the manual when you put your hands inside the cover during regular 
maintenance while the power is turned on. 
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 IMPORTANT 

Printing 

 
Do not move the platen by hand. Otherwise, the printer may be mechanically and electrically damaged. 

 
Ensure there is adequate space left in front of the printer and avoid placing any objects. The platen may be 
hit and damaged. 

 

 NOTE 

 
Use the printer in an area which is free from sources of strong electrical noise such as electrical line noise or 
static electric noise. Sources of strong electrical noise may cause problems with correct operation. 

 
Any fluctuations in the power supply voltage should be within ±10% of the rated voltage for the printer. 
Voltage fluctuations which are greater than this may cause problems with correct operation. 

 
The power supply capacity should be greater than the requirements for the printer's power consumption. 
Insufficient power supply capacity may cause problems with correct operation. 

 
In the event of an electrical storm, turn off the power and disconnect the power cord from the wall outlet. 
Lightning may cause problems with correct operation. 
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3. Warning labels 
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Pretreatment 
5 kg (11 lb) 

Pretreatment
20 kg (44 lb)

Waste ink tank 

Cleaning solution bottle
9 L 

Ink bottle 
9 L 

Waste water tank

Ink bottle 
18 L 

Cleaning solution bottle 
18 L 

Pretreatment 
200 kg (440 lb) 
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SAFETY INSTRUCTIONS

This printer has the following warning labels displayed on it. 
Follow the precautions given on each warning label for your work. 
When the label is peeled off or illegible, contact the place of purchase. 
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1 Before Using Your Printer for the First Time 

1-1.  Be sure to read the following notes before using the printer 

Keep in mind the following points before using the printer: 

Precautions for proper use 

 PLEASE LEAVE THE PRINTER POWERED ON 24 HOURS A DAY. 
Even when the printer is placed in standby mode, it performs such maintenance as white ink circulation inside 
the main unit automatically to prevent sedimentation of the white ink. 

 
 Please use the printer within the scope covered by its warranty for the best print result (temperature: 18 

to 30°C (64.4 to 86°F) and humidity: 35 to 85%). 
Otherwise, the print heads may be clogged with ink and ink may splash. 

 
 Adjust the height of the platen according to the print medium before using it. 

Adjust the height and check that the platen is not detected by the obstacle sensor. 
 

 Do not excessively lower the platen. 
Otherwise, ink mist will be scattered inside the printer, which may result in staining of the printing surface, 
blurring of the printed image, and malfunction of the sensor and the main unit. Increase the platen height if the 
platen too low sensor is activated. 
☞"5-4-2. Platen height adjustment >>P.158" 

 
 Never power off the printer or open the cover while the printer is in operation. 

Otherwise, the printer may break down or a print job may end up in failure. 
 

 Until the ink is firmly fixed, do not touch the printed part. 
If a T-shirt is soiled with such ink that has not been firmly fixed on its surface, such ink stain cannot be removed 
even by washing. 

 

About ink bottle 

 Refill ink into the ink bottle of the same color as the ink bottle seal. 
 

 Shake the white ink well until no deposits remain on the bottom of the bottle. 
Otherwise, the white ink may precipitate. 
☞"6-1-2. Refilling white ink >>P.181" 

 
 Store consumable goods in a place where they are not exposed to direct sunlight, high temperatures, 

or low temperatures. 
 

 Use up the ink and pretreatment before their shelf life. 
Use of an expired ink bottle may make you liable for the cost of repairs even during the guarantee period. 

 
 In order to take full advantage of the printer capabilities, we recommend to use the ink specified by us. 

In cases where the printer malfunctions due to the use of non-genuine ink, you may be liable for the cost of 
repairs even during the guarantee period. 

 
 Be sure to close the ink tank lid once you have refilled the ink. 

 
 Handle the ink bottle with care. 
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 Handle the IC stick with care. 
Take care not to lose the IC stick. 
Once you have refilled ink, you cannot print until you insert the IC stick. 

 

About pretreatment 

 Apply the pretreatment when using white ink. 
If a T-shirt to which the pretreatment is applied is coated with only color inks, its stains may be wiped off by 
washing. 

 
 After a T-shirt is coated with the pretreatment, store pretreatment in a place where it is not exposed to 

direct sunlight, and wash it with clean water at an early stage after ink is applied to it. 
When a white or light-colored T-shirt is coated with the pretreatment, the coated surface color may change, and 
cannot be restored to the original color even if the T-shirt is washed. 

 
 When performing printing for the first time, try pretreatment in an unnoticeable area. 

Some T-shirts may be discolored by the pretreatment and cannot be restored to the original color even if they 
are washed. 

 
 Wash away any imprint of the pretreatment with water. 

 
 When a color transfer occurs, wipe the color-transferred area clean of dirt with a soft and clean cloth or 

a toothbrush that is moistened with a small amount of mild detergent for home use or alcohol. 
If a printed material is rubbed with vinyl-chloride-based white or light-colored synthetic leather, color transfer 
may occur. 
Also, when a color-printed surface is rubbed strongly against a printed surface with only white ink, color transfer 
may occur in the same fashion. 

 

About maintenance 

 If you put your hands inside the cover during regular maintenance while the power is on, follow the 
instructions in this manual. 

 
 In order to keep good printing quality, perform maintenance on a regular basis. 

☞"6. Precautions to keep good printing quality/use printer over the long term >> P.178" 
 

 We recommend to use the genuine cleaning solution that is specified by us when cleaning the head or 
cap. 
This allows you to take full advantage of the printer's intrinsic capabilities and use it for a long period. 
Using commercially available alcohol or cleaning solution could cause damage to the print heads. 

 
 Never remove the print heads except when they are replaced with new ones. 

Because they are precision components, the print head may fail. 
 

What to do when not using printer 

 When the printer will not be used for a prolonged period of time, take appropriate procedures before 
storing the printer depending on storage period or condition. 
☞"6-3. When Not Using for a Long Period of Time >> P.241" 
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About waste handling 

 Dispose of the residual wastes and waste ink properly as water-based waste fluid in accordance with 
applicable laws and ordinances. 

Others 

 In the event that the printer is relocated elsewhere for layout change, etc., place a level gauge on the 
top surface of the cover and the top surface of the platen to make such an adjustment that the printer 
will be placed horizontally level.  
After moving the printer unit, perform a pin check to ensure that no pins are missing before use. 

 You cannot connect this product directly to the communications lines, including the public wireless LANs, of 
telecommunication carriers like mobile communications companies, fixed communications companies, or 
internet providers. Ensure that the product is connected through a router, if it is to be used over the internet. 

 
<NOTE> 
 This apparatus is Class A information technology equipment based on the standards of the Voluntary Control Council for 

Interference by Information Technology Equipment (VCCI). Using this apparatus in a home environment may cause radio 
interference. In that case, the user may be required to take appropriate measures. 

 

About trademarks 

The names of operating systems described in the main context of this manual are abbreviated. Product names used in 
this manual are, in general, trademarks or registered trademarks of their respective developer or manufacture. However, 
in this manual, the ® marks or TM marks are not used. 
Brother logo is registered trademark of Brother Industries, Ltd. 
Apple, Macintosh, Mac OS, iOS, OS X, macOS, Safari, iPad, iPhone, iPod and iPod touch are the trademarks or 
registered trademarks of Apple Inc. in the United States of America and other countries. 
The official name of Windows® 10 is Microsoft® Windows® 10 operating system. (represented as Windows 10 in this 
manual) 
The official name of Windows® 11 is Microsoft® Windows® 11 operating system. (represented as Windows 11 in this 
manual) 
Microsoft®, Windows® 10, and Windows® 11 are trademarks and registered trademarks of Microsoft Corporation in the 
United States of America and other countries. 
Corel, Corel's logo and CorelDRAW are trademarks and registered trademarks of Corel Corporation. 
Adobe, Adobe's logo, Acrobat, Photoshop, and Illustrator are trademarks of Adobe Systems Incorporated (Adobe 
Systems). 
Other product and company names mentioned herein may be the trademarks or registered trademarks of their 
respective owners. 
Information in this document and the specifications of this product are subject to change without notice. 
 

About the CE declarations 

Downloadable from: https://www.brother.com 
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About software 

This printer uses its own software. 
To use this printer, you are required to agree with the End-User License Agreement for Brother Software as mentioned 
below. 
 

End-User License Agreement for Brother Software 
You can use this software if you agree to comply with the terms of the End-User License 
Agreement. You cannot use this software unless you agree to comply with the terms. 
1. Ownership 
The rights for this software and its reproductions belong to Brother Industries, Ltd. (hereafter 
referred to as the “Company”) or its suppliers. The Company does not transfer the copyright 
related to this software to you under this agreement. 
2. Permission for license 
2.1 The Company grants you a non-exclusive right to use this software. 
2.2 You cannot conduct any of the following acts: 
(1) Modifications of all or part of this software, 
(2) Reverse engineering, disassembly, or decompilation, 
(3) Loaning or leasing this software, 
(4) Keep this software available for download in public. 
3. No warranty 
The Company provides this software without any warranty, either expressed or implied, including 
but not limited to a warranty for free of defects, fitness for a particular purpose, and 
non-infringement of third party rights. 
4. Limitation of liability 
The Company shall not be liable for any direct or indirect damages caused by or connected with 
this software. 
5. Termination of license 
The Company may terminate this agreement without notice if you violate the terms and conditions 
outlined in this agreement. 
6. Governing law 
This agreement shall be construed in accordance with Japanese law. 
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1-2.  Components included with printer 

The components included with the printer are shown below. However, in the event that there is any missing 
component(s), please contact your dealer. 

X1163

① ② ③ ④ ⑤ ⑥

⑧ ⑨ ⑫⑪

⑬ ⑮

⑲ ⑳ ㉒㉑

⑦

⑯ ⑯

⑰

⑭

⑱

⑩

 
No. Name Quantity No. Name Quantity
1 Main tank cover 1 13 Waste water tank 1 
2 Main tank cover S 1 14 USB hub 1 
3 Main tank cover installation screw (M4) 2 15 Key to main body door *1 6 
4 Main tank cover S installation screw (M3) 1 

16 
Clean stick R 
Clean stick T 

10 
10 5 Hole cap (black) 4 

6 Print switch unit 2 17 Cleaning cup 1 
7 Print switch cover installation screw 8 18 Gloves 2 
8 Print switch unit installation screw 8 19 Cam fixing pin 2 
9 Carriage foam 1 20 Wiper blade 4 
10 Humidifier pipe R 1 21 Flushing foam 2 
11 Humidifier pipe L 1 22 Setup Manual 1 
12 Waste ink tank 1    

*The print heads and mist fan filter are attached to the main body before shipping. 
<TIPS> 
*1: The administrator should keep the key. 
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1-3.  Other items you must make available for use 
What you buy from our distributors 

 9 L Ink bottle 
 Cleaning solution 
 Pretreatment 
 AC power cord 

<NOTE> 
 There is a risk of malfunction or fire if you use other cables than the specified one. Purchase the cable (optional item) from 

your dealer. Also, do not use any extension cable. 
 

Others 

 LAN cable (10BASE-T/100BASE-TX/1000BASE-T) 
 

 USB flash memory 
Please use a FAT32-formatted USB flash memory of which storage capacity is 2 GB to 32 GB in total. You 
cannot use a USB memory with security functions such as password lock function or beyond 32 GB. 

<NOTE> 
 Use the supplied USB hub if the USB flash drive cannot be recognized. 

 
 Pure water 

Pure water refers to clear water, such as distilled water or purified water, to dilute the pretreatment and 
supply to the humidifier. 

<NOTE> 
 Avoid using such water as tap water in which impurities are contained. 

 
 Heat press 

It must deliver the performance through which the print range of the size of a platen to be used can be 
covered and 180°C (356°F) can be kept for 35 seconds or more. At a fixing stage of the pretreatment, be 
sure to use the heat press, but not an oven, to smoothen the surface fluff. 

 
 Peel-off sheet 

Always use this sheet to flatten the fixed surface and enhance the peel property when fixating the 
pretreatment and ink by means of the heat press. ☞"5-3-1. Provisions for pretreatment >> P.147" 

 
 Silicone foam (of open-cell structure) 

It is the foamed mattress which resists heat. Use this at a fixing stage through the use of the heat press. 
 

 Adhesive roller 
Use these to remove lint from a T-shirt or debris from its surface. 

 
 Water supply to the humidifier 

☞"1-5-2. Water supply >>P.33" 
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 T-shirt (printing medium) 
 100% cotton 
 Polyester blended yarn fabric 

 
<TIPS> 
 Although it is advisable to use a 100% cotton T-shirt, some textiles cannot necessarily guarantee good printing quality even 

if they are made of 100% cotton or blended yarn. In particular, for a T-shirt made of new material, perform a printing test on 
it beforehand. 

 Some textiles may leave noticeable imprints of the pretreatment after it is fixated. In that case, wash them away with water. 
 Perform a printing test beforehand. Then, the following phenomena may occur:  

- The textiles may be discolored by the pretreatment and cannot be restored to the original color even if they are washed.  
- A deep-colored polyester blended yarn fabric dissolves dye, which may cause the white ink to change to a slightly different 
color.  
- Fabric material may turn yellow after the pretreatment is fixed. 



 

22 

Before Using Your Printer for the First Time

1-4.  Name and function of each component 

1-4-1.  Front part 

 

5 

4 

6 

10 13 3 

7 

9

1 2 

8 

11

12
11

12
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No. Name Function 
1 Top cover Open this cover when cleaning the internal area of the printer. 
2 Carriage Holds the print head. 

3 
Obstacle sensor 

Checks the presence of any obstacles by their height (such as wrinkled T-shirt) 
that are within range to collide with the print head. 

“Platen too low” sensor Make sure that the clearance between the head and platen is not too large. 

4 Platen sheet 
It helps to keep the T-shirt from moving/shifting during printing so that an image 
can be clearly printed. 

5 Platen Set the T-shirt to be printed. 
6 Shoulder bar Align the position of a T-shirt with this bar. 

7 T-shirt tray 
This T-shirt tray holds such portions of T-shirt that droop down on it and feeds 
the entire T-shirt into the printer. 

8 Platen fixing handle 
Use this handle to secure the platen in place. 
Tighten or loosen it when attaching/removing the platen. Keep it tightened 
when printing. 

9 Mist fan filter It absorbs ink mist which is generated inside the printer on its surface. 
10 Operation panel Operate the printer using this panel. 

11 Print button 
There is no print data when this button remains off. This button blinks during 
reception of print data, and it illuminates when such reception is completed. 
Printing will begin if you press this button when it is illuminated. 

12 Stop button 

Press either one to cancel operations, such as printing and platen movement. 
Printer will come to a stop after necessary actions for keeping the printer's good 
quality, such as retracting operation of print heads and capping operation, are 
completed. 

13 Monitor mounting frame You can mount the monitor by using the monitor arm. 



 

24 

Before Using Your Printer for the First Time

1-4-2.  Right side view 

 
No. Name Function 
1 Right side cover Open this cover when cleaning the internal area of the printer. 

2 
Ink tank White (W), magenta (M), cyan (C), yellow (Y), and black (K) from the right-hand 

side. 
3 Cleaning solution tank It is the tank that reserves the cleaning solution used for maintenance. 

1 

23
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1-4-3.  Left side view/Rear side view 

 
No. Name Function 
1 Upper left side cover Open this cover when cleaning the internal area of the printer. 
2 Lower left side cover Open the cover and replace the waste ink tank and waste water tank. 
3 Waste ink tube This tube is used to direct the flow of waste ink down into the waste ink tank. 
4 Waste ink tank This tank collects waste ink. 
5 Drainage tube This tube is used to drain water. 
6 Waste water tank This tank collects drain water. 
7 Model plate On this plate, a product serial number is inscribed. 
8 Power cord insertion port Insert the power cord into this port. 

9 Power switch 
Use this button to turn the power on/off to the printer. 
To turn off the power, execute [Prepare Power OFF] on the operation panel, and 
turn off the power switch after completing the operation. 

10 LAN port Into this port, insert the LAN cable which is to be connected with a PC. 
 

10 7 8 9 

5

6 4 

3

1

2
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1-4-4.  Inside the cover 

<IMPORTANT> 
 If you put your hands inside the cover during regular maintenance while the power is on, follow the instructions in this manual. 

 
No. Name Function 
1 Print head (front: on the color side) It ejects the color ink. 
2 Print head (rear: on the white side) It ejects the white ink. 
3 Carriage linear guide This shaft supports the carriage. 

4 Maintenance unit 
In order to keep good printing quality, this unit performs maintenance 
functions to the print heads on a regular basis. (Example: Auto-Cleaning 
Function) 

5 Caps (color, white) 
The caps protect the color and white head surfaces and suck ink when 
cleaning the heads. 

6 
Wiper unit It wipes away ink from the head surface. 
Wiper cleaning tank  
(Under the wiper unit) 

This tank keeps cleaning solution and soaks and cleans the wiper. 

7 Flushing foam 
To keep good printing quality the foam absorbs the ink-jet droplets ejected 
from the print head. 

8 Flushing receiver Set the flushing foam. 

9 Carriage locker solenoid 
To prevent drying of print heads, it fixes the carriage to the cap position of 
the maintenance unit. 

10 Carriage foam It absorbs ink and prevents printed materials from being stained. 

1 2 

9

3 4

6 

7 

8 
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5
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1-4-5.  Operation panel 

 
 
No. Name Function 

1 Liquid crystal panel 
It indicates the job name or file name of print data, the active status of the 
printer, and the menu for various settings. 

2 Error LED 
When it remains off: No error has occurred. 
When it remains on: One or more errors have been detected. 

3 Up-arrow button  

While the menu screen is being displayed, use this button to select your 
desired menu item. 
In the numeric value setting menu, use this button to increase the target value.

4 USB flash insertion slot Insert a USB flash memory into this slot. 

5 Right-arrow button  

While the menu screen is being displayed, use this button to select your 
desired lower-level (right) menu item. 
While the standby mode screen is being displayed, use this button to display a 
warning when any warning message appears. 

6 IC stick insertion slot 
This slot accommodates the IC stick that contains the color information for use 
when refilling the ink. 

7 MENU/OK button  

If this button is pressed when the printer is placed in the standby state, the 
menu screen will appear. 
While the menu screen or the error screen is being displayed, use this button to 
finalize and accept the currently displayed content. 

8 Down-arrow button  

While the menu screen is being displayed, use this button to select your 
desired menu item. 
In the numeric value setting menu, use this button to decrease the target value.

9 
Back button / 
Left-arrow button 

 

 

While the menu screen is being displayed, use this button to return to only one 
upper-level (left) menu screen. 
If this button is pressed when the printer is placed in the standby state, the 
printer status will be displayed. 

4 

5

6 

78910

11
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13
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No. Name Function 

10 Stop button 
 

With this button, such actions as printing and platen movement can be 
canceled. 
Printer will come to a stop after necessary actions for keeping the printer's good 
quality, such as retracting operation of print heads and capping operation, are 
completed. 
While the menu screen is being displayed, the screen will exit and return to the 
standby mode screen. 

11 Platen button 
 

It is used to move the platen toward the rear or front of the printer. Use this 
button to ascertain whether the platen is set to a proper height after the platen's 
height is adjusted. 

12 Shortcut button 
 

Performs the action assigned to the shortcut function. 

13 Power LED 
When it remains off: The power of the printer is turned off. 
When it remains on: The printer remains turned on (powered on). 
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Liquid crystal panel 

The picture shown below indicates a state under which the printer has received print data. On this screen, the printer's 
current state and necessary information for printing are displayed. 

 
No. Indications Function 

1 Preview image 

The preview display screen of received print data is shown in this window. The 
preview display screen shown here is indicated upside down as opposed to the 
page orientation (the upper side of the preview image is oriented toward the front 
of the printer main unit). 
Furthermore, it is possible to change the direction of the preview display screen 
as well. 

2 
Remaining cleaning solution 
volume indication area 

In this area, the current remaining cleaning solution volume in the tank is 
displayed. 

3 
Remaining ink volume 
indication area 

In this area, the current remaining ink volume of each tank is displayed. 
In the left-to-right order, the remaining ink volume in the black (K), yellow (Y), 
cyan (C), magenta (M), and white (W) ink cartridges are shown here. 

: The remaining ink volume is running low. Make ink available for use in the 

next printing session. *1 

: Ink has been depleted. 

4 
Waste ink tank replacement 
indication 

This indication shows a guideline for replacing the waste ink tank. 

5 Ink volume to be used 
The required ink volume (cc) for printing out one sheet of the received print data 
is displayed here. 
(CMYK + White) 

6 Auto-Cleaning 
Head cleaning is automatically performed every time a predetermined number of 
sheets are printed in order to provide stable printing quality. 
It is possible to make displayed icon changes in [Standby mode icon settings]. 

10

9

11

8
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1 
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No. Indications Function 

7 Warning mark  
This mark appears when any warning is issued. Pressing  causes the 

current screen to move to the warning screen where the applicable warning 
message is indicated. 

8 Number of printed sheets 
The total number of printed sheets of which printing operation is completed in 
response to the received print data is displayed here. (0 to 999) 

9 Platen Size 
Platen size that is specified by the printer driver during data creation is indicated 
here. 

10 
Text string display area on 
basic display screen 

In this area, the print job name or file name, auto cleaning, receiving state, 
standby state, etc. are shown. 

11 Progress bar display area It displays a state of progress during the process of printing. 
 
<IMPORTANT> 
*1: If you perform printing that requires a large volume of ink when the remaining ink level is low, the ink may be depleted 

during the printing process. As a rough indication, refill the ink before you perform printing that requires 20 cc or more 
ink. 
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When receiving print data, press the left arrow button on the screen to switch it over to the following screen to display 
print information. 

 

No. Indications Function 
1 Time/Date Displays the current date and time. 
2 Resolution icon The printing resolution of received print data is displayed here. 

3 Print direction icon 
The print direction is displayed here in the form of either bi-directional or the 
uni-directional icon. 

4 Humidity display 
The humidifier operates to keep the humidity of the unit between 65% and 75%. 
“Suitable” will be displayed if the humidity is appropriate, and “Low” will be displayed if 
it is less than 65%RH. 

5 Auto-Cleaning 

Head cleaning is automatically performed every time a predetermined number of 
sheets are printed in order to provide stable printing quality. 

At the next print,  will be displayed on the right side if auto cleaning is activated 

before or after printing.  
(The conditions for performing auto cleaning will change as appropriate depending on 
changes in temperature and humidity, the length of printing intervals, etc. Therefore, 
the presence or absence of auto cleaning may differ at the time of actual printing.) 

6 Platen position The current platen position is displayed. 

7 Humidifier ON/OFF 
The humidifier runs automatically. Therefore, you can see if it is currently running. 

 will be displayed on the right side when the waste water tank is filled with water. 
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No. Indications Function 

8 
White ink circulation 
time 

The time of the next white ink circulation is displayed. 
The time set by the maintenance tool is displayed. 

The reinforced circulation of white ink will be performed if  is displayed. 
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1-5.  About the humidifier 

The humidifier works to maintain the image quality and keeps the humidity of the unit properly. 
Furthermore, the water accumulated inside the humidifier will be regularly discarded for hygiene control. 
<IMPORTANT> 
 If the humidity inside the printer is low, the amount of ink consumed will increase to maintain the functionality of the printer. 
 If excessive water is supplied to the humidifier, the water will be released through the hose on the lower right front side of the 

printer. Do not connect power cords on the floor near the printer. Doing so may result in electric shock. 
<TIPS> 
 The humidifier will not operate if the ambient humidity is high and the humidity inside the unit is sufficiently high. 
 
 

1-5-1.  About the water used 

Use pure water. 
<IMPORTANT> 
 If non-pure water, such as tap water, is used, white powdery impurities will adhere to the inside of the unit, causing damage to the 

printer and heads. 
 Electrical conductivity of Pure water have to be less than 10 μS/cm. 

For the measurement method, contact the dealer where you purchased the printer. 
 
 

1-5-2.  Water supply 

Select the water supply to the printer from the following two methods.  
Please refer to the Setup Manual for how to connect to the printer. 
 

Optional items 

 Water tank supply ASSY 
 Water tube T6040 15M 
 L-shaped fitting 06-06 

 

Commercially available item 

 Regulator 
 Pure water equipment 

 
Supply from a water pipe 

 

<NOTE> 
 If supplying water from a water pipe, perform piping according to the applicable laws and regulations. 
 If necessary, use a regulator so that the supply pressure will be 40 kPa or less. 
 

Pure water 
equipment 

Printer Water 
pipe 
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Supply from a tank 

 

<IMPORTANT> 
 Fill the tank with pure water. 
 Use a clean container to supply water to the tank. 
 Install the tank about 31.5 in. (80 cm) above the installation location of the printer.  

If the height is insufficient, water may not be supplied to the printer. 
 The tube should be laid on the floor, and the length should be 49.2 ft. (15 m) or less. Piping should be done so that the height 

difference between the tubes is about 5.9 in. (15 cm). 
 Limit the number of L-shaped fittings to three per flow path. 
 Be sure to mount a cable cover with sufficient strength to the tube. 

Water will not be supplied and may leak to the floor if the tube is broken or cut off. 
 Lay the tube so that the bending radius is 2.0 in. (5 cm) or more. 

If the bending radius is small, the tube may break. 
 If the tube is broken during laying, do not use the broken part. 
 Do not use the optional humidifier water supply tube to connect to tap water piping. 
 Loosen the tank's cap during use. 
 Verify that the faucet is in the closed position before inserting or removing the tube. Failure to do so could allow the water to flow 

out of the tank. 
 Check inside the water supply tank once a month. Clean inside the tank if you notice any bad odor or discoloration. 
 

Printer Tank 
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2 Menu list 
 

On-screen menu manipulation 
What to do How to operate 

Start 
Pressing  in the wait state causes the current screen to move to the menu 

selection screen. 

Select / Acknowledge 

By means of , change a menu item to another menu item to be displayed. 

Pressing  causes the current menu to change to another menu item which is 
one level lower in the menu layer. 

Pressing  causes the currently displayed menu to be acknowledged. 

Return to previous menu in 
upper menu layer 

Pressing  causes the current menu to change to another menu item which is 

one level higher in the menu layer. 

Exit 

 If you press  when a menu in the uppermost menu layer remains 

displayed, the menu will exit and the system will return to a standby state. 

 If you press  when an optional menu remains displayed, the menu will 

exit and the system will return to a standby state. 
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Menu list 
1st layer 2nd layer 3rd layer Description 

[Platen height 
adjustment] 

[Position A] 

This menu item is used to set the platen height. 

[Position B] 
[Position C] 
[Position D] 
[Position E] 
[Position F] 
[Position G] 
[Position H] 
[User settings 1] 
[User settings 2] 
[Print Data Height] 

[Head Cleaning] 

[Normal Cleaning] 

[All Colors] 
In the event that no ink-jet droplets are ejected, 
this menu item enables you to perform cleaning 
of all the nozzles of the color heads. 

[All Whites] 
In the event that no ink-jet droplets are ejected, 
this menu item enables you to perform cleaning 
of all the nozzles of the white heads. 

[All Print Heads] 
In the event that no ink-jet droplets are ejected, 
this menu item enables you to perform cleaning 
of the nozzles of all the print heads. 

[Color head A] 
In the event that no ink-jet droplets are ejected, 
this menu item enables you to clean the nozzle 
of each print head. 

[Color head B] 
[White head A] 
[White head B] 

[Powerful Cleaning] 

[All Colors] 

In the event that the poor ejection of ink-jet 
droplets is not improved by means of the normal 
cleaning, use this menu item. 

[All Whites] 
[All Print Heads] 
[Color head A] 
[Color head B] 
[White head A] 
[White head B] 

[Super Cleaning] 

[All Colors] 

In the event that the poor ejection of ink-jet 
droplets is not improved by means of the 
powerful cleaning, use this menu item. 

[All Whites] 
[All Print Heads] 
[Color head A] 
[Color head B] 
[White head A] 
[White head B] 
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1st layer 2nd layer Description 

[Test Print] 
[Nozzle Check CMYK] 

This is the test pattern to check to see if ink-jet droplets are 
ejected from the color heads properly or not. 

[Nozzle Check White] 
This is the test pattern to check to see if ink-jet droplets are 
ejected from the white head(s) properly or not. 

[Ink refill] 

[Black] 

Use when refilling the ink. 

[Yellow] 
[Cyan] 
[Magenta] 
[White] 
[Cleaning solution] 

[Print Data Load] 
Any print data stored in a USB flash memory (ARX6, ARXP, 
or ARX4 file) is loaded into the system with this menu item. 

[Receiving History] 

By selecting this menu item, you can display any print data 
received in the order in which they are sorted from the 
newest to the oldest ones, and you can select any one of 
them. 

[Maintenance] 

[Maintenance Part 
Clean/Replace] 

Use when performing printer maintenance. 

[White Ink Circulation] 
[White Ink Tank Agitation] 
[Humidification] 
[Humidifier unit] 
[Waste Ink Tank Disposal] 
[Humidifier Drain Tank Disposal] 
[Tank remaining volume sensor 
correction] 
[Wiper Cleaning Tank Operation]
[Head Replacement] 
[Install Ink after Replacing Head]
[Initial Ink Installation] 
[Recovery after Long 
Power-OFF] 
[Tube air bleed] 
[Cap pump check] 
[Log copy to USB] 
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1st layer 2nd layer Description 

[Printer Setting] 

[Print Direction] 

Use when configuring the printer. 

[Back Light] 
[Auto Screen Erase Time] 
[Menu TimeOut Setting] 
[Speaker Volume] 
[Temperature] 
[Preview display settings] 
[File name display setting] 
[Standby mode icon settings] 
[Platen Setting] 
[Low Temperature Mode] 
[Low Humidity Mode] 
[Post-circulation Auto Cleaning] 
[Auto Cleaning Setting] 
[Auto Cleaning Start Timing] 
[Auto Multiple Pass Setting] 
[Flushing Interval Setting] 
[Flushing Volume Setting] 
[Auto Job Delete] 
[Reserve Print during Receiving]
[Network filtering] 
[IP Address Set] 
[Shortcut button setting] 

[Total Print] 

Use when needed. 

[Temperature/Humidity Info] 

[Confirm network 
setting] 

[IP Address] 
[Subnet Mask] 
[Default Gateway] 
[Host name] 
[MAC address] 

[Check circulation schedule] 
[Check humidification schedule] 
[Language] 
[Prepare Power OFF] 

[Version] 

[Firm Version] 
[Data Info] 
[Serial No.] 
[Head information] 
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3 Installation and preparation 

Be sure to use the printer after making correct setting in accordance with the instructions described in this chapter. 
 

WARNING 

 

 

 

Do not set up the printer in a dusty environment. If dust collects inside the printer, it may cause fire or electric 
shocks or problems with correct operation. 
 

 
Be sure to connect the ground. If the ground connection is not secure, you run a high risk of receiving a 
serious electric shock, and problems with correct operation may also occur. 

 

 

 

Do not bend the cords excessively or fasten them too hard with staples or anything similar to secure cords. 
Otherwise it may cause fire or electric shocks.  
 

 

CAUTION 

 

 

The printer machine weighs 680 kg (1499 lb). Transporting and setting up of the printer should be held in the 
proper way. Otherwise, the printer may topple over and cause injury. 

 

 

Unplug the printer and contact the dealer where you purchased the printer or a trained technician if the 
printer topples over. If you continue to use it, it may result in fire or electric shocks or poor printing quality. 

 
Do not set up the printer in a place where it will be affected by vibration. Otherwise the printing quality may be 
degraded or the printer may topple over, which causes injury or results in failure of the printer. 

 
Do not connect the power cord until installation is complete. The printer may operate if the power switch is 
turned on by mistake, which could result in injury. 

 
Do not climb onto the printer or place heavy objects on top of it. You may get injured if it becomes 
unbalanced and tips over. 
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Installation and preparation

3-1.  Installation of printer 

Please refer to the Setup Manual included with the printer, for details of unpacking procedures and installation 
procedures of accessories.  
For an installation site of the printer, please bear the following points in mind: 

• When installing the printer, avoid any place that presents direct sunlight or a large amount of dust. 
• The size is 66.5 in. (width) x 69.3 in. (depth) x 63.0 in. (height) (169 cm (width) x 176 cm (depth) x 160 cm 

(height)). The main unit weighs 680 kg (1499 lb). 
• Do not use any extension cable. 
• Keep a minimum workspace of 31.5 in. (80 cm) in front and on the left and right sides of the printer. Also, keep 

15.7 in. (40 cm) or wider clearance at the back of the printer. Keep 23.6 in. (60 cm) or wider space free above 
the unit as well. If this space is not secured, you will have to move peripherals or the printer when making a 
repair. 

• When installing the printer, place a level gage on the top surface of the platen to make adjustments so that the 
main unit is set horizontally level. 

X1008  

• When connecting the power cord of the printer, do not use overloaded sockets. 

X1168 

116.5 in. (296 cm) 
or more 

31.5 in. (80 cm) 
or more

31.5 in. (80 cm) 
or more

31.5 in. (80 cm) 
or more 

129.5 in. (329 cm) 
or more 

23.6 in. (60 cm) or more 

15.7 in. (40 cm) or more 

Printer installation dimensions 
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3-2.  Initial installation of printer 

Please refer to the Setup Manual for the following initial installation procedures: 
• Main tank unit 
• Print switch 
• Waste ink tank/Waste water tank 
• Humidifier pipe 
• Carriage belt tension adjustment 
• Humidifier water supply tube 
• Water supply tank (optional item) 
• Turning on the power 

 

3-2-1.  Level adjustment 

Prepare a level gage and a 1.4-in. (35-mm) wrench. 
 

(1) On the operation panel, press , and move the platen toward the front of the printer. 

(2) Place a level gage on the top surface of the platen. 

 

(3) Adjust the level by rotating the lower nuts that secure the legs (4 points) so that the main unit is set horizontally level 

while checking the level gage. 
<IMPORTANT> 
• Adjust so that the adjusters protrude 4.9 in. (125 mm) or less from the bottom of the frame. 

 

4.9 in. (125 mm) 
or less 
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(4) Tighten the upper nuts on the lefts (4 points) upwards after adjusting the level. 

 
<IMPORTANT> 
• Check the level again with a level gage after fixing everything. 
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3-3.  Power supply of printer 

Even when the printer is placed in standby mode, such maintenance as white ink circulation is performed automatically. 
PLEASE LEAVE THE PRINTER POWERED ON 24 HOURS A DAY. 
<IMPORTANT> 
• Do not turn off the power because if you do so, the machine may fail because necessary maintenance operations are 

not performed. 
 

3-3-1.  Turning on the power 

Please refer to the Setup Manual, after the unpacking procedures and installation procedures are completed. 
Please check the following points, before connecting the power cord to the printer: 

• Ascertain whether the ink tube is connected to the print head correctly. 
• Ascertain whether the waste ink tube is inserted into the waste ink tank and waste water tank that have been 

made available. 
• Ascertain whether at least about 31.5 in. (80 cm) of space required for the platen is secured. 

<IMPORTANT> 
• Turn on the power before you refill the ink. 

(1) Connect the power cord to the power cord insertion port. 

(2) Insert the power plug into an electric outlet. 

(3) Make sure that the printer's earth terminal is properly grounded. 

(4) Turn on the printer power switch with each door and cover closed. 
<IMPORTANT> 
• Never power off the printer while it is in operation. Otherwise, the printer may be damaged. 
• Do not activate the printer with the ink tube not connected to the print head. Otherwise, the printer may be damaged. 
• Make sure that no flushing foam extends off the outboard end portions of the flushing foam. If it sticks out of the end 

portions, it may interfere with any nozzles and may result in non-ejection of ink-jet droplets. 
<TIPS> 
• If the printer is activated after having been off for a long time, the maintenance operation including white ink agitation will be 

performed for up to 4 hours, depending on how long the power was off. 

 

Power switch 



 

44 

Installation and preparation

3-3-2.  Turning off the power 

When you need to turn off the power 
Turn off the power in the following cases. 

• When moving the printer elsewhere. 
• In the event that the power supply interruption is anticipated in advance, including the case where a planned 

power outage is scheduled. 
 

How to turn off the power 

(1) From the menu, select [Prepare Power OFF] and press  . 

If the printer is operating, wait for it to finish. 

(2) Cleaning will start at the end of the print job. 

Follow the instructions on the panel and turn off the power. 
<IMPORTANT> 
• No cleaning will be performed at the end of the print job to keep the print heads in good condition if you turn the power off or 

disconnect the AC power cable before the operation of [Prepare Power OFF] is completed. In these cases, the print heads 
may fail to eject ink-jet droplets. For this reason, be sure to activate the printer once again and perform the head cleaning 
after activation. 
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3-3-3.  When there is no prospect of electric power recovery for a while due to power outage 

Print head capping will be performed to prevent the print heads from drying out if there is a power failure while the printer 
is operating and no prospect of recovery for a while. 
<IMPORTANT> 
• Be sure to turn off the power switch before starting work. 
<TIPS> 
• Perform the work specified below when no print heads are capped, e.g., when a power failure occurs during printing. The 

specified work is not required if the print heads are capped. 
 

(1) Unlock the upper left-hand-side cover and top cover and open them. 

 

(2) Remove two screws to remove the cover. 

 

Screw 

Cover 

Keyhole 

Keyhole 



 

46 

Installation and preparation

(3) Place the cap fixing plate stored on the lower right side of the maintenance unit on the frame, and move the 

carriage toward you until the carriage comes in contact with the cap fixing plate. 

 
<IMPORTANT> 
• Be careful not to let the carriage come in contact with the protrusion on the cap. 
• Return the parts to the storage position. 

 

(4) Insert the two pins stored on the lower right side of the maintenance unit into the holes marked A and B, 

respectively. 

 

(5) Turn the lever clockwise until it comes in contact with the pin inserted in A. 
<IMPORTANT> 
• If any print head rises, unlock and reinstall the print head. 

 

Lever 

Pin 

Protrusion 

Cap fixing plate Frame 

Cap fixing plate 
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(6) Push the carriage in the maintenance direction after the carriage comes in contact with the lever. 
<IMPORTANT> 
• Make sure that the protrusion on the cap touches the side of the print heads when pressing the carriage in the maintenance 

direction. Non-ejection may occur if the carriage comes in contact with the nozzle surface of a print head. 

 

(7) Pull out the pin inserted in A and turn the lever clockwise until the lever comes in contact with the pin inserted in B. 

Print head capping will be performed correctly in this state. 
<IMPORTANT> 
• Make sure that the lever will not come in contact with the nozzle surfaces of the print heads when turning the lever. 
• A print head may rise if you press the protruding part of the cap strongly against the nozzle surface of a print head. Do not 

forcibly turn the lever in that case, and start over the work from the beginning. 

 

(8) Pull out the pin inserted in B and attach the cover with the two screws. 
<TIPS> 
• Return the pins to the storage position. 

 

(9) Turn on the power and restart the printer as soon as the power failure is restored. 
<IMPORTANT> 
• For this reason, be sure to restart the printer and perform the head cleaning after activation. 

 

 

Screw 

Cover 
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3-4.  Connection between Printer and PC (for Windows) 

This chapter provides information about the procedures to install the GTX-6 printer driver onto your PC and connection 
method of the printer to PC. 
For Windows 10 and 11, different dialog boxes may be displayed.Proceed with the next step while checking each 
procedural step.  
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Installing the printer driver 

"3-4-1. Installing printer driver onto your PC >>P.49"

When connecting via  
USB When connecting via LAN 

Add a Printer to PC 

"3-4-2. When connecting via a 
USB 3.0 cable: Adding the 

printer to the PC >>P.50" 

Set static IP address 
on PC 

Set static IP address 
on Printer main unit 

Printer static IP Address 
Set 

"3-4-3. When connecting via a 
LAN cable: Static IP address 

setting >>P.51"

Printer static IP Address 
Set 

"7-20. Static IP address setting 
>>P.258"

Add a Printer to PC 

"3-4-4. When connecting via a LAN cable: Adding the printer to the PC >>P.55"

Adjusting Printer 
"3-6-1. Initial settings after head replacement >>P.69"

"3-6-2. Color adjustments between the two color heads >>P.70"
"3-6-3. Firing adjustment >>P.71"

"3-6-4. 2 same color heads position adjustment >>P.72"
"3-6-5. Platen-rolling adjustment >>P.73"

"3-6-6. White/color alignment >>P.74"
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3-4-1.  Installing printer driver onto your PC 

To begin with, on your PC, install the printer driver for file output, "Brother GTX-6 FileOutput". 
At this stage, do not connect the printer to the PC yet. 
<TIPS> 
• You must log into your PC with administrator privileges. 
 

(1) Activate the PC. 

(2) Complete all of the current sessions. 

(3) Double-click on the "setup.exe" to execute the installer. 

(4) Then, the installation procedures will begin. Follow the on-screen instructions to complete the installation. 

(5) When the dialog box shown below appears, click [Install]. 

 

(6) After the installation is completed, reactivate the PC. 
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3-4-2.  When connecting via a USB 3.0 cable: Adding the printer to the PC 

(1) Once you have installed the printer driver, with the printer powered on, make a connection with a USB 3.0 cable 

between the printer and your PC. 
<TIPS> 
• Use the USB 3.0 cable provided with the printer. 
• Do not use any extension cable. 
• You may skip step (2) if you can automatically select the printer driver for use.  

Follow the steps if it cannot be selected automatically. 
• Connect the PC and the printer with a USB 3.0 cable after installing the printer driver.  

Connecting with a USB 3.0 cable before installing the printer driver may result in installation failure. In that case, uninstall 
the printer driver and try again. 

<CAUTION> 
• When plugging and unplugging the USB 3.0 cable, do it with the printer's power on. 
• When not using the USB 3.0 cable, always attach the provided cap for protection. 
• Be careful not to touch the USB terminal directly with your hands. 
• Before using a USB 3.0 cable, discharge any static electricity from your body using one of the following methods:  

・Touch a metal object. 
・Wash your hands or wipe them with a damp towel. 

(2) Follow the on-screen instructions to complete the installation. 

(3) After the installation is completed, open [Devices] > [Printers & Scanners] from [Settings]. 
<TIPS> 
• For Windows 11, open [Bluetooth & devices] > [Printers & Scanners] from [Settings]. 

 

 
 

(4) Right-click the "Brother GTX-6" icon or the "Brother GTX-6 FileOutput" icon for file output, and select the [Set as 

default printer]. 

(5) If a LAN connection is required, perform a static IP address setting on the printer and add the printer to the PC.  

If connecting only via USB and LAN connection is not required, the configuration task on the PC is now completed. 
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3-4-3.  When connecting via a LAN cable: Static IP address setting 

When connecting via LAN, the printer's static IP address needs to be obtained beforehand. There are two ways to set a 
static IP address for the printer: From the PC and from the printer. For information on the setting from the printer, refer to 
Chapter 7. ☞"7-20. Static IP address setting >>P.258" 
<TIPS> 
• If the PC cannot recognize the Printer, a correct static IP address might not be assigned. ☞"3-4-4. When connecting via a LAN 

cable: Adding the printer to the PC >>P.55" 
Check with your network administrator. 

 

(1) With the printer powered on, make a connection with a USB 3.0 cable between the printer and your PC. 

(2) From [All Programs] in the Start menu, select "GTX-6 Maintenance" from "Brother GTX-6 Tools". 

(3) After the window shown below appears, select the [IP Address Set] and click [Next]. 
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(4) Select the desired IP address setting method and click [Next]. 
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If you selected "Manually enter the IP address". 

(5) Enter each of the pre-determined values of the printer for [IP Address], [Subnet Mask], and [Default Gateway], and 

click [Next]. (One instance of each value is cited as shown in the window below.) 
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If you selected "Automatically acquire the IP address" 

(5) Enter the hostname to be set for the printer and click [Next]. 
<TIPS> 
• The hostname can contain up to 31 characters. 

 

(6) The steps are completed when the message [IP address was successfully assigned to the Printer.] is displayed.    
If there is any error in each of the values you have entered for the static IP Address, Subnet Mask, and Default Gateway, an error 
message to inform you accordingly will appear. In this case, correct the error and attempt the process again. 
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3-4-4.  When connecting via a LAN cable: Adding the printer to the PC 

Before connecting via LAN, refer to ☞"7-20. Static IP address setting >>P.258" and set the IP address for the printer. 
Then, add the printer to your PC according to the procedure specified below. 

(1) Connect your PC with the printer by means of the LAN cable to make a network connection, and power on the 

printer. 

(2) Select [Devices] > [Printers & Scanners] from [Settings]. 
<TIPS> 
• For Windows 11, open [Bluetooth & devices] > [Printers & Scanners] from [Settings]. 

(3) Click [+]. 
<TIPS> 
• For Windows 11, click [Add a device]. 

 

(4) Select [The printer that I want isn't listed]. 
<TIPS> 
• For Windows 11, click [Add with manual settings]. 
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(5) Select [Add a local printer or network printer with manual settings], then click [Next]. 

 

 

(6) Select the [Create a new port], then select [Standard TCP/IP Port] for [Type of port], and finally click [Next]. 
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(7) In the [Hostname or IP address] field, enter the already-setup static IP address of the printer, make sure that [Query 

the printer and automatically select the driver to use] is checked, and click [Next]. (One instance of each value is 

cited as shown in the window below.) 

 
<TIPS> 
• You can omit steps (8) through (11) if the printer driver to use is automatically selected. Follow the steps if it cannot be 

selected automatically. 
• If you set the printer's IP address by automatic acquisition, you must check the IP address of the printer in advance. You 

can confirm the IP address by selecting [Confirm network setting] -> [IP Address] from the menu. ☞"7-24. Confirm network 
setting >>P.261" 

• If you are using a DNS server, you can use a host name and domain name instead of the IP address. Enter the host name 
of your choice. ☞"7-24. Confirm network setting >>P.261" As for the domain name, check with your network administrator. 

• When the printer screen displays “00X”,  enter “X” in the IP address field. 

 

(8) Then, the detection window of TCP/IP port appears, and the current window will automatically go to the additional 

port information window after the detection is completed. 

(9) After the window shown below appears, select the [Custom] in the [Device Type], and click [Settings]. 
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(10) In the [Protocol], select the [LPR], enter "BINARY_P1" in [Queue Name] of the [LPR Settings], and click [OK]. 

When the current screen goes back to the previous screen, click [Next]. 

 
 

(11) After the window shown below appears, select [Brother] for [Manufacturer], [Brother GTX-6] for [Printer], and click 

[Next]. 
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(12) After the window shown below appears, select the [Replace the current driver], and click [Next]. 

 
 

(13) Enter [Printer name], and click [Next]. 
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(14) Then, the specified printer will be added to the system, following which the window shown below appears, select 

the [Do not share this printer], and click [Next]. 

 
 

(15) Click [Finish]. This exits the setting for the PC. 
<TIPS> 
• If the PC cannot recognize the Printer, a correct static IP address might not be assigned. Consult your administrator. 

 

 

(16) Then adjust the printer using "GTX-6 Maintenance". 
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3-5.  Connection between Printer and PC (for Macintosh) 

This chapter provides information about the procedures to install the GTX-6 printer driver onto your PC and connection 
method of the printer to PC. 
You can connect the printer to your PC using either a USB cable or a LAN cable.  
・When using a USB 3.0 cable: ☞"3-5-2. Connecting the printer to your PC via a USB cable >>P.62" 
・When using a LAN cable: ☞"3-5-3. Connecting the printer to your PC via a LAN cable >>P.65" 

3-5-1.  Installing printer driver onto your PC 

To begin with, on your PC, install the printer driver for file output, "Brother GTX-6 FileOutput". 
At this stage, do not connect the printer to your PC yet. 
<TIPS> 
• You must log into your PC with administrator privileges. 
 

(1) Activate the PC. 

(2) Complete all of the current sessions. 

(3) Double-click on "BrotherGTX-6_ver***.pkg" to execute the installer. 

(4) Then, the installation procedures will begin. Follow the on-screen instructions to complete the installation. 

(5) After the installation is completed, reactivate the PC. 
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3-5-2.  Connecting the printer to your PC via a USB cable 

(1) With the printer powered on, make a connection with a USB 3.0 cable between the printer and your PC. 
<TIPS> 
• Use the USB 3.0 cable provided with the printer. 
• Do not use any extension cable. 
• You can omit steps (2) through (6) if the printer driver to use is automatically selected.  

Follow the steps if it cannot be selected automatically. 
• Connect the PC and the printer with a USB 3.0 cable after installing the printer driver.  

Connecting with a USB 3.0 cable before installing the printer driver may result in installation failure. In that case, uninstall 
the printer driver and try again. 

(2) Open [System Settings] from the Apple menu and click [Printers & Scanners]. 
<TIPS> 
• For macOS Monterey, open [System Preferences] from the Apple menu and click [Printers & Scanners]. 

 

(3) Click [Add a printer, scanner, or Fax...] at the bottom right. 
<TIPS> 
• For macOS Monterey, click the [+] button at the bottom left. 
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(4) Select [Brother GTX-6 xxx] and click [Select Software] under [Driver]. 

 
 

(5) Select [Brother GTX-6] and click [OK]. 

 

 

(6) Click [Add]. 
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(7) Select [Brother GTX-6] or [Brother GTX-6 FileOutput] from [Default Printer]. 
This exits the USB connection setting. 
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3-5-3.  Connecting the printer to your PC via a LAN cable 

Before connecting via LAN, refer to ☞"7-20. Static IP address setting >>P.258" and set the IP address for the printer. 
Then, add the printer to your PC according to the procedure specified below. 
 

(1) Connect your PC with the printer by means of the LAN cable to make a network connection, and power on the 

printer. 

(2) Open [System Settings] from the Apple menu and click [Printers & Scanners]. 
<TIPS> 
• For macOS Monterey, open [System Preferences] from the Apple menu and click [Printers & Scanners]. 

 

(3) Click [Add a printer, scanner, or Fax...] at the bottom right. 
<TIPS> 
• For macOS Monterey, click the [+] button at the bottom left. 
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(4) Select [IP]. 

 

(5) Enter the IP address of the printer for [Address].  

Select [Line Printer Daemon - LPD] from [Protocol].  

Enter "BINARY_P1" for [Queue].  

Enter the printer name for [Name].  

Select and click [Select Software…] under [Use]. 

 

(6) Select [Brother GTX-6] and click [OK]. 
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(7) Click [Add]. 

 

(8) The screen returns to the [Printers & Scanners] screen, and the GTX-6 printer (LAN) is added.  

If necessary, select the GTX-6 printer under [Default Printer].  

This exits the LAN settings. 
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3-6.  Adjustment 

Adjust the printer using "GTX-6 Maintenance". 
 

Menu name Description Things to prepare 
See the operating procedure 

with GTX-6 Maintenance 
[Initial settings after 
head replacement] 

Make settings after print head 
replacement. 

― 
"3-6-1. Initial settings after 
head replacement >>P.69" 

[Color adjustments 
between the two color 
heads] 

Make adjustments after 
replacing the print head if the 
horizontal stripes (banding) in 
the picture are noticeable. 

White paper 
"3-6-2. Color adjustments 
between the two color heads 
>>P.70" 

[Firing Adjustment] 

Make adjustments after print 
head replacement if the print is 
blurred and the printed result 
appears too granular. 

Black paper or 
transparent sheet (such 
as OHP sheet) 
White paper 

"3-6-3. Firing adjustment 
>>P.71" 

[2 same color heads 
position adjustment] 

Make adjustments if 
misalignment occurs in 
white-only or color-only printing. 

Black paper or 
transparent sheet (such 
as OHP sheet) 
White paper 

"3-6-4. 2 same color heads 
position adjustment >>P.72" 

[Platen-rolling 
adjustment] 

Make adjustments if the 
horizontal stripes (banding) in 
the picture are noticeable after 
printing. 

White paper 
"3-6-5. Platen-rolling 
adjustment >>P.73" 

[White/Color Alignment] 
Make adjustments if the white 
and color images are out of 
position. 

Black paper or 
pretreated black or dark 
color T-shirt 

"3-6-6. White/color alignment 
>>P.74" 

[Setting of the time 
displayed on the nozzle 
check pattern] 

No settings are required if 
scheduled time settings for white 
ink circulation have been made. 

― 
"3-6-7. Setting of the time 
displayed on the nozzle 
check pattern >>P.75" 

[Set the scheduled time 
for white ink circulation] 

Make settings when making a 
time reservation for white ink 
circulation or canceling the 
reservation. 

― 
"3-6-8. Set the scheduled 
time for white ink circulation 
>>P.77" 

[Humidification 
Schedule Settings] 

Set the start time and end time 
for humidification. 

― 
"3-6-9. Humidification 
Schedule Settings >>P.80" 
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3-6-1.  Initial settings after head replacement 

Set V-rating after replacing the print head or completing the setup procedure. 

(1) Make sure that a connection of USB 3.0 cable or LAN cable is made between the printer and your PC. 

(2) On the PC, from [All Programs] in the Start menu, select the "GTX-6 Maintenance" from "Brother GTX-6 Tools". 

(3) After the window shown below appears, select [Initial settings after head replacement] and click [Next]. 

 

(4) Perform the required operation by following the on-screen instructions in the dialog box. 
After the adjustment is completed, the currently displayed screen will go back to the window mentioned above. 
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3-6-2.  Color adjustments between the two color heads 

Make adjustments after replacing the print head or completing the setup procedure, or if horizontal stripes appear in the 
printing.  
If you want to make adjustments after replacing the print head, configure the initial settings after print head replacement 
and adjust the firing timing before you do so. 

(1) Make several sheets of A4-size or letter-size white paper available for use. 

(2) Make sure that a connection of USB 3.0 cable or LAN cable is made between the printer and your PC. 

(3) On the PC, select "GTX-6 Maintenance" under "Brother GTX-6 Tools" from [All Programs] in the Start menu. 

(4) When the window shown below is displayed, select [Color adjustments between the two color heads] and click 

[Next]. 

 

(5) Follow the instructions in the dialog box that appears on the screen. 
After the adjustment is completed, the currently displayed screen will go back to the window mentioned above. 
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3-6-3.  Firing adjustment 

Because the ejection timing varies depending on the platen's height and properties of each print head, this function is 
provided to adjust the ejection timing for each print head when any print head is replaced with a new one or after the 
completion of the setup procedure, for instance. If you want to make adjustments after replacing the print head, 
configure the initial settings after print head replacement before you do so. 

(1) Make several sheets of A4-size or letter-size paper (black paper or transparent sheet such as OHP sheet, and 

white paper) available for use. 

(2) Make sure that a connection of USB 3.0 cable or LAN cable is made between the printer and your PC. 

(3) On the PC, from [All Programs] in the Start menu, select the "GTX-6 Maintenance" from "Brother GTX-6 Tools". 

(4) After the window shown below appears, select [Firing Adjustment] and click [Next]. 

 

(5) Perform the required operation by following the on-screen instructions in the dialog box. 
After the adjustment is completed, the currently displayed screen will go back to the window mentioned above. 
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3-6-4.  2 same color heads position adjustment 

This is the adjustment function to align the print position on the white side with the print position on the color side. Make 
adjustments after replacing a print head or completing the setup procedure. 
If you want to make adjustments after replacing the print head, configure the initial settings after print head replacement 
and adjust the firing timing before you do so. 

(1) Make several sheets of A4-size or letter-size paper (black paper sheets or transparent sheets, such as OHP sheets, 

along with white paper sheets) available for use. 

(2) Make sure that a connection of USB 3.0 cable or LAN cable is made between the printer and your PC. 

(3) On the PC, select "GTX-6 Maintenance" under "Brother GTX-6 Tools" from [All Programs] in the Start menu. 

(4) When the window shown below is displayed, select [2 same color heads position adjustment] and click [Next]. 

 

(5) Follow the instructions in the dialog box that appears on the screen. 
After the adjustment is completed, the currently displayed screen will go back to the window mentioned above. 
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3-6-5.  Platen-rolling adjustment 

Make adjustments after replacing the print head or completing the setup procedure, or if horizontal streaks appear in the 
printing.  
If you want to make adjustments after replacing the print head, configure the initial settings after print head replacement 
and adjust the firing timing before you do so. 

(1) Make several sheets of A4-size or letter-size white paper available for use. 

(2) Make sure that a connection of USB 3.0 cable or LAN cable is made between the printer and your PC. 

(3) On the PC, select "GTX-6 Maintenance" under "Brother GTX-6 Tools" from [All Programs] in the Start menu. 

(4) When the window shown below is displayed, select [Platen-rolling adjustment] and click [Next]. 

 

(5) Follow the instructions in the dialog box that appears on the screen.  
After the adjustment is completed, the currently displayed screen will go back to the window mentioned above. 
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3-6-6.  White/color alignment 

This is the adjustment function to align the print position on the white side with the print position on the color side. Adjust 
white/color alignment after replacing a print head or completing the setup procedure. 
If you want to make adjustments after replacing the print head, configure the initial settings after print head replacement 
and adjust the firing timing before you do so. 

(1) Prepare a sheet of black paper or a pretreated black or dark color T-shirt. 

(2) Make sure that a connection of USB 3.0 cable or LAN cable is made between the printer and your PC. 

(3) On the PC, from [All Programs] in the Start menu, select the "GTX-6 Maintenance" from "Brother GTX-6 Tools". 

(4) After the window shown below appears, select the [White/Color Alignment] and click [Next]. 

 

(5) Perform the required operation by following the on-screen instructions in the dialog box. 
After the adjustment is completed, the currently displayed screen will go back to the window mentioned above. 
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3-6-7.  Setting of the time displayed on the nozzle check pattern 

Set the time displayed on the nozzle check pattern. 

(1) Make sure that a connection of USB 3.0 cable or LAN cable is made between the printer and your PC. 

(2) On the PC, from [All Programs] in the Start menu, select the "GTX-6 Maintenance" from "Brother GTX-6 Tools". 

(3) After the window shown below appears, select [Setting of the time displayed on the nozzle check pattern] and click 

[Next]. 
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(4) Perform the required operation by following the on-screen instructions in the dialog box. 
<CAUTION> 
• Confirm that the date and time of your PC are set correctly, and continue. 

 
 

(5) After the setting is completed, the currently displayed screen will go back to the Main screen. 
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3-6-8.  Set the scheduled time for white ink circulation 

White ink circulation can be performed at a specified time. If not set, white ink circulation will be performed automatically 
every four hours. 

(1) Make sure that a connection of USB 3.0 cable or LAN cable is made between the printer and your PC. 

(2) On the PC, from [All Programs] in the Start menu, select the "GTX-6 Maintenance" from "Brother GTX-6 Tools". 

(3) After the window shown below appears, select [Set the scheduled time for white ink circulation] and click [Next]. 
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(4) After the next window appears, select [Set the scheduled time for white ink circulation.]. Then, click [Next]. 
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(5) Set the scheduled time for white ink circulation and click [Next]. 
<CAUTION> 
• Confirm that the date and time of your PC are set correctly, and continue. 
• Enter at least six start-time settings. 
• Set the white ink circulation interval to be between one hour and six hours. 
• Input a time range of "0:00" to 23:59". 
<TIPS> 
• You can check on the main unit the scheduled time you set. ☞"7-25. Check circulation schedule >>P.262". 
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3-6-9.  Humidification Schedule Settings 

Make settings when reserving the operation schedule of the humidifier. 

(1) Make sure that a connection of USB 3.0 cable or LAN cable is made between the printer and your PC. 

(2) On the PC, from [All Programs] in the Start menu, select the "GTX-6 Maintenance" from "Brother GTX-6 Tools". 

(3) After the window shown below appears, select [Humidification Schedule Settings] and click [Next]. 
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(4) After the window shown below appears, click the [Set the scheduled time for humidification]. Then, click [Next]. 
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(5) Set the start time and end time for humidification and click [Next]. 
<CAUTION> 
• Confirm that the date and time of your PC are set correctly, and continue. 
• You can enter the start time and end time if you check the day of the week.  

Humidification will not start or end in time on days that are not checked. 
• Humidification will start at the start time.  

Specify one hour before printing. Insufficient humidification can affect print quality.  
Waste liquid increases to prevent the printer from malfunctioning. 

<TIPS> 
• You can check on the main unit the scheduled time you set. 
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(6) Select the elapsed time to finish humidification and click [Next]. 
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3-7.  Moving the printer 

When moving the printer elsewhere, please contact your dealer. 
<IMPORTANT> 
• If you have moved the printer, print a nozzle check pattern and perform head cleaning as necessary.  

☞"6-1-15. Head cleaning >>P.219" 
☞"6-1-17. Print out the nozzle check pattern (checking on the print heads) >>P.222" 
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4-1.  Types of applications 

You can create print data by either "using Brother products" or "using other applications". Select applications to use 
depending on your needs. 
You are recommended to use Brother product applications as far as possible. If you want to use other applications, 
however, you are recommended to use one of the three recommended applications to achieve high-quality print results. 
This chapter describes the procedures for using other applications. 
 

Using Brother products 
Applications to use Reference 

GTX Graphics Lab Graphics Lab Instruction Manual 

When using other applications 
Applications to use Reference 

CorelDRAW (2020/2021) "4-3-1. When using CorelDRAW >>P.88" 
Adobe Photoshop CC "4-3-2. When using Adobe Photoshop >>P.95" 
Adobe Illustrator CC "4-3-3. When using Adobe Illustrator >>P.100" 
 
<TIPS> 
• Make proper settings, such as color settings and printing conditions, of each application, in accordance with the setting contents 

of the application. 
• In this chapter, the value RGB=(254,254,254) is described as "RGB=254", and the value RGB=(255,255,255) is described as 

"RGB=255". 
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About color mode (color space) 
The GTX-6 printer is a printer of RGB type.  
Be sure to create image data in RGB mode, and always set the color space (input) you use for such data to sRGB 
(sRGB IEC61966-2.1). 
<TIPS> 
• When such application as Adobe and Corel is used, there are instances in which an image in CMYK mode cannot reproduce the 

color that is intended. 
• Even for an image in RGB mode, a similar color reproduction failure occurs when other color space than the specified one, such 

as Adobe RGB, is used. 

About print layout 
Specify the platen size that uses the paper size specified in the Print menu, and confirm the print layout.  
Moreover, use the "Brother GTX-6 FileOutput" printer driver for file output, then display and check the print preview. 
<TIPS> 
• For a print image to be oriented properly at all times, it is advisable to set the GTX-6 printer to the [Set as default printer] for the 

PC. 
 

How to create white data 

When creating print data with [Color + White Ink] or [White Ink Only], RGB=255 is treated as "Transparent color", 
ejecting no ink. 
For an image that you want to print pure white color with white ink, make sure that the white areas are set to RGB=254. 
<TIPS> 
• The treatment of RGB=255 varies depending on the applications.  

Configure the settings appropriately. 
 

About ARX6 file 
Use the "Brother GTX-6 FileOutput" printer driver for file output in order to save your print data in the ARX6 format. 
When your print data is saved in the ARX6 format, its information and the amount of used ink will be able to be reviewed. 
<TIPS> 
• When performing file output, be sure to use the printer driver, "Brother GTX-6 FileOutput". If file output is performed using [Print to 

file] command that is supplied with each application, there may be some cases where the file extension cannot be saved as .arx6, 
or the file destination cannot be specified. 

• ARX4 files created with the GTX-4 and ARXP files created with the GTX pro can be printed with the GTX-6. 
• The GTX-6 printer cannot print out the print data that has been created for the GT-541/GT-782/ GT-3 series. 
• If you make a printer driver setting from the Control Panel of your PC, such setting sometimes will not take effect in each 

application. For this reason, verify that your printer driver has been set up properly before you begin printing. 
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4-2.  Sending print data using Brother GTX-6 FileOutput (for Macintosh only) 

Saving print data to a file 
Check that the "GTX-6 File Viewer" is running when saving print data to a file using the "Brother GTX-6 FileOutput" 
printer. 
The error shown below will occur, and you will not be able to save the data if you output without "GTX-6 FileViewer" 
running. 
<TIPS> 
• Depending on the application, the following error may or may not appear. Try again with the "GTX-6 FileViewer" running. 

 
<TIPS> 
• The procedure for outputting a file from "Brother GTX-6 FileOutput" is the same as that for a Windows PC. 
 

Sending print data 
Follow the procedure below to send print data to the printer if the print data has been saved using the "Brother GTX-6 
FileOutput" printer. 
<TIPS> 
• The procedure for sending print data is the same as that for a Windows PC. 
 

(1) Double-click the file with the extension .arx6 saved using the "Brother GTX-6 FileOutput" printer. 

(2) "GTX-6 FileViewer" will be launched, and the file will be sent when you click [Send to Printer]. 
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4-3.  Using other applications 

4-3-1.  When using CorelDRAW 

First of all, perform the following procedures: 
• Color setting 
• Print size 

 
As required, perform the following procedures: 

• Create print data (ARX6 file). 
• Use the color palette in Useful Tools. 
• Convert data to bitmap image data. 
• Replace RGB=255 in bitmap image data with RGB=254. 

 
<TIPS> 
• For this printer, it is recommendable to use CorelDRAW 2020/2021. The display screen is described assuming CorelDRAW 

2019. 
 

Color management settings 

(1) In the menu bar, select [Tools] > [Color Management]. 

(2) Establish the settings in [Color management settings] as follows: 
• [RGB Profile]: [sRGB IEC61966-2.1] 
• [Primary color mode]: [RGB] 
• [Rendering intent]: [Relative colorimetric] 
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Print size 

(1) In the menu bar, select [File] > [Print]. 

(2) Set the [Printer] to either "Brother GTX-6" or "Brother GTX-6 FileOutput", click on [Apply], and close the [Print] 

dialog box. 
<TIPS> 
• If [Printer] is set to "Brother GTX-6", the print data at the time of printing will be sent to the printer.  

If [Printer] is set to "Brother GTX-6 FileOutput", the print data at the time of printing will be saved as an ARX6 file. 
 

 
(3) In the menu bar, select [Layout] > [Page Layout]. 
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(4) Make the following settings in the [Page Size] window: 
• [Size]: [Custom] 
• [Width]: 14.6 in. (370 mm) 
• [Height]: 16.5 in. (420 mm) 
• Page orientation: Portrait 
<TIPS> 
• Set the width and height to the size of platen to be used. The above size is the standard 14X16 platen size. 

・In the case of print data using white ink ☞"4-4-2. Select the platen size >>P.108" 
・In the case of print data using color ink and black ink only ☞"4-5-2. Select the platen size >>P.126" 
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Create print data (ARX6 file) 
Save the image data and print settings as a set of print data in ARX6 file format. 
The following will be made available if the print data is converted into an ARX6 file: 

• Image data and print settings can be put together and stored. 
• Without connection to a PC, the printing can be performed directly from a USB flash memory. 

<TIPS> 
• Image editing is unavailable for any ARX6 file. As such, save your image data for an editing purpose in advance. 
• For file output, there are some cases where neither file output destination nor extension cannot be specified by the [Print to file] 

command. Be sure to use the printer driver "Brother GTX-6 FileOutput". 
• For details of directly sending data to the printer from an application, ☞"5-6-2. Sending print data from applications >>P.166" 

(1) In the menu bar, select [File] > [Print]. 

(2) On [General] tab, select [Printer] and select "Brother GTX-6 FileOutput" for file output. 
<TIPS> 
• If the specified [Printer] is set to "Brother GTX-6", the print data will be sent to the printer.  

If the specified [Printer] is set to "Brother GTX-6 FileOutput", the print data will be saved as an ARX6 file. 

(3) Open the [Color] tab, and make the following settings: 
• Place a checkmark in the [Document color] checkbox. 
• [Color conversions]: "Brother GTX-6" or "Brother GTX-6 FileOutput" 
• [Color Profile]: [sRGB IEC61966-2.1] 
• [Rendering intent]: [Relative colorimetric] 

 
(4) On [Preferences], create your settings of printer driver. 

• In the case of print data using white ink ☞"4-4-1. Setting up the printer driver >>P.106" 
• In the case of print data using color ink and black ink only ☞"4-5-1. Setting up the printer driver >>P.124" 
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(5) When you press [OK] in the [Print] dialog box, the dialog box shown below will be displayed. After that, click [Save]. 
<TIPS> 
• There may be cases where this saving process takes several minutes. 

 
 

(6) Specify the [Save In] and [File name] first, and then click [Save] to save the ARX6 file to your PC. 
 
 

Use the color palette in Useful Tools. 

(1) Save the color pallet files for CorelDRAW, "GT_Colors.xml" and "GT_Tshirts.xml", on your PC, following the 

instructions on screen.  

(2) In the menu bar, select [Window] > [Color Palettes] > [Open Palette]. 

(3) Select the files having such filename as "GT_Colors.xml" and "GT_Tshirts.xml", respectively. 
 
<TIPS> 
• Do not use any color from the color sample palette, such as HKS and Pantone. Otherwise, an on-screen color may differ from 

the resulting print color. 
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Convert data to bitmap image data 

(1) In the menu bar, select [Bitmaps] > [Convert To Bitmap]. 

(2) Set the [Color mode] to [RGB Color]. 
<TIPS> 
• When the white ink is used for performing the printing, unmark the [Anti-aliasing] checkbox. 

 

 
<TIPS> 
• Even when the platen size to be used has been selected from the printer driver, the current setting in [Page Layout] may change 

to [Settings from printer].  
In the [Page Layout], be sure to change the width and the height according to the size of the platen. 
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Replace RGB=255 in bitmap image data with RGB=254 
RGB=255 is identified as a transparent color. To a portion where RGB=255 is contained, no ink will be ejected.  
In order for the white ink to be printed, select an area for RGB=255, and replace it with RGB=254.  
To make such replacement, use the method mentioned below. 

(1) In the menu bar, select [Effects] > [Adjust] > [Replace Colors]. 

(2) From the [Original] pull-down menu, set RGB=255 in [Replace Colors]. 

 

(3) In the same manner, set [New color] to RGB=254. 

(4) Check the [Single Color] check box, and click on the [OK] button. 

 
 
<TIPS> 
• For the vector data, change the fill color to RGB=254. 
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4-3-2.  When using Adobe Photoshop 

In Photoshop, configure the settings mentioned below: 
• Color setting 

 
As required, perform the following procedures: 

• Create print data (ARX6 file) 
• Use the color palette in Useful Tools. 
• Replace RGB=255 with RGB=254 

 
<TIPS> 
• For an image created in the CMYK color mode, select [Image] > [Mode] in the menu bar, and change the color to the RGB color 

(sRGB). In order to edit an image, select [Image] > [Adjustments] in the menu bar and edit it, or edit it by means of the image 
quality improvement of the printer driver. 
・In the case of print data using white ink ☞"4-4-11. Set up the image quality >>P.121" 
・In the case of print data using color ink and black ink only ☞"4-5-7. Set up the image quality >>P.132" 

• For this printer, it is recommended to use Photoshop CC. The display screen is described in Photoshop CC. 
 

Color setting 

(1) In the menu bar, select [Edit] > [Color Settings]. 

(2) Establish the settings of [Color Settings] as follows: 
[Working Spaces] 
• [RGB]: [sRGB IEC61966-2.1] 
[Conversion Options] 
• [Engine]: [Adobe(ACE)] 
• [Intent]: [Relative Colorimetric] 
[Color Management Policies] 
• [RGB]: [Convert to Working RGB] 
• [CMYK]: [Convert to Working CMYK] 
• [Gray]: [Convert to Working Gray] 
• [Profile Mismatches]: Mark the [Ask When Opening] and [Ask When Pasting] checkboxes. 
• [Missing profiles]: Mark the [Ask When Opening] checkbox. 

 
 



 

96 

Creating print data

Create print data (ARX6 file) 
Save the image data and print settings as a set of print data in ARX6 file format. 
The following will be made available if the print data is converted into an ARX6 file: 

• Image data and print settings can be put together and stored. 
• Without connection to a PC, the printing can be performed directly from a USB flash memory. 

<TIPS> 
• Image editing is unavailable for any ARX6 file. As such, save your image data for an editing purpose in advance. 
• For file output, there are some cases where neither file output destination nor extension cannot be specified by the [Print to file] 

command. Be sure to use the printer driver "Brother GTX-6 FileOutput". 
• For details of directly sending data to the printer from an application, ☞"5-6-2. Sending print data from applications >>P.166" 

(1) In the menu bar, select [File] > [Print]. If the PC's default printer is either "Brother GTX-6" or "Brother GTX-6 

FileOutput", the layout is set to the platen size. 

(2) Make the settings as follows: 
• [Color Handling]: [Printer Manages Colors] 
• [Rendering Intent]: [Relative Colorimetric] 

 

(3) From [Printer], select "Brother GTX-6 FileOutput" for file output. 
<TIPS> 
• If [Printer] is set to "Brother GTX-6", the print data will be sent to the printer.  

If [Printer] is set to "Brother GTX-6 FileOutput", the print data will be saved as an ARX6 file. 

(4) On [Print Settings], make your settings for the printer driver. 
• In the case of print data using white ink ☞"4-4-1. Setting up the printer driver >>P.106" 
• In the case of print data using color ink and black ink only ☞"4-5-1. Setting up the printer driver >>P.124" 
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(5) When you press [Print], the dialog box shown below will be displayed on the screen. After that, click [Save]. 
<TIPS> 
• There may be cases where this saving process takes several minutes. 

 

(6) Specify the [Save In] and [File name] first, and then click [Save] to save the ARX6 file to your PC. 
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Use the color palette in Useful Tools. 

(1) Save the color pallet file for Photoshop, "GT_Colors_T.ase", on your PC, following the instructions on screen.  

(2) In the menu bar, select [Window] > [Swatches]. 

(3) Click on  to open the submenu. 

 

(4) From [Read Swatches], select [Swatch Exchange (*.ASE)] for the type of file and then select the file name 

[GT_Colors_T.ase]. 

 
 
<TIPS> 
• Do not use any color from the color sample palette, such as HKS and Pantone. Otherwise, an on-screen color may differ from 

the resulting print color. 

RGB=254 
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What to do when replacing RGB=255 with RGB=254 
RGB=255 is identified as a transparent color. To a portion where RGB=255 is contained, no ink will be ejected.  
In order for the white ink to be printed, select an area for RGB=255, and replace it with RGB=254.  
To make such replacement, use the method mentioned below. 

(1) On the menu bar, select [Layer] > [New Adjustment Layer] > [Selective Color], and create a new layer. 

(2) Set the opacity to 20%, and click [OK]. 

 
 

(3) From the [Selective Color], make the following settings: 
• [Colors]: [Whites] 
• [Black]: 1% 
• Mark the [Absolute] option 

 
<TIPS> 
• The method to replace RGB=255 with RGB=254 as shown above can be used only when the [Color mode] is set to [8 bit] of 

[RGB Color]. 
• For Photoshop, the action file "SolidWhite.atn" is made available in Useful Tools, which changes RGB=255 to RGB=254 (☞

"4-6-2. Replace RGB=255 with RGB=254 (for Photoshop only) >>P.135"). For how to use it, refer to the Help feature that 
Photoshop is provided with. 
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4-3-3.  When using Adobe Illustrator 

In Illustrator, perform the required procedures mentioned below: 
• Color setting 
• Open a new file 

 
As required, perform the following procedures: 

• Create print data (ARX6 file). 
• Use the color palette in Useful Tools. 

 
<TIPS> 
• Take one of the actions mentioned below, in order to avoid such troubles that no image data is inserted into the print range or part 

of image data is cut off. 
- Before start-up, specify the PC's default printer as the "Brother GTX-6" or the "Brother GTX-6 FileOutput". 
- Use the "Brother GTX-6 FileOutput" printer driver to output a file, then display and check the print preview. 

• For an image created in CMYK color mode, load the image into Photoshop, select [Image] > [Mode] in the menu bar, and change 
the color to the RGB color (sRGB). In order to edit an image, load the image into Photoshop, edit it in the form of bitmap data, or 
edit it by means of image quality improvements in the printer driver. 
・In the case of print data using white ink ☞"4-4-11. Set up the image quality >>P.121" 
・In the case of print data using color ink and black ink only ☞"4-5-7. Set up the image quality >>P.132" 

• For this printer, it is recommended to use Illustrator CC. The display screen is described in Illustrator CC. 
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Color setting 

(1) In the menu bar, select [Edit] > [Color Settings]. 

(2) Click on the [More Options]. 

(3) Ensure selection of the settings as mentioned below, and click [OK]. 
• [Settings]: [Custom] 
[Working Spaces] 
• [RGB]: [sRGB IEC61966-2.1] 
[Color Management Policies] 
• [RGB]: [Convert to Working Space] 
• [CMYK]: [Convert to Working Space] 
• [Profile Mismatches]: Mark the [Ask When Opening] and [Ask When Pasting] checkboxes. 
• [Missing profiles]: Mark the [Ask When Opening] checkbox. 
[Conversion Options] 
• [Engine]: [Adobe(ACE)] 
• [Intent]: [Relative Colorimetric] 
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Open a new file 

(1) Set up a new document as follows: 
• [Width]: 14.6 in. (370 mm) 
• [Height]: 16.5 in. (420 mm) 
• [Orientation]: Portrait 
• [Color Mode]: [RGB] 
<TIPS> 
• Set the width and height to the size of platen to be used. The above size is the standard 14×16 platen size. 

・In the case of print data using white ink ☞"4-4-2. Select the platen size >>P.108" 
・In the case of print data using color ink and black ink only ☞"4-5-2. Select the platen size >>P.126" 
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Create print data (ARX6 file) 
Save the image data and print settings as a set of print data in ARX6 file format. 
The following will be made available if the print data is converted into an ARX6 file: 

• Image data and print settings can be put together and stored. 
• Without connection to a PC, the printing can be performed directly from a USB flash memory. 

<TIPS> 
• Image editing is unavailable for any ARX6 file. As such, save your image data for an editing purpose in advance. 
• For file output, there are some cases where neither file output destination nor extension cannot be specified by the [Print to file] 

command. Be sure to use the printer driver "Brother GTX-6 FileOutput". 
• For details of directly sending data to the printer from an application, ☞"5-6-2. Sending print data from applications >>P.166" 

(1) In the menu bar, select [File] > [Print] > [Color Management]. 

(2) Make the settings as follows: 
• [Document Profile]: [sRGB IEC61966-2.1] 
• [Color Handling]: [Let Illustrator determine colors] 
• [Printer Profile]: [sRGB IEC61966-2.1] 
• [Rendering Intent]: [Relative Colorimetric] 
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(3) From [Printer], select "Brother GTX-6 FileOutput" for file output. 
<TIPS> 
• If [Printer] is set to "Brother GTX-6", the print data will be sent to the printer.  

If [Printer] is set to "Brother GTX-6 FileOutput", the print data will be saved as an ARX6 file. 

(4) On the [Advanced], make your settings for the printer driver. 
• In the case of print data using white ink ☞"4-4-1. Setting up the printer driver >>P.106" 
• In the case of print data using color ink and black ink only ☞"4-5-1. Setting up the printer driver >>P.124" 
<CAUTION> 
• For Adobe Illustrator, set the platen size for the paper size in the Print dialog box in the application.  

The size or placement of the image may not be set correctly if you make settings in the Print Settings dialog. 

(5) When you press [Print], the dialog box shown below will be displayed on the screen. After that, click [Save]. 
<TIPS> 
• There may be cases where this saving process takes several minutes. 

 

(6) Specify the [Save In] and [File name] first, and then click [Save] to save the ARX6 file to your PC. 
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Use the color palette in Useful Tools. 

(1) Save the color pallet file for Illustrator, "GT_Colors_T.ase", on your PC, following the instructions on screen.  

(2) In the menu bar, select [Window] > [Swatches]. 

(3) Click on , and select [Open Swatch Library] from the submenu. 

(4) Select [Other Library]. 

 
 

(5) On the [Open] screen, select the file having such filename as "GT_Colors_T.ase". 
<TIPS> 
• Unlike the Photoshop or CorelDRAW, this Swatch needs to be selected each time a file is opened.  

However, you can fix the Swatch library in the following method to display the screen automatically whenever you start the 
application if you are using Illustrator CC.  

Click  on the top right corner of the Swatch library and select [Fix] from the submenu. 
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4-4.  Driver settings for print data using white ink 

4-4-1.  Setting up the printer driver 

<TIPS> 
• The GTX-6 printer driver treats RGB=255 as "Transparent color" and does not eject the ink. For such an image that you wish to 

print out in pure white color with white ink, make such a setting as RGB=254. 
• For the color replacement method, refer to a relevant page (☞"4-3. Using other applications >>P.88") or help menu of each 

application software. 
 

(1) By following the printing procedures of each application software, open the print setup dialog box of the printer 

driver. 
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(2) In the dialog box for setting the printer driver, configure required settings. 
If you click on the [Advanced], [White Ink Settings], [Color Processing], [Color Balance] and [Uni-Directional Printing] can be 
configured. 
<TIPS> 
• Depending on the settings you have made in the [Select Ink:] option or the like, setup items that appear on the screen vary. 
• The rollover help is displayed in the square portion at the bottom of dialog box. Place the mouse pointer over it to browse 

the help feature. 
• For the detailed description of setup items, refer to each chapter mentioned below. 

 
(3) After your settings are completed, click [OK]. 

<TIPS> 
• You can refer to each value you have set up here by opening an ARX6 file from the "GTX-6 FileViewer". 
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4-4-2.  Select the platen size 

From the pull-down menu of [Platen Size:], select a platen size for print area. 
<TIPS> 
• The platen size is equivalent to the paper size. 
 

Setup item Platen to be used Size 
[24×24] 24×24 platen 24.0 in. x 24.0 in. (610 mm x 610 mm) 
[18×22] 18×22 platen 18.0 in. x 22.0 in. (457 mm x 559 mm) 
[16X18] 16X18 platen 16.0 in. x 18.0 in. (406 mm x 457 mm) 
[14X16] 14X16 platen 14.0 in. x 16.0 in. (356 mm x 406 mm) 
[10X12] 10X12 platen 10.0 in. x 12.0 in. (254 mm x 305 mm) 
[7X8] 7X8 platen 7.0 in. x 8.0 in. (178 mm x 203 mm) 
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4-4-3.  Selecting platen height 

From the pull-down menu of [Platen Height:], select the platen height. 
When the printer receives print data, the platen automatically changes to the specified platen height. 

• You can select the height from [No designation], [A], [B], [C], [D], [E], [F], [G], and [H]. 
<TIPS> 
• The platen height is not changed if you select [No designation]. 
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4-4-4.  Select the ink type 

From the [Select Ink:] option, select a combination of inks to be used. 
 

Setup item Description 
[Color+White Ink] This option enables a color image to be printed out on the mask layer of white ink. 
[White Ink Only] This option enables the white ink only to be used for printing out a monochrome image. 
[Color Ink Only] This option enables a color image to be printed out on a white background or lighter and 

pale color background. 
[Black Ink Only] This option enables the black ink only to be used for printing out monochrome image. 
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4-4-5.  Select the mode 

If you set [Mode:] to [Eco-Mode], the white ink volume serving as the background is automatically adjusted to reduce the 
overall ink consumption. 
<TIPS> 
• The luminance on the finished print may be slightly reduced depending on the color. 

 



 

112 

Creating print data

4-4-6.  Select the resolution 

The range that can be set for highlighting will change, and the printing time will also differ, depending on the resolution 
selected in [Resolution:]. 

 
Resolution 

Resolution Description 
1200dpi × 1200dpi Prints at 1200 dpi × 1200 dpi. 
1200dpi × 1200dpi HQ Prints at 1200 dpi × 1200 dpi (High Quality Mode).  

Valid for white + color ink and white ink only. 
1200dpi × 900dpi Prints at 1200 dpi × 900 dpi. 
1200dpi × 600dpi Prints at 1200 dpi × 600 dpi. 

 
<TIPS> 
• Depending on the settings of [Resolution:], [Print Time:] will change. 
• Actual ink consumption depends on the actual colors used in the original image. As such, use this number as a reference for ink 

consumption. 
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4-4-7.  Set up the white ink 

If you have selected [Color+White Ink] or [White Ink Only] in the [Select Ink:], the setup items for [White Ink Settings:] will 
appear. 
Adjust the white ink volume separately in the [Highlight:] (visible white ink volume) and in the [Mask:] (white ink volume to 
cover the background color). 
Also, set the white ink time in the [2 Layer White] and [White/Color Pause]. 
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Highlight 
This enables you to select whiteness (thickness) of RGB=254 in such nine levels as [1] to [13]. When you increase this 
value, the White ink volume will increase. 
You can specify [10] to [13] only if [2 Layer White] is enabled. 

Highlight setpoints Ink volume 
[1] White ink volume 200% 
[2] White ink volume 250% 
[3] White ink volume 300% 
[4] White ink volume 350% 
[5] White ink volume 400% 
[6] White ink volume 450% 
[7] White ink volume 500% 
[8] White ink volume 550% 
[9] White ink volume 600% 
[10] White ink volume 650% 
[11] White ink volume 700% 
[12] White ink volume 750% 
[13] White ink volume 800% 
 
<TIPS> 
• Appropriate highlight setting value depends on color or material of the T-shirt. It is recommended to consider and decide on an 

appropriate highlight setting value before creating print data. Perform a highlight check pattern print and select an appropriate 
setting value. ☞"4-6-6. Print out of highlight check pattern/mask check pattern >>P.139" 

• Depending on the settings of [Highlight:], [2 Layer White], [White/Color Pause], and [Color Multiple Pass Printing], the [Print 
Time:] and [Whiteness:] will change accordingly. 

• [Print Time:] will be set to [×1] if the setup value of [Highlight:] is [5], and [2 Layer White], [White/Color Pause] and [Color Multiple 
Pass Printing] are turned OFF. With this [X1] serving as a reference value, how many times relates to how long the print time will 
take when printing. 

• Actual ink consumption depends on the actual colors used in the original image. As such, use this number as a reference for ink 
consumption. 

 

Mask 
This enables you to select the volume of white ink which is used as background color for color inks in such five levels as 
[1] to [5]. 

Setup value Description 
[1] or [2] These setup values are suitable for such lighter and pale background colors as pale pink, 

ash and cream. 
[3] This is the default value. 

This value will reproduce the most smooth white-gray-black gradation. 
[4] This value is suitable for vivid background colors, e.g., red, purple, and green. It 

suppresses the influence of the color of the fabric. 
[5] This value enables the printing with the largest amount of white ink under all colors except 

darker color areas. 
 
<TIPS> 
• Perform a mask check pattern print and select an appropriate setting value. ☞"4-6-6. Print out of highlight check pattern/mask 

check pattern >>P.139" 
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2 Layer White 
You can make highlight settings at a level of [1] to [13] when 2 Layer White is enabled.  
Set 0-60 seconds for the time from the start of printing the first white ink layer to the start of printing the second white ink 
layer.  
If you set a time shorter than the time it takes to print the first layer, the additional waiting time will be set to 0 seconds. 
<TIPS> 
• Only if you have selected [Color+White Ink] or [White Ink Only] in the [Select Ink:] settings, this setting menu will be enabled. 
 

White/Color Pause 
Set 0-60 seconds for the time from the start of printing the previous white ink layer to the start of printing the color ink 
layer.  
If you set a time shorter than the time it takes to print the previous white ink layer, the additional waiting time will be set to 
0 seconds. 
<TIPS> 
• Only if you have selected [Color+White Ink] in the [Select Ink:] settings, this setting menu will be enabled. 
• Check this checkbox to activate it when you print a tiny image. 
• Tiny images may become black when printed. When that occurs, print a white layer first and wait for a while (waiting time) to print 

the color layers. 
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4-4-8.  Specify whether or not to use the background black color 

If you have selected [Color+White Ink] in the [Select Ink:], the setup items of [Use background black color (for black 
T-shirts only)] will appear. 
In the event that you wish to print a black T-shirt making use of the T-shirt's background black color, mark the [Use 
background black color (for black T-shirts only)] checkbox. 
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4-4-9.  Specify whether or not to perform Multiple Pass Printing 

The setup items for [Color Multiple Pass Printing] will appear if you have selected the [Color+White Ink], [Color Ink Only], 
or [Black Ink Only] in the [Select Ink:].  
In cases where small and horizontal stripes are noticeable in the print result, mark the [Color Multiple Pass Printing] 
checkbox. 
<TIPS> 
• Even if the [Color Multiple Pass Printing] checkbox is marked, the amount of ink to be consumed will remain unchanged. 
• It takes longer to complete the print when the [Color Multiple Pass Printing] checkbox is marked. For a typical print time, refer to 

[Print Time:]. 
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4-4-10.  Set up the white ink 

If you have selected [Color+White Ink] or [White Ink Only] in the [Select Ink:], this setting menu will be enabled. 
When you click on the [Advanced] in the [Printing Preferences] dialog box, the setup items of [White Ink Settings] 
appear. 
In the [White Ink Settings], you can make settings for [Transparent Color:], [Tolerance:], [Minimum Whiteness:],and 
[Choke Width:]. 
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Transparent color 
With this option, specify a color which is treated as a transparent color without using any color during the printing 
process. If you want to specify other colors excluding the RGB=255 as "Transparent color", perform the following 
procedures to make your setting. 
<TIPS> 
• The RGB=255 is treated as a "Transparent color" (non-printing color). 
• You would be better off making [Use background black color (for black T-shirts only)] OFF to produce better colors. 
 

(1) Click the [Transparent Color:] checkbox. 
Then, the pull-down menu for color selection becomes active. 

(2) In the pull-down menu, select a color which serves as a background color of T-shirt, or click on the [Custom...] to 

specify a RGB value. 
<TIPS> 
• This custom color you have specified is valid only for one color which is specified immediately before. This color cannot be 

saved in the list. 

 

Tolerance 
Specify the gradation range (RGB values) to smoothly connect the zone between "Unprinted color" and "Printed color" 
to be gradually changed in tone. 
<TIPS> 
• If this value is increased, the gradation range in which the mask white is generated from a state in which no mask white exists will 

increase. 
• The gradation's image quality depends on image data. For this reason, it is advisable to perform a test printing beforehand. 
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Minimum white ink volume 
When printing with [Color+White Ink], the volume of background white color ink for dark or black color ink can be 
controlled. 
When printing with [Color+White Ink], you can increase the amount of the white ink volume used as the base in a dark 
area by specifying a larger value. 
Selecting [Special] allows you to select a value of [3] or higher. 
<TIPS> 
• The larger the value is, the more likely that blurring occurs. 
 

White Ink Choke Width 
This enables you to select the white ink choke width in such ten levels as [1] to [10]. When you increase this value, the 
choke width increases. By decreasing the print range of white ink, the white ink will be prevented from extending off from 
under the color inks. 
<TIPS> 
• Check the original image if white lines and/or dots are seen around the image, this may be caused by "Anti-alias" bitmap. 
• There are instances in which fine lines (characters or photographs) will disappear if this level is increased. For this reason, it is 

advisable to perform a test printing beforehand. 
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4-4-11.  Set up the image quality 

When you click on the [Advanced] in the [Printing Preferences] dialog box, the setup items of [Color Processing] appear. 
In the [Color Processing] option, you can make settings for [Saturation:], [Brightness:] and [Contrast:]. 
Make adjustments to increase vividness, brightness and clarity of an image without using any functions of application 
software. 
 

Setup item Description 
[Saturation:] The more vivid the color is, the higher its value. 
[Brightness:] The brighter the color is, the higher its value. 
[Contrast:] Contrast makes the image lighter for lighter colors and darker for darker colors if its value 

increases. 
 
<TIPS> 
• If a value of [Contrast:] is increased, there may be some cases in which fine lines will disappear. 
• For this reason, it is advisable to perform a test printing beforehand when you specify a higher value. 
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4-4-12.  Set up the color balance 

When you click on the [Advanced] in the [Printing Preferences] dialog box, the setup items of [Color Balance] appear. 
In the [Color Balance], you can make settings for [Cyan:], [Magenta:], [Yellow:], and [Black:]. 
You can adjust the color in 11 gradations, -5 to +5. 
<TIPS> 
• If you select [Black Ink Only] for ink selection, you can adjust [Black:] only. 
 

Setup item Description 
[Cyan:] Adjust the cyan ink volume. 

If you increase its value, the color becomes light bluish overall. If you decrease its value, 
the color becomes reddish overall. 

[Magenta:] Adjust the magenta ink volume. 
If you increase its value, the color becomes reddish-purple overall. If you decrease its 
value, the color becomes greenish overall. 

[Yellow:] Adjust the yellow ink volume. 
If you increase its value, the color becomes yellowish overall. If you decrease its value, 
the color becomes bluish overall. 

[Black:] Adjust the black ink volume. 
If you increase its value, the color becomes blackish overall. If you decrease its value, the 
color becomes whitish overall. 
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4-4-13.  Specify the print direction 

When you click on the [Advanced] in the [Printing Preferences] dialog box, you can make the settings for [Uni-Directional 
Printing]. 
<TIPS> 
• What you have specified on the printer's operation panel are prioritized, and this option becomes active only when the print 

direction specified on the printer side is set to [Auto]. 
• Print time will be doubled. 
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4-5.  Driver settings for print data using color ink and black ink only 

4-5-1.  Setting up the printer driver 

<TIPS> 
• The GTX-6 printer driver treats RGB=255 as "Transparent color" and does not eject the ink. For such an image that you wish to 

print out in pure white color with white ink, make such a setting as RGB=254. 
• For the color replacement method, refer to a relevant page (☞"4-3. Using other applications >>P.88") or help menu of each 

application software. 
 

(1) By following the printing procedures of each application software, open the print setup dialog box of the printer 

driver. 
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(2) In the dialog box for setting the printer driver, configure required settings. 
If you click on the [Advanced], [White Ink Settings], [Color Processing], [Color Balance] and [Uni-Directional Printing] can be 
configured. 
<TIPS> 
• Depending on the settings you have made in the [Select Ink:] option or the like, setup items that appear on the screen vary. 
• The rollover help is displayed in the square portion at the bottom of dialog box. Place the mouse pointer over it to browse 

the help feature. 
• For the detailed description of setup items, refer to each chapter mentioned below. 

 

(3) After your settings are completed, click [OK]. 
<TIPS> 
• You can refer to each value you have set up here by opening an ARX6 file from the "GTX-6 FileViewer". 
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4-5-2.  Select the platen size 

From the pull-down menu of [Platen Size:], select a platen size for print area. 
<TIPS> 
• The platen size is equivalent to the paper size. 
 

Setup item Platen to be used Size 
[24×24] 24×24 platen 24.0 in. x 24.0 in. (610 mm x 610 mm) 
[18×22] 18×22 platen 18.0 in. x 22.0 in. (457 mm x 559 mm) 
[16X18] 16X18 platen 16.0 in. x 18.0 in. (406 mm x 457 mm) 
[14X16] 14X16 platen 14.0 in. x 16.0 in. (356 mm x 406 mm) 
[10X12] 10X12 platen 10.0 in. x 12.0 in. (254 mm x 305 mm) 
[7X8] 7X8 platen 7.0 in. x 8.0 in. (178 mm x 203 mm) 
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4-5-3.  Selecting platen height 

From the pull-down menu of [Platen Height:], select the platen height. 
When the printer receives print data, the platen automatically changes to the specified platen height. 

• You can select the height from [No designation], [A], [B], [C], [D], [E], [F], [G], and [H]. 
<TIPS> 
• The platen height is not changed if you select [No designation]. 
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4-5-4.  Select the ink type 

From the [Select Ink:] option, select a combination of inks to be used. 
 

Setup item Description 
[Color+White Ink] This option enables a color image to be printed out on the mask layer of white ink. 
[White Ink Only] This option enables the white ink only to be used for printing out a monochrome image. 
[Color Ink Only] This option enables a color image to be printed out on a white background or lighter and 

pale color background. 
[Black Ink Only] This option enables the black ink only to be used for printing out monochrome image. 

 
 



 

129 

Creating print data

4-5-5.  Specify whether or not to perform Multiple Pass Printing 

The setup items for [Color Multiple Pass Printing] will appear if you have selected the [Color+White Ink], [Color Ink Only], 
or [Black Ink Only] in the [Select Ink:].  
In cases where small and horizontal stripes are noticeable in the print result, mark the [Color Multiple Pass Printing] 
checkbox. 
<TIPS> 
• Even if the [Color Multiple Pass Printing] checkbox is marked, the amount of ink to be consumed will remain unchanged. 
• It takes longer to complete the print when the [Color Multiple Pass Printing] checkbox is marked. For a typical print time, refer to 

[Print Time:]. 
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4-5-6.  Set up the color ink 

If you have selected [Color Ink Only] or [Black Ink Only] in the [Select Ink:], the setup items of [Color Ink Settings:] will 
appear. 
You can make your setting from the [Ink Volume:] or [Double Printing:] option in the [Color Ink Settings:] window. 
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Ink volume 
This enables you to select the ink volume in such ten levels as [1] to [10]. 
 

Setup value Description 
[10] This is the default value. 

This value corresponds to 100%-cotton fabrics as well as for blended yarn fabrics (hemp 
50%/polyester 50% or cotton 50%/polyester 50%). 

[9] to [7] These values correspond to a thinner T-shirt, thick towel, and cotton products woven with 
twill fabrics. 

[6] to [4] These values correspond to thin and plain fabrics as well as for blended yarn fabrics that 
consist of cotton, polyester and polyurethane. 

[3] to [1] These values correspond to polyester jerseys and synthetic fabrics that have no water 
absorbency. 

 
<TIPS> 
• When you print other clothes than a thick T-shirt, check on the actual blurring first, then adjust a value in the [Ink Volume:] option. 
  

Double Printing 
Performing the print cycle two times separately will make the printed color stand out more. 
 

Setup value Description 
[0] No separate processes 
[1] Separate processes (wait time between the 1st and 2nd print cycle) 
[2] Separate processes (longer wait time than the case with setting [1] between the 1st and 

2nd print cycle) 
[3] Separate processes (longer wait time than the case with setting [2] between the 1st and 

2nd print cycle) 
 
<TIPS> 
• For the options [1] to [3], the platen will reciprocate two times. 
• The higher the setpoint is, the longer the print time will be. 
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4-5-7.  Set up the image quality 

When you click on the [Advanced] in the [Printing Preferences] dialog box, the setup items of [Color Processing] appear. 
In the [Color Processing] option, you can make settings for [Saturation:], [Brightness:] and [Contrast:]. 
Make adjustments to increase vividness, brightness and clarity of an image without using any functions of application 
software. 
 

Setup item Description 
[Saturation:] The more vivid the color is, the higher its value. 
[Brightness:] The brighter the color is, the higher its value. 
[Contrast:] Contrast makes the image lighter for lighter colors and darker for darker colors if its value 

increases. 
 
<TIPS> 
• If a value of [Contrast:] is increased, there may be some cases in which fine lines will disappear. 
• For this reason, it is advisable to perform a test printing beforehand when you specify a higher value. 
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4-5-8.  Set up the color balance 

When you click on the [Advanced] in the [Printing Preferences] dialog box, the setup items of [Color Balance] appear. 
In the [Color Balance], you can make settings for [Cyan:], [Magenta:], [Yellow:], and [Black:]. 
You can adjust the color in 11 gradations, -5 to +5. 
<TIPS> 
• If you select [Black Ink Only] for ink selection, you can adjust [Black:] only. 
 

Setup item Description 
[Cyan:] Adjust the cyan ink volume. 

If you increase its value, the color becomes light bluish overall. If you decrease its value, 
the color becomes reddish overall. 

[Magenta:] Adjust the magenta ink volume. 
If you increase its value, the color becomes reddish-purple overall. If you decrease its 
value, the color becomes greenish overall. 

[Yellow:] Adjust the yellow ink volume. 
If you increase its value, the color becomes yellowish overall. If you decrease its value, 
the color becomes bluish overall. 

[Black:] Adjust the black ink volume. 
If you increase its value, the color becomes blackish overall. If you decrease its value, the 
color becomes whitish overall. 
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4-5-9.  Specify the print direction 

When you click on the [Advanced] in the [Printing Preferences] dialog box, you can make the settings for [Uni-Directional 
Printing]. 
<TIPS> 
• What you have specified on the printer's operation panel are prioritized, and this option becomes active only when the print 

direction specified on the printer side is set to [Auto]. 
• Print time will be doubled. 
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4-6.  Using Useful Tools 

Useful tools and print data are provided for adjusting colors or searching for an appropriate print setting. 
The "Useful Tools" will be installed onto the subdirectory under the "Brother GTX-6 Tools" of your PC. 
For the details of each tool, please refer to the chapters described later. 
 
 

4-6-1.  Use the color palette 

The different color palettes are available for each software application as follows: 
• Adobe Photoshop/Illustrator: "GT_Colors_T.ase" 
• CorelDRAW: “GT_Colors.xml" and "GT_Tshirts.xml" 

 
For more information, refer to a relevant page (☞"4-3. Using other applications >>P.88") or help menu of each 
application software. 
<TIPS> 
• When using the printer driver by default, use one of them as a color sample to check color reproduction and create/edit the 

image data. (Because CorelDRAW cannot contain identical color in the same palette, the color palette is divided into two files.) 
 
 

4-6-2.  Replace RGB=255 with RGB=254 (for Photoshop only) 

For Photoshop, use this to change RGB=255 to RGB=254. 

(1) From the "Useful Tools", click "SolidWhite.atn", and follow the on-screen instructions to save the file on your PC. 

(2) In the menu bar of Photoshop, select [Window] > [Action file]. 

(3) Click on  to open the submenu. 

(4)  From the [Load Actions], select "SolidWhite.atn" saved on your PC. 
<TIPS> 
• For information on using action files, refer to the Help feature that Photoshop is provided with. 
• "SolidWhite.atn" can be used only when the [Color mode] is set to [8 bit] of [RGB Color]. 
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4-6-3.  Check the color sample 

Use when checking the color sample. 
Please use this color chart as a color sample like the one that is commonly provided by an ink maker, for the print data 
(ARX6 file) you created using your desired printer driver setting. 
<TIPS> 
• Make use of this color chart when you perform the printing after changing the settings of the printer driver. 

 

(1) From the "Useful Tools", click a required file name to download the data. The following files are provided as color 

samples. 
• GT_Blues.pdf 
• GT_Greens.pdf 
• GT_Oranges.pdf 
• GT_Reds.pdf 
• GT_ColorChart.pdf 

(2) Configure the printer driver and create print data. 
<TIPS> 
• For details of the printer driver's setting procedures. 

・In the case of print data using white ink ☞"4-4-1. Setting up the printer driver >>P.106" 
・In the case of print data using color ink and black ink only ☞"4-5-1. Setting up the printer driver >>P.124" 

• For information on creating print data, ☞"4-3. Using other applications >>P.88" 

(3) Send the created print data to the printer and perform printing. ☞"5. Basic printing procedures >>P.143" 
<TIPS> 
• Check the print result and adjust the printer driver's settings. 
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4-6-4.  Print a grid pattern on the platen sheet 

You can print a grid pattern onto a new platen sheet. 

X0163 

(1) From the "Useful Tools", open such an ARX6 file (for example, Grid14×16.arx6) that has a grid size suitable to the 

platen size. 

(2) Send the print data of grid pattern to the printer. 

(3) Without putting a T-shirt in place, print the grid pattern directly onto the platen sheet. 
<TIPS> 
• After the printing is completed, press down the printed surface lightly with a dry cloth or a sheet of paper to dry the ink. 

 

Platen sheet 

Platen 

Grid
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4-6-5.  Adjust the ink volume 

Set an optimum setting for [Ink Volume:] of the printer driver. 
Download the data from "Useful Tools" and perform printing (☞"5. Basic printing procedures >>P.143") to check the 
blurring beforehand. 
<TIPS> 
• Appropriate ink volume setting value depends on color or material of the T-shirt. It is recommended to consider and decide on an 

appropriate ink volume setting value before creating print data. 
• There are four types of ink volume printing data. Select the ink volume print data to match the [Double Printing:] setting for the 

printer driver. 

(1) Select the desired file from "Ink Volume SinglePrint.arx6", "Ink Volume DoublePrint1.arx6", "Ink Volume 

DoublePrint2.arx6", and "Ink Volume DoublePrint3.arx6" from the "Useful Tools" to download data. 

(2) Send the data to the printer and perform printing. 

(3) Check the print result and adjust the value for [Ink Volume:] of the printer driver. 
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4-6-6.  Print out of highlight check pattern/mask check pattern 

Set an optimum setting for [Highlight:] of the printer driver. 
Download the data from "Useful Tools" and print the highlight check pattern for checking whiteness, background hiding 
level, and blurring beforehand. 
<TIPS> 
• Please print on a pretreated T-shirt. ☞"5. Basic printing procedures >>P.143" 
• Appropriate highlight setting value depends on color or material of the T-shirt. It is recommended to consider and decide on an 

appropriate highlight setting value before creating print data. 

(1) From the "Useful Tools", click "Highlight-Mask Check at MW1.zip" or "Highlight-Mask Check at MW2.zip" to 

download data. 
<TIPS> 
• The file you should select differs depending on whether "Minimum Whiteness:" is set to [1] or [2].  

Check the number at the end of the file name before downloading the file. 

(2) Unzip the file and the following print data will be displayed. 
• "HighlightCheckPattern" 
• "MaskCheckPattern" at each highlight 

(3) Print "HighlightCheckPattern" and select the optimum highlight setting. 

(4) Print "MaskCheckPattern" for the optimum highlight setting and select the optimum mask setting. 

(5) Check the print result and adjust the values for [Highlight:] and [Mask:] of the printer driver. 
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4-6-7.  Color adjustment for 2 color heads 

Check the color adjustment of the color-side heads. 

(1) From the "Useful Tools," click "COLOR ADJUSTMENT.arx6" to download data. 

(2) Send the data to the printer and perform printing. 

(3) Check the print result to make sure the color adjustment has been set correctly. 

 
 

4-6-8.  Check the ejection timing 

Check whether or not the ejection timing is correct. 

(1) From the "Useful Tools", click "FIRING CHK COLOR A.arx6" or "FIRING CHK COLOR B.arx6" or "FIRING CHK 

WHITE A.arx6" or "FIRING CHK WHITE B.arx6" to download data. 

(2) Send the data to the printer and perform printing. 

(3) Check the print result to make sure the ejection timing has been set correctly. 
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4-6-9.  Position adjustment for the 2 heads of the same color 

Check the position of the print head. 

(1) From the "Useful Tools," click "HEAD POSITION ADJUSTMENT_C.arx6" or "HEAD POSITION 

ADJUSTMENT_W.arx6" to download data. 

(2) Send the data to the printer and perform printing. 

(3) Check the print result to make sure the position adjustment has been set correctly. 

 
 

4-6-10.  Platen feed adjustment 

Check whether or not the platen feed adjustment is appropriate. 

(1) From the "Useful Tools", click "FEEDING PATTERN(1).arx6" to download data. 

(2) Send the data to the printer and perform printing. 

(3) Check the print result to make sure the platen feed adjustment has been set correctly. 
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4-6-11.  Check the print position 

Check the alignment of the print position on the white side with the print position on the color side. 

(1) From the "Useful Tools", click "ALIGN CHK.arx6" to download data. 

(2) Send the data to the printer and perform printing. 

(3) Check the print result to make sure the print position on the white side has been aligned with the print position on 

the color side correctly. 
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WARNING 

 

 

 
 

If a foreign object gets inside the printer, immediately turn off the power, disconnect the power cord, and 
contact the place of purchase or a qualified technician. If you continue to use the printer while there is a 
foreign object inside, it may result in fire or electric shocks or problems with correct operation. 

 

 

 

 

Do not allow the printer to come into contact with liquids. Otherwise it may cause fire or electric shocks or 
problems with correct operation. 
If any liquid gets inside the printer, immediately turn off the power, disconnect the power cord, and contact the 
place of purchase or a qualified technician. 

 

 

 

Do not use the printer when smoke or a bad odor is coming from the printer. Otherwise it may cause fire or 
electric shocks or problems with correct operation. Immediately turn off the power, disconnect the power 
cord, and contact the place of purchase or a qualified technician. 

 
Keep your finger or any body part away from the rotating fan. Otherwise it will be caught up, which results in 
injuries. 
Turn off the power when you approach the fan. 

  

CAUTION 

 
This printer should only be used by operators who are appropriately trained in its safe operation. 

 
Ensure there is adequate space left in front of the printer and avoid placing any objects. Otherwise your hand 
may get caught between the platen and an object, which may result in injury. 

 
Do not handle the platen while printing. If your hand gets caught between the platen or the T-shirt tray and 
the covers, it may be injured. 

 
Do not put your hands inside the covers while the printer's power is turned on. Otherwise your hands may 
touch against moving parts and this may result in injury. 

 
Do not drink liquids such as the ink, cleaning solution, pretreatment, or waste. They may cause diarrhea or 
vomiting. 
When handling liquids, such as the ink, cleaning solution, pretreatment, and waste, use protective glasses 
and gloves to avoid causing your eyes and skin to contact the liquids. It may cause inflammation. In case of 
contact with eyes, do not rub but immediately rinse the eyes with water. 
Keep the liquids out of the reach of children. 

 
When the pretreatment is applied to printed objects (like a T-shirt) with a spray or pretreatment applicator, 
sprayed mist is generated. So wear a pair of plastic gloves, a mask and protective glasses (or goggles) 
designed to shield against liquid splash, and fully take care of the air ventilation when you are working with it.

 
When a problem occurs with the operation of the printer, contact the place of purchase or a qualified 
technician. 
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 IMPORTANT 

 
Do not move the platen by hand. Otherwise the printer may be mechanically and electrically damaged. 

 
Ensure there is adequate space left in front of the printer and avoid placing any objects. The platen may be 
hit and damaged. 
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5-1.  Basic printing process flow 

What are described below are the basic work flows before the start and after the completion of print process. 
 

Fixation of 
ink 

Removing 
printed matter 

from platen 

Remove the print medium from the platen. 
☞"5-9. Removing printed matter from platen >>P.175" 

Fixate the ink onto the print medium. 
☞"5-10. Fixation of ink >>P.176" 

Printing 

Start the print operation. 
☞"5-7. Executing a printing job >>P.171" 

Sending/Loadin
g Print Data 

Placing print 
medium in 
position 

Platen 
adjustment 

Pretreatment for 
print medium 

To fixate the white ink onto a T-shirt, apply the pretreatment to it beforehand. 
If you are not using white ink, you do not need to pretreat print medium. 
☞"5-3. Pretreating process for print medium >>P.147" 

Replace the currently used platen with another one that suits the print medium. 
After the platen replacement is completed, adjust the platen's height. 
☞"5-4. Platen adjustment >>P.156" 

Put a print medium on the platen. 
☞"5-5. Placing print medium in position >>P.159" 

Send or load print data to the printer. 
☞"5-6. Sending/Loading Print Data >>P.162" 

Tasks to be 
performed before 

starting print 
operation 

Before starting printing, perform check and preparation tasks on the printer. 
☞"5-2. Tasks to be performed before starting print operation >>P.146" 
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5-2.  Tasks to be performed before starting print operation 

5-2-1.  Confirmation of Water Supply Tank 

Before starting the work, check that the water supply tank has water in it. 
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5-3.  Pretreating process for print medium 

 
To fixate the white ink onto the surface of fabric of a T-shirt, apply the pretreatment to it beforehand. If you are not using 
white ink, you do not need to pretreat print medium. 

Workflow of pretreating process 
Step Item Detailed description 

1 Dilution of pretreatment 
Put the pretreatment into a polypropylene container or the like, and dilute it with 
pure water. 

2 
Application of diluted 
pretreatment 

By means of a spray, apply the diluted pretreatment onto the print medium. 

3 Fixation of pretreatment 
Fixate the pretreatment by using the heat press to apply heat and pressure onto 
the print medium. 

 
 

5-3-1.  Provisions for pretreatment 

Items to be prepared 
With reference to the table below, make what you need available in advance. 

 

Items to be prepared 
Pretreatment ○ 
Pretreatment ○ 
Weighing instrument ○ 
Spray ○ 
Heat press ○ 
Peel-off sheet △ 
Silicone foam (of open-cell structure) △ 
Adhesive roller △ 
 

 Pretreatment 
It is the white liquid that is needed for pretreating process for printing with white ink. If a print medium is not 
coated with this agent, no color development of white ink takes place, and the whiteness becomes insufficient. 
Also, no color will be produced from the color inks that are applied onto the white ink. Use a spray to apply the 
pretreatment onto a T-shirt and the heat press to fixate it. 

<CAUTION> 
 Be sure to wear a pair of plastic gloves, a mask and protective glasses during the work operation. 
 For information on handling of the pretreatment, see the Material Safety Data Sheet issued by us.  

http://sds.brother.co.jp/sdsapp/index.html 
 

 Pretreatment 
It refers to distilled water, purified water, etc. which is used to dilute the pretreatment with it. 

 

○: What you need 
△: Useful items, if any 

http://sds.brother.co.jp/sdsapp/index.html
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 Spray (Commercial product) 
This is used to apply the pretreatment onto a T-shirt. Use a spray (preferably of an electrically-operated type) 
that can emit fine spray. A spray allows for easy and even coating and reduces non-uniform coating, while it 
requires a special space for using it. 
In addition to a spray, a pretreatment applicator (commercial product) is available that can apply the 
pretreatment onto a T-shirt automatically. As required, make them available for use separately. 

<CAUTION> 
 Fully take care of the air ventilation when you are in operation that generates mist, such as spray application. 
 Be sure to wear a pair of plastic gloves, a mask and protective glasses (or goggles) designed to shield against liquid splash 

during the work operation. 
 For information on handling of the pretreatment, see the Material Safety Data Sheet issued by us.  

http://sds.brother.co.jp/sdsapp/index.html 
<IMPORTANT> 
 If you are using an electric spray to apply the pretreatment, perform the work at a place as far as possible from the printer. 

Otherwise, it may cause failure of print heads. 
 

 Heat press 
It must deliver the performance through which the print range of the platen can be covered and 180°C (356°F) 
can be kept for 35 seconds or more. At a fixing stage of the pretreatment, be sure to use the heat press, but not 
an oven, to smoothen the surface. 

 
 Peel-off sheet 

When using the heat press, place this sheet on a T-shirt so that neither inks nor pretreatment can be attached to 
the press surface of the heat press. As a peel-off sheet, use a silicone-coated paper or a fluororesin sheet. 
There is a tendency to bring the print result to an almost matte finish if a silicone-coated paper is used at the ink 
fixation stage. There is a tendency to bring the print result to an almost bright finish if a fluororesin sheet is used 
at the ink fixation stage. 

 
 Silicone foam (of open-cell structure) 

It is the foamed mattress which is made of silicone that resists heat. When fixating the inks or pretreatment by 
means of the heat press, use this foam to ventilate steam with ease. 

 
 Adhesive roller 

Use these to remove lint from a T-shirt or debris from its surface. 
 

 T-shirt (printing medium) 
100%-cotton fabric or polyester blended yarn fabric (cotton 50% or more) 

<TIPS> 
 Although it is advisable to use a 100% cotton T-shirt, some textiles cannot necessarily guarantee good printing quality even 

if they are made of 100% cotton or blended yarn. In particular, for a T-shirt made of new material, perform a printing test on 
it beforehand. 

 Some textiles may leave noticeable imprints of the pretreatment after it is fixated. In that case, wash them away with water. 
 Perform a printing test beforehand. Then, the following phenomena may occur:  

- The textiles may be discolored by the pretreatment and cannot be restored to the original color even if they are washed.  
- A deep-colored polyester blended yarn fabric dissolves dye, which may cause the white ink to change to a slightly different 
color.  
- It is likely that a textile may become yellowish in color after the pretreatment is fixated. 

http://sds.brother.co.jp/sdsapp/index.html
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5-3-2.  Dilution of pretreatment 

Be sure to use the pretreatment after diluting it with pure water. 
<CAUTION> 
 Be sure to wear a pair of plastic gloves and protective glasses during the work operation. 
 For information on handling of the pretreatment, see the Material Safety Data Sheet issued by us.  

http://sds.brother.co.jp/sdsapp/index.html 

Dilution ratio 
Use within the ratio range of x3 (Pretreatment:Pure water=1:2) (Volume ratio). 
 

Dilution method 
<TIPS> 
 The figure below is based on the pretreatment (20 kg (44 lb)). When using the pretreatment (5 kg (11 lb)), remove the cap and 

pour the agent into the container, and dilute it with pure water, referring to step (4) and the subsequent steps. Dilution ratio is the 
same. 

(1) Unpack the pretreatment container from the shipping carton by cutting off the perforated paper along the perforated 

tear-off line to open the carton. 

 

(2) Remove the cap, and place the cap in position. 

 

X0079

X0080

Pretreatment

Faucet

Cap 

Pretreatment 

http://sds.brother.co.jp/sdsapp/index.html
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(3) Orient the pour spout of faucet in the position as shown in the figure below. 

 
 

(4) Pour the pretreatment with the carton into the container for dilution and dilute the pretreatment with pure water. 
<IMPORTANT> 
 Dilute the pretreatment three times (pretreatment with pure water at the ratio of 1:2 by volume). 
 Close the lid of the container for dilution and stir the content well to make the concentration uniform. 

 

(5) To provide safekeeping for the pretreatment, close the faucet, place the pretreatment with the faucet part facing 

upward, and store the entire carton in a safe place. 

X0081

X0082
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5-3-3.  Application of pretreatment 

In order for the pretreated portions to be printed with inks, apply the pretreatment evenly to a wider area than the print 
range. 
<CAUTION> 
 Fully take care of the air ventilation when you are in operation that generates mist, such as spray application. 
 Be sure to wear a pair of plastic gloves, a mask and protective glasses (or goggles) designed to shield against liquid splash 

during the work operation. 
 For information on handling of the pretreatment, see the Material Safety Data Sheet issued by us.  

http://sds.brother.co.jp/sdsapp/index.html 
<IMPORTANT> 
 Some T-shirts may leave distinct imprints of the pretreatment after it is fixated. Wash away any imprint of the pretreatment with 

water, if any.  
Also, some T-shirts may be discolored by the pretreatment and cannot be restored to the original color even if they are washed.  
When performing the printing for the first time, do that after applying the agent to an unnoticeable area on trial. 

 If you are using an electric spray to apply the pretreatment, perform the work at a place as far as possible from the printer. 
Otherwise, it may cause failure of print heads. 

Reference guide for amount of coating of pretreatment 
Determine a coating area and amount of coating according to a platen size. When your coating area differs from what 
are shown in the table below, calculate the amount of coating based on the area ratio. 
<IMPORTANT> 
 Depending on the type of fabric, the print quality cannot be guaranteed with the amount of coating of pretreatment shown below. 

It is therefore necessary to conduct sufficient print tests and adjust the amount of coating. 
 If the amount of coating of pretreatment is too small, imprints of the pretreatment may become less noticeable after it is fixated, 

whereas color reproduction of the white ink and color inks on the white ink will deteriorate. 
 Meanwhile, if the amount of coating of pretreatment is too large, imprints of the pretreatment may become noticeable, the printed 

surface may be cracked or discoloring may occur after washing. 
 

Platen Size Amount of coating of pretreatment 
24 x 24 77 g (3 oz) 
18 x 22 53 g (2 oz) 
16 x 18 39 g (1 oz) 
14 x 16 30 g (1 oz) 
10 x 12 16 g (1 oz) 
7 x 8 8 g (0.5 oz) 

Letter size/A4-size 15 g (1 oz) 
Pocket size (3.9 in. x 3.9 in. (10 cm x 10 cm)) 3 g (0.5 oz) 

 

http://sds.brother.co.jp/sdsapp/index.html
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For coating with a pretreatment applicator (commercial product: preferably of an electrically-operated type) 

(1) Fill the pretreatment applicator with the diluted pretreatment. 
<TIPS> 
 Please use a pretreatment applicator (preferably of an electrically-operated type) that can emit fine spray. 

 

(2) Set the T-shirt on the pretreatment applicator, and apply the pretreatment evenly onto the print surface. 

 
 

X1039

Pretreatment applicator 

Smooth out the wrinkles 

T-shirt 
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For coating with a spray (commercial product: preferably of an electrically-operated type) 

(1) Fill the spray with the diluted pretreatment. 
<TIPS> 
 Please use a spray (preferably of an electrically-operated type) that can emit fine spray. 

 

(2) Put a T-shirt flatly on a flat surface or lean it back against wall, and apply the pretreatment evenly onto it with a 

spray. 
<CAUTION> 
 Fully take care of the air ventilation when you are in operation that generates mist, such as spray application. 
 Be sure to wear a pair of plastic gloves, a mask and protective glasses (or goggles) designed to shield against liquid splash 

during the work operation. 
 For information on handling of the pretreatment, see the Material Safety Data Sheet issued by us.  

http://sds.brother.co.jp/sdsapp/index.html 
<IMPORTANT> 
 If you are using an electric spray to apply the pretreatment, perform the work at a place as far as possible from the printer. 

Otherwise, it may cause failure of print heads. 
<TIPS> 
 Note that pretreatment will not soak into the back (reverse) side of a T-shirt if you put an intermediate plate in the T-shirt. 

Remove the intermediate plate from the T-shirt before the pressing stage. 
 When you are still unaccustomed to the spray coating, perform it while measuring the amount of coating by means of a 

weighing instrument. 
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http://sds.brother.co.jp/sdsapp/index.html
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5-3-4.  Fixation of pretreatment 

<CAUTION> 
 As the operation will generate mist, fully take care of the air ventilation. 
 Be sure to wear a pair of plastic gloves, a mask and protective glasses (or goggles) designed to shield against liquid splash 

during the work operation. 
 For information on handling of the pretreatment, see the Material Safety Data Sheet issued by us.  

http://sds.brother.co.jp/sdsapp/index.html 
<TIPS> 
 Because the pretreatment will not work best if it is dried through oven-based drying or air drying, be sure to use the heat press. 

As the oven does not bind fuzziness, the agent may be applied unevenly on white print. 
 When you put a T-shirt on the heat press, set it so as to flatten the T-shirt's surface, place a peel-off sheet on the entire press 

area, and apply pressure. 
 Note that any area in which the pretreatment is fixated may cause its effect to deteriorate or could cause the agent to be coated 

there unevenly if such area gets wet once. 
 Do not touch the treated area with your hand after the pretreatment is fixated. 
 After the pretreatment is fixated, do not touch or place the T-shirts on top of each other. 
 Avoid leaving the pretreatment as it is in any highly humid areas. 
 If the agent is left unchecked for a long time, use the heat press to apply pressure to a T-shirt immediately before the printing in 

order to dry it well. 

Guidelines on fixation conditions of pretreatment 
The undermentioned fixation temperature/time serve as guidelines only, and optimum conditions vary with your heat 
press. Be sure to perform the fixation after checking on the temperature and fixation results beforehand. 
<TIPS> 
 Prior to and during a fixation process, check the heat press's temperature. If the fixation is performed continuously, the heat 

press's temperature will decrease, resulting in improper fixation of the pretreatment. In this case, the whiteness cannot be 
reproduced because the white ink soaks into the fabric of a T-shirt. 

 Such a pressure is required that is adequate enough to flatten the surface. As the fixation conditions differ by heat press, check 
the ink fixation result in advance and adjust the pressure. 

 If it is not dry enough after pressing for 35 seconds, extend the time while checking the dried condition of the pretreatment. 
 The following values should be regarded as guidelines only, for the optimum fixation conditions depend on the amount of coating 

of pretreatment. 
 

Temperature Time 
180°C (356°F) 35 seconds 

 

http://sds.brother.co.jp/sdsapp/index.html
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(1) Place the silicone foam, T-shirt and peel-off sheet in position under the heat press first, and fixate the pretreatment 

properly. 
<TIPS> 
 Water droplets are generated around the heat press to evaporate water content of the pretreatment by the heat of heat 

press. Keep your working space clean so that the surface to be coated with the agent will not get wet. 
 A peel-off sheet should be used if needed, depending on the heat press you use. 

 
 

(2) Remove the T-shirt from the heat press so that the steamy heat will escape from it. 
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5-4.  Platen adjustment 

 
Replace the currently used platen with another one that suits the medium to be printed. 
<CAUTION> 
 Hold the platen with both hands and be careful not to drop the platen at the time of platen replacement. 
<TIPS> 
 In cases where such an optionally sized platen as 10X12 platen is used, ascertain that a proper "Platen size" has been selected 

in the printer driver's setting menu.  
- For print data using white ink, ☞"4-4-2. Select the platen size >>P.108" 
- For print data using color ink and black ink only, ☞"4-5-2. Select the platen size >>P.126" 

 

5-4-1.  Replacing the currently used platen with another one 

(1) On the operation panel, press , and move the platen toward the front of the printer. 

 
 

(2) Loosen the platen fixing handle by rotating it one to three turns. 

 

X1038
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Platen

Platen 
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(3) Remove the platen moving it straight upwards by holding both ends of it. 

 
 

(4) Put another platen to be used in position directly from above. 

 
 

(5) Tighten the platen fixing handle. 
<TIPS> 
 Place the platen fixing handle sideways so that the platen fixing handle will not come in contact when setting the platen or 

T-shirt.  
If the platen fixing handle is in portrait orientation, pull the platen fixing handle sideways and turn it in landscape orientation. 

 

Platen 

Platen 

Platen fixing handle 

Platen
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5-4-2.  Platen height adjustment 

Select a proper position of the platen corresponding to the print medium. 

(1) Select [Platen Height Adjustment] from the menu, and select an appropriate position from [Position A] to [Position 

H]. 
<IMPORTANT> 
 Do not handle the platen while printing. Injury may result if your hand gets caught between the platen or T-shirt tray and a door or 

cover. 
 Be careful not to put your hands in the clearance of the cover of the lifting up/down mechanism. Doing so may cause injury.  

Otherwise, the operator may get injured. 
<TIPS> 
 There are custom positions that can be set to any height.  

You can set the height from the menu by selecting [Printer Setting] > [Platen Setting] > [Height User Setting]. ☞"7-10-1. User 
settings for height >>P.249" 

 You can set the platen height with the print data.  
If [Print Data Height] is selected, the platen will be adjusted to the height specified in the loaded print data.  
・For print data using white ink, ☞"4-4-3. Selecting platen height >>P.109" 
・For print data using color ink and black ink only, ☞"4-5-3. Selecting platen height >>P.127" 

 

 

Platen Height Adjustment 
Head Cleaning 
Test Print 
Ink Refill 
Print Data Load 

Printer Setting 

Position A 
Position B 
Position C 
Position D 
Position E 

Platen Height Adjustment 
Position F 
Position G 
Position H 
User setting 1 
User setting 2 

Platen Height Adjustment 

Print Data Height 
Platen Height Adjustment 
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5-5.  Placing print medium in position 

 
In order to provide an optimum printing image quality when a print medium is placed in position, you need to adjust the 
platen's height in accordance with the thickness of the T-shirt or other print medium. 
<CAUTION> 
 Ensure there is adequate space left in front of the printer and avoid placing any objects. The platen moves forward while 

operating and it can strike/damage anything set in its path of movement. 
 Do not handle the platen while printing. If your hand gets caught between the platen or the T-shirt tray and the covers, it may be 

injured. 
<IMPORTANT> 
 Do not move the platen by hand. Otherwise the printer may be mechanically and electrically damaged. 
<TIPS> 
 Adjust the height of the platen corresponding to the print medium before using it. As a rough indication, adjust the height so that it 

is lowered by one step from the limit height detected by the obstacle sensor, and check that the platen is not detected by the 
sensor.  
In the event that the platen's height is lowered excessively, ink mist will be scattered inside the printer, which may result in 
staining of the printing surface, blurring of the printed image, and malfunction of the sensor and the main unit. 

 Use Uni-Directional Printing in the case where the platen's height needs to be lowered to avoid a hemmed (edge) and seam.  
☞"7-1. Setting the print direction >>P.244" 

 

(1) If the platen has not been moved forward, press  on the operation panel. 

(2) Adjust the platen's height. 
<TIPS> 
 Set the platen height to [Position A] or in the neighborhood for a T-shirt, and to [Position C] or in the neighborhood for thick 

material, such as a sweatshirt. 
 If the platen's height is lowered too much, the printing quality may deteriorate, the main unit may be soiled with ink mist and 

so on. 
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(3) Put a T-shirt onto the platen, with its printing side facing upward. 
<TIPS> 
 For the position alignment of white or pale-colored T-shirts, a grid to be printed out on the platen sheet is available from [All 

Programs] in the Start menu, by selecting "Brother GTX-6 Tools" > "Useful Tools".  
☞"4-6-4. Print a grid pattern on the platen sheet >>P.137" 

 

(4) Smooth down the creases in the T-shirt and remove lint and dust from it. 
<TIPS> 
 Seams on a hemmed (edge), neck portion, armhole, tucks and sleeves or the like are easily detected by the obstacle 

sensor. 
 In particular, both ends of the T-shirt tend to be raised easily during the printing operation if not flattened properly and 

detected by the obstacle sensor. 
 Touching on the fixated pretreated surface should be avoided during the work. 
 Do not pull the T-shirt with the pretreatment applied. Instead, flatten it in such a way that it will fit onto the platen surface 

well. 
 When the surface of the T-shirt does not remain flattened properly, the obstacle sensor detects it. 
 In the event that any T-shirt is placed on the platen by pulling it outward forcibly, there are instances in which ejection areas 

of the white and color inks are misaligned and the white ink extends off its specified printing area. In particular, be careful 
not to stretch a thin T-shirt outward on the platen. 
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(5) The T-shirt should be placed on the T-shirt tray, trying not to draw the excessive parts like sleeves and hems into 

the printer. 

 
 

(6) On the operation panel, press , and move the platen toward the rear of the printer. 

Try moving the platen, and check on the gap between the T-shirt surface and the obstacle sensor over the entire print area. 
<TIPS> 
 If this gap is too wide, adjust the platen height. 
 Adjust the height so that it is lowered by one step from the limit height detected by the obstacle sensor, and check that the 

platen is not detected by the sensor. 
 If the platen's height is too high, a print medium will strike against the print head during the printing process, which in turn 

results in ink stains or malfunction. 
 

(7) On the operation panel, press , and move the platen toward the front of the printer. 

<TIPS> 
 Repeat the height adjustment until the platen will be positioned at a proper height. 
 After your desired height is determined, start the printing operation. ☞"5-7. Executing a printing job >>P.171" 
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5-6.  Sending/Loading Print Data 

Print data can be loaded into the printer in the following ways: 
 Receive the print data from the PC connected with the USB 3.0 or LAN cable. 
 Load the print data from the USB flash memory. 

For details, please refer to the chapters described later. 
 

5-6-1.  Sending print data from ARX6 file preview 

(1) Open an ARX6 file. 
<TIPS> 
 Double click on the ARX6 file, or select [All Programs] > "Brother GTX-6 Tools" > "GTX-6 File Viewer", to select and open 

the ARX6 file. You can also load ARXP and ARX4 files. 
 

(2) The file's printing conditions and preview window will be displayed. 
<TIPS> 
 If you have selected [Color+White Ink] or [White Ink Only] in the Select Ink operation, the preview window will be displayed 

against a "Black" background or a "Transparent color" background which has been specified in the Advanced settings. 
 If you have selected [Color Ink Only] in the Select Ink operation, the preview window will be displayed against a "White" 

background. 
 When you press the Details button, those items that have been specified in the Advanced setting window of the printer 

driver appear. 
 

 When [Color+White Ink] or [White Ink Only] is selected 
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 When [Color Ink Only] is selected 

 
 

 [Details] 
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(3) If you have selected [Color+White Ink] or [White Ink Only] in the Select Ink operation, you can change the 

background color of the preview window and preview the print image. Select [Change...] > [Define Custom Colors], 

and enter RGB value. 
<TIPS> 
 When the [White Data] checkbox is marked, the preview window for white ink only will be displayed. 

 

 

 
"Example: Preview window for printing an image on a brown (R=128, G=64, B=64) T-shirt" 
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(4) For the print data that requires multiple cycles of platen reciprocate movement, print data of each layer can be 

verified separately by selecting the desired layer to be displayed. From the [Present Layer], select a layer that you 

want to bring into the view. 
<TIPS> 
 In the layer that is shown as [Total], the preview window of the final print result is displayed. 
 When the [White Data] checkbox is marked, the preview window for white ink only will be displayed. 

 

(5) Check the printing conditions and preview window, and click on [Send to Printer]. 
Then, the ARX6 file is sent to the printer. 
<TIPS> 
 Make sure that a connection of USB 3.0 cable or LAN cable is made between your PC and the printer. 
 In the event that two or more GTX-6 printer drivers have been installed on your PC, select one of them as the destination of 

data transmission and click [OK]. 
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5-6-2.  Sending print data from applications 

CorelDRAW 

(1) In the menu bar, select [File] > [Print]. 

(2) Open [General] tab and select "Brother GTX-6" from [Printer]. 
<TIPS> 
 If the specified [Printer] is set to "Brother GTX-6", the print data will be sent to the printer.  

If the specified [Printer] is set to "Brother GTX-6 FileOutput", the print data will be saved as an ARX6 file. 

(3) Open the [Color] tab, and make the following settings: 
 Place a checkmark in the [Document color] checkbox. 
 [Color conversions]: "Brother GTX-6" or "Brother GTX-6 FileOutput" 
 [Color Profile]: [sRGB IEC61966-2.1] 
 [Rendering intent]: [Relative colorimetric] 

 
(4) On [Preferences], set up the printer driver and send the print data by clicking [OK] in the [Print] dialog box. 

<TIPS> 
 How to set the printer driver 

- For print data using white ink, ☞"4-4-1. Setting up the printer driver >> P.106" 
- For print data using color ink and black ink only, ☞"4-5-1. Setting up the printer driver >>P.124" 

 Clicking on [OK] will not start the print operation of the printer itself. The print button of the printer should be pressed to start 
the printing operation. 
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Adobe Photoshop 

(1) In the menu bar, select [File] > [Print]. If the PC's default printer is either "Brother GTX-6" or "Brother GTX-6 

FileOutput", the layout is set to the platen size. 

(2) Make the settings as follows: 
 [Color Handling]: [Printer Manages Colors] 
 [Rendering Intent]: [Relative Colorimetric] 

 

(3) From [Printer], select "Brother GTX-6". 
<TIPS> 
 If [Printer] is set to "Brother GTX-6", the print data will be sent to the printer.  

If [Printer] is set to "Brother GTX-6 FileOutput", the print data will be saved as an ARX6 file. 

(4) In the [Print Settings], set up the printer driver, and send the print data by clicking [Print]. 
<TIPS> 
 How to set the printer driver 

- For print data using white ink, ☞"4-4-1. Setting up the printer driver >>P.106" 
- For print data using color ink and black ink only, ☞"4-5-1. Setting up the printer driver >>P.124" 

 Clicking on [Print] will not start the print operation of the printer itself. The print button of the printer should be pressed to 
start the printing operation. 
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Adobe Illustrator 

(1) In the menu bar, select [File] > [Print] > [Color Management]. 

(2) Make the settings as follows: 
 [Document Profile]: [sRGB IEC61966-2.1] 
 [Color Handling]: [Let Illustrator determine colors] 
 [Printer Profile]: [sRGB IEC61966-2.1] 
 [Rendering Intent]: [Relative Colorimetric] 

 

(3) From [Printer], select "Brother GTX-6". 
<TIPS> 
 If [Printer] is set to "Brother GTX-6", the print data will be sent to the printer.  

If [Printer] is set to "Brother GTX-6 FileOutput", the print data will be saved as an ARX6 file. 

(4) In the [Advanced], set up the printer driver, and send the print data by clicking [Print]. 
<TIPS> 
 How to set the printer driver 

- For print data using white ink, ☞"4-4-1. Setting up the printer driver >>P.106" 
- For print data using color ink and black ink only, ☞"4-5-1. Setting up the printer driver >>P.124" 

 Clicking on [Print] will not start the print operation of the printer itself. The print button of the printer should be pressed to 
start the printing operation. 
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5-6-3.  Loading print data (ARX6 file) from USB flash memory 

(1) Insert a USB flash memory into the insertion slot in front of the operation panel of the printer. 
<IMPORTANT> 
 Do not apply undue force to the USB flash memory when you insert it into the slot. Otherwise, it could be damaged. 
<TIPS> 
 Please use a FAT32-formatted USB flash memory of which storage capacity is 2 GB to 32 GB in total. You cannot use a 

USB flash memory with security functions such as password lock function or beyond 32 GB. 
 Note that the data which can be loaded from the USB flash memory is only the data in ARX6, ARXP, or ARX4 format. 

 
 

(2) From the menu, select [Print Data Load], and press . 

<TIPS> 
 The information on file is shown on the liquid crystal panel. 

 
(3) Select a filename to be printed out, and press . 

<TIPS> 

 Selecting  will display the file stored in . 

 Folders in the USB flash memory are shown down to the 3rd layer. Folders created in the 4th layer or below are not 
displayed. 
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(4) Check the print image displayed in the preview window, and press . 

<IMPORTANT> 
 Never touch the USB flash memory when the print button is blinking. Otherwise, any already-saved data may be corrupted. 
<TIPS> 
 Depending on data size, it may take several minutes before the loading process is completed. 
 If any files of USB flash memory cannot be read out. ☞"8-1. Troubleshooting instructions>>P.267" 

 If a folder contains more than one print data item, use the  buttons to switch the preview window. 

 
The print data loading will be completed when the print button stops blinking and remains lit, while the electric chime sounds. 
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5-7.  Executing a printing job 

5-7-1.  Executing a print job once for a single print medium 

(1) Receiving a print data file. 
The print button blinks during reception of data. When the data reception is completed, an audible alarm is activated and the print 
button illuminates. 
As there are two types of audible alarms, make sure the mounted platen matches the platen size of the print data. 
<TIPS> 
 When data of the same platen size as the previous one was received: A notice sound of "ping-pong" is output. 
 When data of a different platen size from the previous one was received: A notice sound of "ping-pong pan-pong" is output. 

(2) Make sure that the print data you want to print out is displayed on the liquid crystal panel, and press and hold the 

two print buttons at the same time to start printing. 
<TIPS> 
 You will hear a sound each time you press the print buttons and after a certain period has lapsed. 

Keep pressing them until the second sound is heard. Releasing them too soon causes the printing to be canceled. 

(3) When the printing is completed, the platen moves to the forward-most position and the sound of "pong" is heard. 
<TIPS> 
 If the print buttons are pressed when the platen has not moved toward the front, no print job will be started. 

 Pressing  causes the printing to be canceled. 

 The printer may shift to low temperature operation mode, when the room temperature is less than 18°C (64.4°F) and white 
ink is used.  
During low temperature mode, it may take a longer time for print operation and maintenance before starting the print. 
Change the low temperature operation setting as needed. ☞"7-11. Print Operation Settings Under Low Temperature 
>>P.251" 

 High-temperature and low-humidity environment may prolong the maintenance time after completion of printing. If any 
warning message about temperature and humidity is displayed, be sure to control the temperature and humidity promptly 
so as to conform with the print warranty scope. ☞"10-1. Apparatus >>P.308" 
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5-7-2.  Executing a print job several times for multiple print media 

You can keep the identical print data and execute a print job several times for multiple print media. 
<TIPS> 
 When the power is turned off, the retained print data is erased. 

(1) Make sure that the print data you want to print out is displayed on the liquid crystal panel, and press and hold the 

two print buttons at the same time to start printing. 
<TIPS> 
 You will hear a sound each time you press the print buttons and after a certain period has lapsed. 

Keep pressing them until the second sound is heard. Releasing them too soon causes the printing to be canceled. 

(2) When the printing is completed, the platen moves to the forward-most position and the sound of "pong" is heard. 
<TIPS> 
 If the print buttons are pressed when the platen has not moved toward the front, no print job will be started. 

 Pressing  causes the printing to be canceled. 

 The number of print media of which printing is completed is shown on the liquid crystal panel. 
 The printer may shift to low temperature operation mode, when the room temperature is less than 18°C (64.4°F) and white 

ink is used.  
During low temperature mode, it may take a longer time for print operation and maintenance before starting the print. 
Change the low temperature operation setting as needed. ☞"7-11. Print Operation Settings Under Low Temperature 
>>P.251" 

 High-temperature and low-humidity environment may prolong the maintenance time after completion of printing. If any 
warning message about temperature and humidity is displayed, be sure to control the temperature and humidity promptly 
so as to conform with the print warranty scope. ☞"10-1. Apparatus >>P.308" 

(3) Replace the platen's printed medium (T-shirt) with the next one and repeat the procedure until the desired number 

of print jobs are completed. 
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5-7-3.  Performing the printing from receiving history 

You can print out such print data that you have received before. 
<TIPS> 
 The print data that can be retained are max. 100 pieces of them and 800 MB in total capacity, wherein each print data will be 

erased in the order from the oldest to the latest. 
 When the power is turned off, the retained print data is erased. 

(1) From the menu, select a print data you want to print out in the [Receiving History]. 
<TIPS> 
 Each of the pieces of print data is displayed in the order in which they are received from the newest to the oldest ones. 

(2) Make sure that the print data you want to print out is displayed on the liquid crystal panel, and press and hold the 

two print buttons at the same time to start printing. 
<TIPS> 
 You will hear a sound each time you press the print buttons and after a certain period has lapsed. 

Keep pressing them until the second sound is heard. Releasing them too soon causes the printing to be canceled. 

(3) When the printing is completed, the platen moves to the forward-most position and the sound of "pong" is heard. 
<TIPS> 
 If the print buttons are pressed when the platen has not moved toward the front, no print job will be started. 

 Pressing  causes the printing to be canceled. 

 The printer may shift to low temperature operation mode, when the room temperature is less than 18°C (64.4°F) and white 
ink is used.  
During low temperature mode, it may take a longer time for print operation and maintenance before starting the print. 
Change the low temperature operation setting as needed. ☞"7-11. Print Operation Settings Under Low Temperature 
>>P.251" 

 High-temperature and low-humidity environment may prolong the maintenance time after completion of printing. If any 
warning message about temperature and humidity is displayed, be sure to control the temperature and humidity promptly 
so as to conform with the print warranty scope. ☞"10-1. Apparatus >>P.308" 
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5-8.  Scheduling a print 

Even if the printer is not in the standby state, this function allows you to schedule printing by pressing the Print button in 
advance so that the printer will start printing as soon as it becomes available. 
 

5-8-1.  When you can schedule printing 

You can schedule printing by pressing the Print button in advance while the print data is being received and during the 
post-print processing.  
This is useful if the printer performs the post processing for the previous print job after you remove the printed T-shirt and 
set a new T-shirt to the platen. 
<TIPS> 
 Be sure to remove the printed T-shirt from the platen and set the next T-shirt to the platen before you press the Print button.  
 You cannot press the Print button in advance if the printer is being operated from the menu or an error has occurred. 
 

When you can schedule printing Description 
The printer is receiving print data While the printer is receiving print data sent via the USB 3.0 or LAN cable 

The printer is post-processing after a 
print 

When a print job finishes and the platen is unloaded and while the printer is 
wiping, capping, cleaning the wiper, or performing an auto purge after a print 
job 

 

5-8-2.  When a scheduled print begins 

A scheduled print begins when each of the following conditions is true. 
When you schedule printing When the print begins 

The printer is receiving print data When the printer has completely received print data 
The printer is post-processing after a 
print 

When the printer has finished all the processes such as wiping, capping, 
cleaning the wiper, or an auto purge after a print job 

 
<TIPS> 
 The Print button flashes fast during the period between when you schedule printing and when the printing begins. 
 

5-8-3.  When printing does not begin 

A scheduled printing does not begin when each of the following conditions is true. 
 If an error occurs when printing should begin. (For example, this is true if the ink is depleted in the previous print 

job.)  
 If the data to print is missing from the printer when printing should begin. 

 

5-8-4.  Canceling scheduled printing 

You can cancel scheduled printing by pressing the Cancel button during the period between when you schedule printing 
and when printing begins. 
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5-9.  Removing printed matter from platen 

(1) Hold the shoulder portions of print medium with your hand, and pull it out slowly in the forward direction indicated. 
<IMPORTANT> 
 Because the printed surface is still wet with ink, avoid touching it. 
 If any ink is attached to your hands, wash your hands with soap and water. 
 Those inks that are attached to fabrics cannot be cleaned up, please handle the inks with utmost care. 
<TIPS> 
 The printed ink is not fixated at this point - therefore, handle the T-shirt with care to avoid the printed surface touching with 

other objects. 
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5-10.  Fixation of ink 

For fixation of ink, use the heat press or oven. 
 Heat press 
 It is useful because you can control its temperature and operating time with ease. 
 Oven 
 If the number of articles to be printed is high, it will improve the operational efficiency. 

<CAUTION> 
 Please use the heat press and oven in a well-ventilated area. If your working area is not well ventilated, wear a protective mask. 
<TIPS> 
 If the inks are fixated insufficiently, discoloring may occur due to washing and friction. 
 Keep the fixation surface of heat press and peel-off sheet clean.  

Otherwise, the printing surface may be soiled with stains from the peel-off sheet. 
 If a printed material is rubbed with vinyl-chloride-based white or light-colored synthetic leather, color transfer may occur.  

When a color-printed surface is rubbed strongly against a printed surface with only white ink, color transfer may occur in the 
same fashion.  
When a color transfer takes place, wipe the color-transferred area and clean off dirt with a soft and clean cloth or a toothbrush 
that is moistened with a small amount of mild detergent for home use and/or alcohol. 

 Component of pretreatment remains on the T-shirt on which the ink was fixated after applying pretreatment. For this reason, it is 
advisable to wash such T-shirts with water before wearing them. 

Guidelines on fixation conditions of ink 
The undermentioned fixation temperature/time serve as guidelines only, and optimum conditions vary with your heat 
press or oven. Be sure to perform the fixation after checking on the temperature and fixation results beforehand. 
<TIPS> 
 Because optimum conditions vary depending on the type of your heat press or oven, use the fixation conditions as a reference 

guide. Be sure to adjust the conditions while checking on the temperature and ink fixation results beforehand. 
 Because some print media easily get scorched, please carefully check and see how the surface actually looks like.  

In particular, the print media onto which the pretreatment has been applied will easily get scorched. 
 When using the heat press, adjust the pressure while checking the ink fixation result. 
 If it is not dry enough after processing for the period of the guideline, extend the time while checking the dried condition of the ink. 
 

Device Temperature Time 
Heat press 180°C (356°F) 35 seconds 

Oven Surface temperature: 160°C (320°F)*1 3 min. and 30 sec. to 5 min. 
*1: Because a T-shirt may be discolored if this temperature increases too high, great care should be taken to exercise 

temperature control. 
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Ink fixation by means of heat press 

(1) Place the silicone foam, T-shirt and peel-off sheet in position under the heat press first, and fixate the ink properly. 
<TIPS> 
 For the guidelines on fixation conditions of ink, ☞"5-10. Fixation of ink >>P.176" 
 For details, refer to the instruction manual of your heat press. 
 There is a tendency to bring the print result to an almost matte finish if a silicone-coated paper is used as a peel-off sheet or 

to an almost bright finish if a fluororesin sheet is used as the same at the ink fixation stage. Selectively use either of them 
according to your desired finish. 

 

Ink fixation by means of conveyor-type oven 

(2) Fixate inks onto a T-shirt by means of the conveyor-type oven. 
<TIPS> 
 For the guidelines on fixation conditions of ink, ☞"5-10. Fixation of ink >>P.176" 
 For the conveyor-type oven, identify the oven's internal temperature, and check up on actual ink fixation result. 
 For details, refer to the instruction manual of your conveyor-type oven. 
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6 Precautions to keep good printing quality/use printer over the long term

 

DANGER 

 
Contact with high voltage sections may lead to a serious injury. Turn off the power, and remove the cover 5 
minutes later. 

 

CAUTION 

 
Be careful not to pinch your fingers when closing each door and cover. You may get injured if you pinch your 
fingers. 

 Do not drink liquids such as the ink, cleaning solution, pretreatment, or waste. They may cause diarrhea or 
vomiting. 
When handling liquids, such as the ink, cleaning solution, pretreatment, and waste, use protective glasses 
and gloves to avoid causing your eyes and skin to contact the liquids. It may cause inflammation. In case of 
contact with eyes, do not rub but immediately rinse the eyes with water. 
Keep the liquids out of the reach of children. 

 Be sure to wear protective goggles and gloves when handling the grease, so that it does not get into your 
eyes or onto your skin. 
It can cause inflammation. 
Do not drink or eat the grease. It may cause diarrhea or vomiting. 
Keep the liquids out of the reach of children. 

 When replacing parts and installing optional accessories, be sure to use only genuine Brother parts. Brother 
will not be held responsible for any accidents or problems resulting from the use of non-genuine parts. 

 When replacing parts or installing optional accessories, be sure to follow the procedures described in the 
Instruction Manual. Incorrect procedures could cause injuries or problems. 

 

IMPORTANT 

 Do not move the platen by hand. Otherwise the printer may be mechanically and electrically damaged. 

 Ensure there is adequate space left in front of the printer and avoid placing any objects. The platen may be 
hit and damaged. 
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6-1.  Tasks to be performed regularly 

6-1-1.  Refilling color ink 

If  is displayed in the remaining ink volume indication window on the operation panel screen, refill the ink. 

<CAUTION> 
• Be sure to wear a pair of plastic gloves and protective glasses during the work operation. 
• Take care not to lose the IC stick that comes standard with the ink bottle. 
• Once you have refilled ink, you cannot print until you insert the IC stick. 

 

 

(1) From the menu, select [Ink refill] and press . 

(2) From [Black], [Yellow], [Cyan], and [Magenta], select the color with no ink and press . 

(3) Insert the IC stick of the same color as the refilled ink and press . 

<TIPS> 
• An error appears if you insert an IC stick of a different color from the depleted ink. 

 
  

Ink refill: Yellow 

× Error 

IC stick insertion slot
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(4) Open the ink bottle and attach the supplied faucet. 
<IMPORTANT> 
• Protect the ink on the faucet in use with a plastic bag to prevent the ink from drying out. 
• Do not use a non-standard funnel. Use the provided faucet. Otherwise, ink may be contaminated or deteriorated, possibly 

damaging the printer. 

 

(5) Open the ink tank lid and refill ink up to above graduation mark 4. 
<IMPORTANT> 
• Take care not to exceed the graduation mark in 6. 

 

(6) Press  on the operation panel. Close the ink tank lid and press  again. 

<IMPORTANT> 
• Be sure to close the ink tank lid once you have refilled the ink. 

(7) Remove the IC stick following the instructions on screen and press . 

<NOTE> 
• Store the IC stick by attaching it to the handle of the ink bottle. 
• Dispose of any waste resulting from the replacement in accordance with applicable laws and ordinances. 
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6-1-2.  Refilling white ink 

If  is displayed in the remaining ink volume indication window on the operation panel screen, refill the ink.  

Agitate the white ink sufficiently to remove sediments before refilling it. Agitate the ink beforehand because it takes time. 
<IMPORTANT> 
• Do not use ink not agitated sufficiently because doing so may deteriorate the durability of the printed matter or cause the head 

not to eject ink-jet droplets. In cases where the printer malfunctions due to the use of ink not agitated sufficiently, you may be 
liable for the cost of repairs even during the guarantee period. 

• Agitate ink by shaking the ink bottle. 
• Do not insert a bar or propeller into the ink bottle when agitating the ink because doing so causes foreign matter inclusion, 

possibly resulting in printer failure. 
 
<CAUTION> 
• Be sure to wear a pair of plastic gloves and protective glasses during the work operation. 
• Take care not to lose the IC stick that comes standard with the ink bottle. 
• Once you have refilled ink, you cannot print until you insert the IC stick. 

 

Agitating white ink with an agitator 
<IMPORTANT> 
• Be sure to install an agitator.  

To choose from many types of agitators available, consult your dealer. 
<TIPS> 
• When agitating the white ink, remove the IC stick from the refill ink bottle to prevent it from falling off. 
 

(1) Set the ink bottle to the agitator. 
<IMPORTANT> 
• Securely fasten the ink bottle by means of a jig to prevent it from falling during agitation. 

 

(2) Perform agitation with reference to the manual of your agitator. 
<TIPS> 
• The recommended agitation time differs depending on the ink stationary period and agitator performance. 
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X1045

(3) Hold the ink bottle upside down and apply lighting to its side face to visually check sediments.  

A dark shadow is seen on the bottom if sediments are remaining, so repeat steps (1) and (2) until such a dark 

shadow disappears. 
<TIPS> 
• Use bright lighting and darken the surrounding area to make the sediments more visible. 

 
 
Agitated state 

With sediments Without sediments 

  

 
 
<TIPS> 
• The shadows of bubbles may be confusing with sediments after the white ink agitation, so leave the bottle until bubbles 

disappear before checking for sediments.  
To distinguish between bubbles and sediments, lightly shake the ink bottle. The shadows of bubbles move, but the shadows of 
sediments do not move. 
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How to refill white ink 

 

(1) From the menu, select [Ink refill] and press . 

(2) Select [White] and press . 

(3) Insert the white IC stick and press . 

<TIPS> 
• An error appears if you insert an IC stick of a different color from the depleted ink. 

 
  

Ink refill： White 
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(4) Open the ink bottle and attach the supplied faucet. 
<IMPORTANT> 
• Protect the ink on the faucet in use with a plastic bag to prevent the ink from drying out. 
• Do not use a non-standard funnel. Use the provided faucet. Otherwise, ink may be contaminated or deteriorated, possibly 

damaging the printer. 

 

(5) Open the ink tank lid and refill ink up to above graduation mark 6. 
<IMPORTANT> 
• Take care not to exceed the graduation mark in 6. 

 

(6) Press  on the operation panel. Close the ink tank lid and press  again. 

<IMPORTANT> 
• Be sure to close the ink tank lid once you have refilled the ink. 

(7) Remove the IC stick following the instructions on screen and press . 

<NOTE> 
• Store the IC stick by attaching it to the handle of the ink bottle. 
• Dispose of any waste resulting from the replacement in accordance with applicable laws and ordinances. 
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6-1-3.  Refilling the cleaning solution 

If  is displayed in the remaining ink volume indication window on the operation panel screen, refill the ink. 

<CAUTION> 
• Be sure to wear a pair of plastic gloves and protective glasses while working. 
<TIPS> 
• Also check to see if the cleaning solution is kept at a proper liquid level in the cleaning solution tank and refill the tank with the 

solution if its amount is insufficient. 

 

 

(1) From the menu, select [Refill Ink] and press . 

(2) Select [Cleaning solution] and press . 

(3) Open the cleaning solution bottle and attach the supplied faucet. 
<IMPORTANT> 
• Protect the ink on the faucet in use with a plastic bag to prevent the ink from drying out. 
• Do not use a non-standard funnel. Use the provided faucet. Otherwise, the cleaning solution may be contaminated or 

deteriorated, possibly damaging the printer. 
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(4) Open the cleaning solution tank lid and fill the tank with the cleaning solution up to above graduation mark 6. 
<IMPORTANT> 
• Take care not to exceed graduation mark 6. 

 

(5) Press  on the operation panel. Close the cleaning solution tank lid and press  again. 

<IMPORTANT> 
• After filling the cleaning solution, be sure to close the cleaning solution tank lid. 
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6-1-4.  Correcting the remaining ink level 

When a warning message appears in the warning message window, correct the remaining ink level. 

 

(1) From the menu, select [Maintenance] > [Correct tank volume sensor], and press . 

(2) Press . Enter the scale for the ink level and press . 

 
<TIPS> 
• Check and correct the color scale displayed on the panel. 
• If the level is between the scales, make a correction based on the lower value. 
<CAUTION> 
• If you enter an incorrect value, the remaining level may not be correctly recognized and the printer may be damaged. 

 

Tank correction timing
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6-1-5.  Replacement of maintenance parts 

When a warning message appears on the operation panel screen, replace each maintenance part. 

 

<TIPS> 
• For the way to perform replacement, refer to the respective maintenance parts section. 

☞"6-1-6. Replacing the wiper >>P.189" 
☞"6-1-7. Replacing the cap chip and cap foam >>P.191" 
☞"6-1-8. Replacing the flushing foam >>P.194" 
☞"6-1-9. Replacing the carriage foam >>P.197" 

  

Replace wiper 
Replace cap foam 
Replace flushing foam 
Replace carriage foam 

! WARNING
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6-1-6.  Replacing the wiper 

When a warning message appears on the operation panel screen, conduct replacement work. 
<TIPS> 
• Once you have selected [Maintenance Part Clean/Replace], you do not need to select it repeatedly in the case of replacing the 

wiper, flushing foam, cap tip, cap foam, and carriage foam in sequence. 

(1) Have the supplied gloves and wiper ready. 

(2) From the menu, select [Maintenance] > [Maintenance Part Clean/Replace] > [Maintenance Unit Part Replace], and 

press . 

<IMPORTANT> 
• If any other error or message is displayed on the operation panel or warning message window, follow the message to solve 

the problem, then perform the cleaning. 
• Please complete the task within 25 minutes, in order to prevent the print heads from drying up. 
<TIPS> 

• Pressing  causes the platen to start moving. Do not put anything around the platen. 

(3) Unlock the upper left-hand-side cover and top cover and open them. 

 

(4) Remove the wiper from the maintenance unit by pushing up the latch on the left side of the wiper. 
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(5) Hold the latch of the new wiper on the left-hand side and insert the new wiper into the maintenance unit from the 

right-hand side. 
<IMPORTANT> 
• Replace the wipers of the four locations at the same time. 
• Make sure that each wiper is installed in the correct direction. 
• Push the wiper in and make sure that the left and right protrusions are firmly fitted. 

 

(6) Close the upper left-hand-side cover and top cover. 
<NOTE> 
• Dispose of any waste resulting from the replacement in accordance with applicable laws and ordinances. 
• Do not reuse the replaced wipers. 
<TIPS> 
• Then, the head cleaning will be performed to prevent any ink from drying up. 

  

X1169

Right side

Left side 

Right side

Left side

Firmly fit them. 
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Precautions to keep good printing quality/use printer over the long term

6-1-7.  Replacing the cap chip and cap foam 

When a warning message appears on the operation panel screen, conduct replacement work. 
<TIPS> 
• Once you have selected [Maintenance Part Clean/Replace], you do not need to select it repeatedly in the case of replacing the 

wiper, flushing foam, cap tip, cap foam, and carriage foam in sequence. 
• When you replace the cap chip and cap foam, check the staining state inside the printer. If parts inside the printer are stained, 

perform cleaning. ☞"6-2-2. Cleaning and replacing maintenance parts >>P.235" 

(1) Prepare the gloves, cap chip, and cap foam. 

(2) From the menu, select [Maintenance] > [Maintenance Part Clean/Replace] > [Maintenance Unit Part Replace], and 

press . 

<IMPORTANT> 
• If any other error or message is displayed on the operation panel or warning message window, follow the message to solve 

the problem, then perform the cleaning. 
• Please complete the task within 25 minutes, in order to prevent the print heads from drying up. 
<TIPS> 

• Pressing  causes the platen to start moving. Do not put anything around the platen. 

(3) Unlock the upper left-hand-side cover and top cover and open them. 

 

Keyhole 

Keyhole 
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Precautions to keep good printing quality/use printer over the long term

(4) Remove the cap chip and cap foam from the maintenance unit. 
<CAUTION> 
• Do not use sharp objects, such as tweezers, and be sure to remove the cap chip and cap foam by hand. 

 
(5) Wipe the gloves with a waste cloth. 

 

(6) Set a new cap chip and cap foam. 
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<CAUTION> 
• Set the cap foam by aligning the cap foam hole with the protrusion on the backside of the cap rubber. 
• Be careful not to reverse the orientation of the cap foam. 
• The cap chip has two sides. Be careful not to turn it upside down. 
• Be careful not to turn the cap chip upside down when the cap chip and cap foam are assembled. 

 

(7) Close the upper left-hand-side cover and top cover. 
<NOTE> 
• Dispose of any waste resulting from the replacement in accordance with applicable laws and ordinances. 

 
 

Back Surface 

Cap chip

Cap foam hole 

Cap foam
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6-1-8.  Replacing the flushing foam 

When a warning message appears on the operation panel screen or in the warning message window, replace the 
specified flushing foam with a new one. 
<TIPS> 
• Once you have selected [Maintenance Part Clean/Replace], you do not need to select it repeatedly in the case of replacing the 

wiper, flushing foam, cap tip, cap foam, and carriage foam in sequence. 
• When you replace the flushing foam, check the staining state inside the printer. If parts inside the printer are stained, perform 

cleaning. ☞"6-2-2. Cleaning and replacing maintenance parts >>P.235" 

(1) Prepare the gloves and flushing foam (consumable supplies). 

(2) From the menu, select [Maintenance] > [Maintenance Part Clean/Replace] > [Maintenance Unit Part Replace], and 

press . 

<IMPORTANT> 
• If any other error or message is displayed on the operation panel or warning message window, follow the message to solve 

the problem, then perform the cleaning. 
• Please complete the task within 25 minutes, in order to prevent the print heads from drying up. 
• Then, the head cleaning will be performed to prevent any ink from drying up. 
<TIPS> 

• Pressing  causes the platen to start moving. Do not put anything around the platen. 

(3) Unlock the upper left-hand-side cover and top cover and open them. 

 

Keyhole 

Keyhole 
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Precautions to keep good printing quality/use printer over the long term

(4) Remove the flushing foam from the maintenance unit. 
<IMPORTANT> 
• Ink droplets will drop off from the hole in flushing foam. After removal, apply a waste cloth to the bottom face. 
<NOTE> 
• For a proper work operation, be sure to wear the printer-provided gloves. 

 

(5) Wipe the gloves with a waste cloth. 

 X0436
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Precautions to keep good printing quality/use printer over the long term

(6) Set the flushing foam in the maintenance unit. 
<IMPORTANT> 
• After this assembly process is completed, make sure that no flushing foam extends off the outboard end portions of the 

maintenance unit. If it sticks out of the end portions, it may interfere with any nozzles and may result in non-ejection of 
ink-jet droplets. 

 

(7) Close the upper left-hand-side cover and top cover. 
<NOTE> 
• Dispose of any waste resulting from the replacement in accordance with applicable laws and ordinances. 
<TIPS> 
• The head cleaning will be performed to prevent ink from drying up. 
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6-1-9.  Replacing the carriage foam 

When a warning message appears in the warning message window, replace the specified carriage foam with a new 
one. 
<TIPS> 
• Once you have selected [Maintenance Part Clean/Replace], you do not need to select it repeatedly in the case of replacing the 

wiper, flushing foam, and carriage foam in sequence. 

(1) Prepare the gloves and carriage foam, which come standard with the printer. 

(2) From the menu, select [Maintenance] > [Maintenance Part Clean/Replace] > [Maintenance Unit Part Replace], and 

press . 

(3) Select [Replace carriage foam] and press . 

<IMPORTANT> 
• If any other error or message is displayed on the operation panel or warning message window, follow the message to solve 

the problem, then replace the carriage foam. 
• Please complete the task within 25 minutes, in order to prevent the print heads from drying up. 
• There is a risk of damaging the nozzle surface of the head. Be careful not to damage the nozzle surface of the head. 

(4) Unlock and open the right-hand-side cover. 

 

(5) Hold the end of the carriage foam and rotate the carriage foam downward to remove the carriage foam from the 

carriage magnet. Rotate the carriage foam until the carriage foam comes in contact with the sliding surface of the 

foam guide. 
<IMPORTANT> 
• Be careful not to let the carriage foam come into contact with the nozzle surface of the head. 
• Be careful when removing the carriage foam, which may come off suddenly. 

 

Keyhole 

Foam end 

Sliding surface of 
foam guide 
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(6) Pull and remove the carriage foam toward you along the sliding surface of the foam guide after making sure that 

the carriage foam is in contact with the surface of the foam guide. 

 

(7) Put a proper amount of cleaning solution into the cleaning cup. 

(8) Moisten a new clean stick R with the cleaning solution. 
<IMPORTANT> 
• Use a new clean stick R when you start cleaning. 
• Never touch the tip end of clean stick R with your hand. If any sebaceous matter is attached to the nozzle surface, it may 

malfunction the printer. 
• Do not use other fluids (water, etc.), because they may damage the print heads. 
• Do not return the cleaning solution which has been put in the cleaning cup to the cleaning solution bottle. 
• Do not shed cleaning solution in the maintenance unit. 
<NOTE> 
• For a proper work operation, be sure to wear the printer-provided gloves. 
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Precautions to keep good printing quality/use printer over the long term

(9) Clean the side of the print heads. 
<TIPS> 
• The use of a flashlight is recommended to make it easier to see when cleaning. 
• It is not easy to see the rearward side of the nozzle guard. It is recommended to clean it while checking the cleaning 

condition with a mirror. 
Nozzle guard side cleaning 

 

 

After nozzle guard side cleaning 

Head frontward side Head rearward side 
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Precautions to keep good printing quality/use printer over the long term

Head frontward and rearward cleaning 

 

 

(10) Remove ink clots, if any, protruding from the nozzle surface on the underside of the carriage. 

 

X1049

Nozzle surface 
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Ink clot example 
<CAUTION> 
• When removing ink clots, do not use hard objects like iron tweezers. The nozzle may be damaged, resulting in non-ejection 

if the objects touch the nozzle or other parts. 
Use gloves and remove ink clots by pinching them with a clean stick or your fingers. 

 

(11) Clean the top of the steel plate next to the flushing foam. 

 

Cleaning location 
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<CAUTION> 
• Be sure to use a clean waste cloth. Using a waste cloth with pretreatment may lead to non-ejection. 
• Do not rub the parts strongly. Doing so may damage the parts. 
• Wipe in the direction of the arrow to prevent the peeled ink waste from entering the flushing foam and the wiper cleaning 

solution tank. 
<TIPS> 
• If it is difficult to remove the ink built up, clean it with the cleaning solution for GTX-6 (GCX-6W09L). 

When doing so, do not apply the cleaning solution directly to the top surface of the steel plate, but rather use a waste cloth 
soaked with the cleaning solution. 

 

 Pre-cleaning state Post-cleaning state 

On the 
color side 

 

On the 
white side 
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(12) Place the tip of the new carriage foam on the sliding surface of the foam guide. 

(13) Move the foam along the sliding surface of the guide in the direction of the arrow, and move the carriage foam until 

it touches the two stopper. 

 
 
 

Sliding surface of foam guide

Stopper
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(14) Rotate and assemble the foam to the magnet on the carriage.  

Make sure that the carriage foam does not ride on the four stopper. 
<IMPORTANT> 
• Be careful not to let the carriage foam come into contact with the nozzle surface of the head. 

 

(15) Make sure that the nozzle surface is below the bottom surface of the foam. 

 

(16) Close and lock the right-hand-side cover. 

(17) From the menu, select [Exit], and press . 

 
 

Stopper 

Foam bottom 

Nozzle surface 
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Precautions to keep good printing quality/use printer over the long term

6-1-10.  Replacing the mist fan filter 

When a warning message appears in the warning message window, replace the mist fan filter with a new one. 
The inside of the main unit may become dirty with mist, which may cause a malfunction if you continue using the mist 
fan filter without replacement. 

 
 

(1) Prepare gloves and a new mist fan filter. 

(2) From the menu, select [Maintenance] > [Maintenance Part Clean/Replace] > [Clean nozzle guard and cap], and 

press . 

(3) Select [Replace mist fan filter], and press . 

<IMPORTANT> 
• If any other error or message is displayed on the operation panel or warning message window, follow the message to solve 

the problem, then perform the cleaning. 
<TIPS> 

• Pressing  causes the platen to start moving. Do not put anything around the platen. 

(4) Push in and open the mist fan door. 
<NOTE> 
• For a proper work operation, be sure to wear the printer-provided gloves. 

 

Replace mist fan filter 
!  WARNING
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(5) Hold the grip and remove the mist fan filter. 

 

(6) Insert a new mist fan filter and push in and close the mist fan door. 
<CAUTION> 
• Insert the mist fan filter completely, on the side with the grip facing upward. 

 
(7) Replace the other one in the same way. 

(8) Press  by following the on-screen instructions to finish the work. 

<NOTE> 
• Dispose of any waste resulting from the replacement in accordance with applicable laws and ordinances. 

 

Mist fan filter

Mist fan filter 
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Precautions to keep good printing quality/use printer over the long term

6-1-11.  Replacing the platen sheet 

When the platen sheet gets soiled, replace it with a new one. 

(1) Remove the platen from the main unit of the printer. ☞"5-4-1. Replacing the currently used platen with another one 

>>P.156" 

(2) Peel the platen sheet off the platen. 
<TIPS> 
• When it is hard to peel the platen sheet off, warm it using a hair dryer or the like and peel it off. 
<NOTE> 
• For a proper work operation, be sure to wear the supplied gloves. 

 

(3) Wipe the surface of the platen with a clean cloth moistened with a mild detergent which is diluted with water, then 

wipe the platen clean with a dry and soft clean cloth. 

(4) Mount the platen in the main unit of the printer. ☞"5-4-1. Replacing the currently used platen with another one 

>>P.156" 

(5) Peel the release paper (small in size) off a new platen sheet. 
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Precautions to keep good printing quality/use printer over the long term

(6) Position the platen sheet to match the platen surface, and onto the platen, stick the portion of the platen sheet 

where the release paper (small) was removed. 

 

(7) Peel off the rest of the release paper, and paste the whole platen sheet onto the entire platen. 
<TIPS> 
• Straighten the platen sheet, and stick it properly while pressing it with hands outward from the center to avoid making 

wrinkles. 

 

(8) As required, print a grid pattern onto the new platen sheet. ☞"4-6-4. Print a grid pattern on the platen sheet 

>>P.137" 
<TIPS> 
• After the printing is completed, press down the printed surface lightly with a dry cloth or a sheet of paper to dry the ink. 
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Precautions to keep good printing quality/use printer over the long term

6-1-12.  Replacement of print head 

If a problem of non-ejection of ink-jet droplets is not cleared even after cleaning the head nozzle, replace a The print 
head with a new one. 
Check the head position of the corresponding print head with the non-ejection of ink-jet droplets in the nozzle check 
pattern, and replace the print head by following the procedure. ☞"6-1-17. Print out the nozzle check pattern (checking 
on the print heads) >>P.222" 
<TIPS> 
• Do not confuse the color side print head with the white side print head.  

Check the case color (red for the color side, white for the white side) and replace the case. 
• Both color print head and white print head have side A and side B. Be sure to set them correctly. 
• Ink needs to be re-installed after replacing the print head. If the ink level is low, refill ink. 
<NOTE> 
• For a proper work operation, be sure to wear the supplied gloves. 

 

(1) From the menu, select [Maintenance] > [Head Replacement] > [Corresponding print head], and press . 

(2) Follow the on-screen message and turn off the power. 
<IMPORTANT> 
• Please complete the task within 15 minutes, in order to prevent the print heads from drying up. 

(3) Unlock the upper left-hand-side cover and top cover and open them. 

 

Keyhole 

Keyhole 
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Precautions to keep good printing quality/use printer over the long term

(4) Remove the upper case of a new print head. 

(5) Remove four caps from the new print head. 

 

(6) Remove each tube from the print head to be replaced with a new one. Then attach each of the new caps which are 

removed from a new print head to each tube, while exercising care to prevent any ink from being spilled. 
<IMPORTANT> 
• Care is needed in preventing any ink from being spilled from each tube. If the ink is dripping, wipe off the dripping ink. 
<NOTE> 
• For a proper work operation, be sure to wear the printer-provided gloves. 

 

(7) Remove the latch on the carriage board cover and open the cover. 
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Precautions to keep good printing quality/use printer over the long term

(8) Remove the head board of the corresponding print head. 
<CAUTION> 
• Be sure not to touch other boards. 

 

(9) Remove the hook and clamp and disconnect the flat cable. 

 
(10) Unlock the print head, and remove the print head. 

<IMPORTANT> 
• When removing the print head, be careful not to drip the ink on the carriage plate. If the ink is dripping, wipe off the dripping 

ink. 
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Precautions to keep good printing quality/use printer over the long term

(11) Release the lock by pulling part (a) on the case to the left and take out the new print head from its case. 
<IMPORTANT> 
• When removing the print head, be careful not to touch the nozzle surface at the bottom of the head. Otherwise it may cause 

poor printing. 
<TIPS> 
• Sometimes, you may find it hard to remove the print head when you try to open the lock of (a) part. If it is hard, use both 

hands to remove it. 

 

(12) Mount the new print head onto the carriage and push in the lock bar of the print head to lock the print head. 
<IMPORTANT> 
• Be careful not to pinch the flat cable between the metal plate of the print head and the carriage. 
• Be careful not to let the metal plate of the print head ride on the positioning part. 
• Be careful not to touch the lock of the other head and release the lock. 

 
 

(13) Connect the head board aligned with the positioning pins on the carriage board. 
<IMPORTANT> 
• After connecting, check that the head board is not tilted. 
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Precautions to keep good printing quality/use printer over the long term

(14) Place the flat cable in the hook and clamp on the carriage. 
<CAUTION> 
• Ensure that the flat cable for head A does not overlap with that for head B. 
• Extend the flat cable on the print head side toward the carriage board so that the flat cable will not bend. 
• Fold the flat cable on the print head side. 

 

(15) Close the carriage board cover. 
<IMPORTANT> 
• Make sure that the latch is securely closed. 
• Ensure that the flat cables do not extend past the edge of the cover. 
<CAUTION> 
• Ensure that the flat cable for head A does not overlap with that for head B. 

 

(16) Remove the cap you connected in step (6) from the tube, and connect the tubes to the print head. 
<IMPORTANT> 
• Check the stamp on the print head and the tube number, and make sure that they are connected in the correct position. 

Incorrectly connecting them may cause the ink to leak during the circulation. 
<CAUTION> 
• Ensure that the flat cables do not extend past the edge of the cover. 
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(17) Tighten the nut firmly until it stops so that each tube is fixed to the print head. 
Head A side 1 2 3 4 
Head B side 5 6 7 8 

 

(18) Close the upper left-hand-side cover and top cover and turn on the power. 

(19) From the menu, select [Maintenance] > [Install Ink after Replacing Head] > [Corresponding print head], and press 

. 

Perform the work operation by following the on-screen instructions. 
<TIPS> 
• After the procedures are completed, the current screen will go back to the standby mode screen. 
• Replace other print heads in the same way. 

(20) Print the nozzle check patterns. ☞"6-1-17. Print out the nozzle check pattern (checking on the print heads) 

>>P.222" 

(21) Perform the initial settings after head replacement configuration. ☞"3-6-1. Initial settings after head replacement 

>>P.69" 

(22) After color head replacement, if any, make color adjustment for 2 color heads. ☞"3-6-2. Color adjustments 

between the two color heads >>P.70" 

(23) Adjust the ejection timing of the print head. ☞"3-6-3. Firing adjustment >>P.71" 

(24) Make position adjustments for the 2 heads of the same color. ☞"3-6-4. 2 same color heads position adjustment 

>>P.72" 

(25) Perform the platen feed adjustment. ☞"3-6-5. Platen-rolling adjustment >>P.73" 

(26) Make the position adjustment between the white head and the color head. ☞"3-6-6. White/color alignment >>P.74" 

1 2
3 4

5 6
7 8
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Precautions to keep good printing quality/use printer over the long term

6-1-13.  Cover adjustments 

Adjust each cover if they do not close smoothly. 

 

Tilt adjustments 

(1) Turn the adjustment screw on the front side clockwise or counterclockwise to make adjustments if a cover is tilted. 

Turn the adjustment screw clockwise to lower the cover and counterclockwise to raise the cover. 

 

Upper right side cover 

Upper left side cover

Lower left side cover

Adjustment screw 

Hinge
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Left/right adjustments 

(1) Turn the adjustment screw on the front side clockwise or counterclockwise to make adjustments if the cover 

interferes with the adjacent cover. Turn the adjustment screw clockwise to reduce the clearance and 

counterclockwise to increase the clearance. 

 
Up/Down adjustments 

(1) Turn the adjustment screw in the center clockwise or counterclockwise to make up and down adjustments. 

Turn the adjustment screw clockwise to raise the cover and counterclockwise to lower the cover. 

 

Hinge

Adjustment screw 

Adjustment screw 

Hinge
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Back/Forth adjustments 

(1) Turn the adjustment screw On the inside clockwise to make back and forth adjustments. 

 

Adjustment screw

Hinge
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6-1-14.  Tube air bleed 

If air is mixed in the print head or tube and ink non-ejection is not improved, bleed the air in the tube. 

(1) While the printer is in standby mode, press  on the operation panel to bring the menu screen into view. 

(2) Press , select [Maintenance] > [Tube air bleed], and press . 

(3) Select the item you want to bleed air from and press . 

 
(4) Select the color you want to bleed air from and press . 

<TIPS> 
• Select the number for the white head. ☞"6-1-12. Replacement of print head>>P.209" 

 
(5) Follow the message displayed on screen, press  on the operation panel.  

Air bleeding in the tube is executed. 
 
 
 
 
 

Tube air bleed
White head A 
White head B 
Color head A 
Color head B 

Tube air bleed (CL_A)
Black 
Yellow 
Cyan 
Magenta 
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6-1-15.  Head cleaning 

This printer has been designed to perform the Auto Cleaning every time 72 print jobs are printed after the previous Auto 
Cleaning, or before starting the printing using the white ink when one hour or more elapses after the previous printing 
that used the white ink. 
<TIPS> 
• The frequency and start timing of Auto Cleaning can be changed. ☞"7-13. Auto Cleaning Setting >>P.253" 
 
In the event that there is any faintly printed or missing portion on a printed material, head cleaning sometimes provides a 
solution. 
 

Selecting a type of head cleaning from the menu to perform the head cleaning 

(1) While the printer is in standby mode, press  on the operation panel to bring the menu screen into view. 

(2) From the menu, select [Head Cleaning], and press . 

 

(3) By pressing , select one of the options: [Normal Cleaning], [Powerful Cleaning] or [Super Cleaning], and 

press . 

<TIPS> 
• For selecting a desired cleaning option, follow the instructions in the respective steps. ☞"8-2-1. Recovery action to be 

taken for such a nozzle that is unable to eject ink-jet droplets >>P.277" 

 
  

Menu 
Platen Height Adjustment 
Head Cleaning 
Test Print 
Ink Refill 
Print Data Load 

Head Cleaning
Normal Cleaning 
Powerful Cleaning 
Super Cleaning 
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(4) Select any head with  and press . 

<TIPS> 
• Under the condition that the nozzle which has been confirmed not ejecting ink-jet droplets, determine the color for which the 

head cleaning should be performed. ☞"6-1-17. Print out the nozzle check pattern (checking on the print heads) >>P.222" 

 
(5) Then, the head cleaning will be performed for the specified print heads. 

<TIPS> 
• The cleaning operation cannot be canceled halfway. 
• After the procedures are completed, the current screen will go back to the standby mode screen. 

 
 

Normal Cleaning
All Colors 
All Whites 
All Print Heads 
Color head A 
Color head B 

Normal Cleaning 
White head A 
White head B 
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6-1-16.  White ink circulation 

When whiteness is not enough, it may be solved by performing white ink circulation. 

(1) While the printer is in standby mode, press  on the operation panel to bring the menu screen into view. 

(2) From the menu, select [Maintenance] > [White Ink Circulation], and press . 

<IMPORTANT> 
• Do not turn off the power because if you do so, the printer may fail because necessary maintenance operations are not 

performed. 
<TIPS> 
• Completing the white ink circulation varies depending on the ambient temperature. Usually, it takes about 8-9 minutes and 

up to 15 minutes. White ink is circulated automatically every four hours, and white ink three times as much as normal is 
circulated every 24 hours. 

• If you are activating the printer after having had its power off for a long period, it will take up to 4 hours depending on how 
long the power was off. 

 
 
 

White Ink Circulation
All Whites 

Please Wait 

[ 1] min. [30] sec.
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6-1-17.  Print out the nozzle check pattern (checking on the print heads) 

By printing out a nozzle check pattern, you can check on the printing quality. 
It is recommended to always perform this procedure to verify the output. 

<TIPS> 
• The serial number, firmware version, print date (day/month/year), time, temperature, humidity, and the number of copies 

printed are printed at the bottom of the nozzle check pattern. 
The date and time will be printed in Coordinated Universal Time with "(UTC)" printed at the end if time adjustment as a 
maintenance tool has not been made. You can print the date and time according to your environment by making time 
adjustment. ☞"3-6-7. Setting of the time displayed on the nozzle check pattern >>P.75" 

(1) Put the platen 14×16 in place, and position its level at "A". 

☞"5-4-1. Replacing the currently used platen with another one >>P.156" and "5-4-2. Platen height adjustment 

>>P.158" 

(2) As illustrated below, put the A4-size or letter-size white paper on the platen in alignment with the right-hand corner 

of the platen at its front edge. 
When the paper is loosely fitted, fix its edge with a tape or the like. 
A T-shirt can also be used instead. 
<TIPS> 
• When printing out a nozzle check pattern on the white side, print it on a pretreated black or dark color textile or black paper, 

or a transparent sheet (such as OHP sheet). 

 X1022
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(3) From the menu, select [Test Print] > [Nozzle Check CMYK], and press and hold the two print buttons 

simultaneously. 

Then, printing will begin. 
<TIPS> 
• You will hear a sound each time you press the print buttons and after a certain period has lapsed. 

Keep pressing them until the second sound is heard. Releasing them too soon causes the printing to be canceled. 

(4) After printing on the color side is completed, remove the printed paper and replace it with a paper for printing on the 

white side. 

(5) From the menu, select [Test Print] > [Nozzle Check White], and press and hold the two print buttons 

simultaneously. 
Then, printing will begin. 
<TIPS> 
• You will hear a sound each time you press the print buttons and after a certain period has lapsed. 

Keep pressing them until the second sound is heard. Releasing them too soon causes the printing to be canceled. 
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X1026

(6) Check to see if the printed result of both sides are acceptable, and if no ink-jet droplets have been ejected, perform 

a head cleaning for print heads. ☞"6-1-15. Head cleaning >>P.219" 
<IMPORTANT> 
• If the print result shows an intermittent line, non-ejection has occurred. A head cleaning should be performed on the print 

head that has a poor nozzle check result. 
• Even if the lines of the white-side printed result are light, since white ink is fired from more than one nozzle on the same 

place, the quality is not affected. 
<TIPS> 
• The following items are printed at the bottom of the nozzle check pattern:  

• Serial number  • Temperature  
• Firmware version  • Humidity 
• Print date (day/month/year) • Number of prints 
• Time 

• The name of the corresponding head (head A or B) is printed next to each nozzle check pattern. 
 

On the color side On the white side 

Non-ejection occurred at the arrowed area. 
 
Example: Non-ejection at color head B black 

Non-ejection occurred at the arrowed area. 
 
Example: Non-ejection at white head A 

 

White head A 

White head B 

Color head B 

Color head A 
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6-2.  Cleaning 

6-2-1.  Cleaning the nozzle guard and suction cap 

When a warning message appears in the warning message window, perform the cleaning. 
In the event that maintenance has been performed inadequately, a printed material may be soiled with waste ink during 
a print session or a printed surface quality may deteriorate. 

 
(1) Make the clean stick R, clean stick T, cleaning cup, gloves and cleaning solution, which come standard with the 

printer, available for use. 

(2) From the menu, select [Maintenance] > [Maintenance Part Clean/Replace] > [Clean nozzle guard and cap], and 

press . 

(3) Select in response to the instructions on the screen. 

<IMPORTANT> 
• If any other error or message is displayed on the operation panel or warning message window, follow the message to solve 

the problem, then perform the cleaning. 
<TIPS> 

• Pressing  causes the platen to start moving. Do not put anything around the platen. 

(4) Follow the on-screen message and start working. 
<IMPORTANT> 
• Please complete the task within 15 minutes, in order to prevent the print heads from drying up. 
• Then, the head cleaning can be performed to prevent any ink from drying up. 

Clean cap 
Please Clean Nozzle Guards 

! WARNING
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(5) Unlock the upper left-hand-side cover and top cover and clean the suction cap. 
Unlock and open the right-hand-side cover and clean the nozzle guard. 
Two types of clean sticks are provided. Use either the clean stick T or R depending on what you want to clean. 
<TIPS> 
• For the cleaning method, refer to the description mentioned below. 

 

(6) After the cleaning is completed, close all the covers. 
<NOTE> 
• Dispose of any waste resulting from the cleaning in accordance with applicable laws and ordinances. 
<TIPS> 
• Then, the head cleaning will be performed to prevent any ink from drying up. 
• Because the cleaning cup will be reused, rinse it in clean cleaning solution and store it in a safe place. 

 

X1013

On the white side

On the color side 

Suction cap

Locations to be 
cleaned with clean 
stick T 

Locations to be 
cleaned with clean 
stick R 

The nozzle guard 
surface and between the 
nozzle guard and nozzle
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The nozzle guard and suction cap should be cleaned separately for the white side and color side. 
For the way to perform cleaning, refer to the respective items. 

 X1069

Perform cleaning of the white side. 

Nozzle guard 
Cleaning 

Prepare a new clean stick R and the cleaning solution. 

Perform cleaning of the nozzle guard part on the white side. 
☞"Cleaning the nozzle guard (Use clean stick R) >>P.228" 
After cleaning the nozzle guard part, remove ink clots, if any, protruding from the nozzle surface. 

Rinse the cleaning cup, and prepare a new clean stick R and the cleaning solution. 

Cleaning suction 
cap 

Perform cleaning of the suction cap part on the white side. 
☞"Cleaning suction cap (Use clean stick T) >>P.231" 

Perform cleaning of the color side. 

Nozzle guard 
Cleaning 

Perform cleaning of the nozzle guard part on the color side. 
☞"Cleaning the nozzle guard (Use clean stick R) >>P.228" 
After cleaning the nozzle guard part, remove ink clots, if any, protruding from the nozzle surface.

Cleaning suction 
cap 

Perform cleaning of the suction cap part on the color side. 
☞"Cleaning suction cap (Use clean stick T) >>P.231" 

Prepare a new clean stick T and the cleaning solution. 

Rinse the cleaning cup, and prepare a new clean stick T and the cleaning solution. 

Clean the backside of the carriage. 
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Cleaning the nozzle guard (Use clean stick R) 

(1) Put a proper amount of cleaning solution into the cleaning cup. 

(2) Moisten a new clean stick R with the cleaning solution. 
<IMPORTANT> 
• Use a new clean stick R when you start cleaning. 
• Never touch the tip end of clean stick R with your hand. If any sebaceous matter is attached to the wiper, it may result in a 

printer malfunction. 
• Do not use other fluids (water, etc.), because they may damage the print heads. 
• Do not return the cleaning solution which has been put in the cleaning cup to the cleaning solution bottle. 
• Do not shed cleaning solution in the maintenance unit. 
<NOTE> 
• For a proper work operation, be sure to wear the printer-provided gloves. 

 

 

X1000

Do not drain waste ink.

Cleaning cup

Cleaning solution 

Clean stick R 

Cleaning cup
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(3) Wipe the area between the print head's nozzle surface and nozzle guard. 
<IMPORTANT> 
• Be sure not to touch the red-frame zone of the nozzle surface. 
• For cleaning, be sure not to use any tool other than clean stick R. 
• Do not rub the nozzle strongly. 

 
 

 
 
Cleaning conditions 

Pre-cleaning state Post-cleaning state 

 

 

 
<IMPORTANT> 
• Be sure to use the clean stick R separately for white ink and color ink. 
 

X1018

X1046

Clean this part 

Cleaning location 
Between the nozzle surface 
and nozzle guard 

Cleaning location 
Between the nozzle surface and nozzle guard

Nozzle surfaceNozzle guard Nozzle guard rearward

Nozzle guard frontward

Cleaning location
Nozzle guard 
rearward 

Cleaning location 
Nozzle guard frontward
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(4) Remove ink clots, if any, protruding from the nozzle surface on the underside of the carriage. 

 
Ink clot example 

<CAUTION> 
• When removing ink clots, do not use hard objects like iron tweezers. The nozzle may be damaged, resulting in non-ejection 

if the objects touch the nozzle or other parts. 
Use gloves and remove ink clots by pinching them with a clean stick or your fingers. 

 
 
 

Nozzle surface 
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Cleaning suction cap (Use clean stick T) 

(1) Wipe the lip of the suction cap in parallel with the side surface of the tip of clean stick T, and then wipe the outer 

frame in the same way. 
<IMPORTANT> 
• Clean the lip of the suction cap with clean stick T. The print head dries and causes an ejection failure if solidified ink 

remains. 
• Do not touch the sponge of the suction cap. The sponge may come off. 
• Never touch the tip end of clean stick T with your hand. If any sebaceous matter is attached to the wiper, it may result in a 

printer malfunction. 
• If ink clot floats on surface, remove it using the clean stick T. Do not use tweezers or other sharp objects. Using sharp 

objects could damage the suction cap and deteriorate its air tightness, possibly resulting in failure to eject ink-jet droplets. 
• Be sure not to pinch the rubber seal. If it is damaged, its sealing property will be degraded, which in turn may lead to 

non-ejection of ink-jet droplets from the print heads. 

 

(2) Replace clean stick T with clean stick R, rinse the cleaning cup, and clean the nozzle guard on the color side head. 
<IMPORTANT> 
• Be sure to use the clean stick T separately for white ink and color ink. 
• The used clean stick T should be disposed of, and should not be reused. 
• After cleaning the nozzle guard of the color side head, rinse the cleaning cup with pure water, let it dry sufficiently, and store 

it so that dust does not get inside. 
 

X1021

Lips Sectional view 

Outer frame 

Clean stick T 

Outer frame 

Sponge 

Outer frame 
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Cleaning conditions 

Pre-cleaning state Post-cleaning state 
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Cleaning the backside of the carriage 

(1) Clean the area shown below on the backside of the carriage. 

 

(2) Use the clean stick R or waste cloth to clean the area. 

 
<CAUTION> 
• When cleaning the backside of the carriage with a waste cloth, make sure that the waste cloth will not touch the nozzle 

surface. The nozzle may be damaged, resulting in non-ejection if the objects touch the nozzle or other parts. 
<TIPS> 
• Clean the white side in the same way. 

 

Cleaning location 

Wipe off the adhered mist ink with a 
waste cloth 

Absorb ink droplets with the clean stick R
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Cleaning ink droplets 

Pre-cleaning state Post-cleaning state 

  
 
Mist-state ink 

Pre-cleaning state Post-cleaning state 
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6-2-2.  Cleaning and replacing maintenance parts 

Clean the maintenance area, if it is dirty, when replacing the flushing foam. 

(1) Prepare a waste cloth. 
<IMPORTANT> 
• Please complete the task within 25 minutes, in order to prevent the print heads from drying up. 
• Then, the head cleaning will be performed to prevent any ink from drying up. 

(2) Unlock the upper left-hand-side cover and top cover and open them. 

 

(3) Wipe the red frame part with waste cloth. 
<IMPORTANT> 
• Please complete the task within 25 minutes in order to prevent the print heads from drying up. 
• Be sure to use a clean waste cloth. Using a cloth with pretreatment may lead to non-ejection. 
• Do not touch other parts such as springs and caps when wiping part (a), as shown in the photo. If you touch the spring, in 

particular, it may come off. 
• Do not rub the parts strongly. Doing so may cause the parts to bend. 
• Do not put the wiped ink waste in the wiper cleaning tank. 

 

(4) Close the upper left-hand-side cover and top cover. 
<NOTE> 
• Dispose of any waste resulting from the cleaning in accordance with applicable laws and ordinances. 

Keyhole 

Keyhole 

(a)

Do not put the ink-smeared waste in 
the cleaning solution tank. 
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6-2-3.  Cleaning the surrounding area of nozzle surface 

(1) Make the clean stick R, cleaning cup, gloves and cleaning solution, which come standard with the printer, available 

for use. 
<IMPORTANT> 
• Use a new clean stick R when you start cleaning. 
• Never touch the tip end of clean stick R with your hand. If any sebaceous matter is attached to the head nozzle, it may 

result in the printer malfunction. 

(2) From the menu, select [Maintenance] > [Maintenance Part Clean/Replace] > [Clean nozzle guard and cap], and 

press . 

<IMPORTANT> 
• If any other error or message is displayed on the operation panel or warning message window, follow the message to solve 

the problem, then perform the cleaning. 
• Please complete the task within 25 minutes, in order to prevent the print heads from drying up. 
• Then, the head cleaning will be performed to prevent any ink from drying up. 
<TIPS> 

• Pressing  causes the platen to start moving. Do not put anything around the platen. 

(3) Unlock and open the right-hand-side cover. 

 
 

Keyhole 
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(4) Put a proper amount of cleaning solution into the cleaning cup. 

(5) Moisten a clean stick R with the cleaning solution. 
<IMPORTANT> 
• Be sure to use a different clean stick R separately for the color head and the white head. Use a new clean stick R when you 

start cleaning. 
• Do not use other fluids (water, etc.), because they may damage the print heads. 
• Do not return the cleaning solution which has been put in the cleaning cup to the cleaning solution bottle. 
• Do not shed cleaning solution in the maintenance unit. 
<NOTE> 
• For a proper work operation, be sure to wear the printer-provided gloves. 

 

 
 

X1000

Do not drain waste ink.

Cleaning cup

Cleaning solution 

Clean stick R 

Cleaning cup
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(6) With a clean stick R, clean the surrounding area of nozzle surface of print head. 
<IMPORTANT> 
• Be sure not to bring the clean stick R into contact with the nozzle surface. 
• The used clean stick R should be disposed of, and should not be reused. 
• Do not rub the parts strongly, which may scrape the water repellent film. 

 
 

(7) Close the right-side cover and press  in response to the instructions on the screen. 

<NOTE> 
• Dispose of any waste resulting from the cleaning in accordance with applicable laws and ordinances. 
<TIPS> 
• Then, the head cleaning will be performed to prevent any ink from drying up. 
• Because the cleaning cup will be reused, rinse it in clean cleaning solution and store it in a safe place. 

 
Cleaning conditions 

Pre-cleaning state Post-cleaning state 

 

 

 

X1001

Nozzle surface
Surrounding area of 
nozzle surface 

Cleaning area 

Cleaning 
prohibited 

X1114
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6-2-4.  Disposal of waste ink and waste water 

If a warning message appears on the operation panel screen or in the warning message window, dispose of the waste 
ink and the waste water in the tanks. 
<IMPORTANT> 
• It takes about two years for the waste water tank to be filled up with water.  

When the waste ink tank accumulates, and an error occurs, treat the water in the waste water tank at the same time. 
<TIPS> 
• Warning messages will be displayed for the respective tanks when the waste ink and the water in the waste water tank are about 

half full. However, these messages are not due to a malfunction of the detector. 

 

 

(1) From the menu, select [Maintenance] > [Empty/replace waste ink tank], and press . 

Follow the menu to complete the process. 

(2) Open the lower left-hand-side cover. 

 

Waste ink tank full
Humidifier drain tank full 

! WARNING
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(3) Pull out the tube toward you from each tank and dispose of the waste ink and waste water in the tanks. 
Place a receiving tray or the like under the other end of the tube (when removed) from the waste ink tank so that the waste ink 
spilled from the tube will not be discharged onto the floor, etc. 
<IMPORTANT> 
• Waste ink tank and waste water tank can weigh as much as 10 kg (22 lb).  

Be careful when pulling them out. 
<NOTE> 
• Dispose of the waste ink properly as water-based waste fluid in accordance with applicable laws and ordinances. 

 

(4) Check the direction of the tank holes and install each tank as shown on the label. 

Insert each tube into the tanks after installation. 
<IMPORTANT> 
• Be sure to push the tanks into the end. 
• Install the tanks so that the hole of each tank is directly below the tube.  

The tanks may not be detected if the orientation is wrong. 
• Make sure that the tubes are inside the respective tanks. 
• Be careful not to bend the tubes excessively.  

Otherwise the waste ink may have difficulty flowing through the tube. 

 
 

(5) Close the lower left-hand-side cover. 
 
 

Waste ink tank

Waste water tank 

Waste water tank Waste ink tank
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6-3.  When Not Using for a Long Period of Time 

When the printer will not be used for a prolonged period of time, take appropriate procedures before storing the printer 
depending on storage period or condition. 
<IMPORTANT> 
• Do not turn the printer off. Otherwise, the printer may be damaged. 
• If the power source to the printer cannot be sustained, please contact your dealer in advance. 
<NOTE> 
• If any error message is displayed on the screen, follow the instructions. 
• When storing the printer for more than two weeks, clean the nozzle guard and suction cap. ☞"6-2-1. Cleaning the nozzle guard 

and suction cap >>P.225" 
 

6-3-1.  When Not Using for a Long Period of Time: within 2 weeks 

The printer can be used through normal procedure after the storage period, by performing the following maintenance 
tasks. 

(1) If the warning message window for the waste ink tank and waste water tank is displayed, dispose of the waste ink 

and the waste water in the tanks. 

☞"6-2-4. Disposal of waste ink and waste water >>P.239" 

(2) Check the amount of cleaning solution in the cleaning solution tank, and refill the tank when its amount is below the 

proper level. 

☞"6-1-3. Refilling the cleaning solution >>P.185" 

(3) As required, print out a nozzle check pattern. 

☞"6-1-17. Print out the nozzle check pattern (checking on the print heads) >>P.222" 
 

6-3-2.  When Not Using for a Long Period of Time: more than 2 weeks 

Perform the following maintenance every two weeks. 

(1) If the warning message window for the waste ink tank and waste water tank is displayed, dispose of the waste ink 

and the waste water in the tanks. 

☞"6-2-4. Disposal of waste ink and waste water >>P.239" 

(2) Check the amount of cleaning solution in the cleaning solution tank, and refill the tank when its amount is below the 

proper level. 

☞"6-1-3. Refilling the cleaning solution >>P.185" 

(3) Print out a nozzle check pattern and verify the result. 

☞"6-1-17. Print out the nozzle check pattern (checking on the print heads) >>P.222" 

(4) If a non-firing nozzle is found, perform head cleaning and run the nozzle check pattern print, and verify the result 

again. 

☞"6-1-15. Head cleaning >>P.219" 
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7 What to do when needed 

As required, make settings and adjustments as mentioned below. 

About menu layer on the setting screen 
Menu Setting screen Description 

[Printer Setting] 

[Print Direction] 
[Auto] 
[Always Bi-Directional] 
[Always Uni-Directional] 

[Back Light] 
[Light High] 
[Light Medium] 
[Light Low] 

[Auto Screen Erase Time] 

[No Auto Screen Erase] 
[5 min] 
[10 min] 
[15 min] 
[30 min] 

[Menu TimeOut Setting] 
[1min] 
[3min] 
[5 min] 

[Speaker Volume] 0 to 7 

[Temperature] 
[Fahrenheit] 
[Centigrade] 

[Preview display settings] 
[Display it upward] 
[Display it downward] 

[File name display setting] 
[Priority to file name display] 
[Priority to job name display] 

[Standby mode icon settings] 

[Auto cleaning icon] 
[Platen height icon] 
[Print data information icon] 
[Circulation schedule icon] 

[Platen Setting] 

[Height settings by user] 
[Obstcl sensr settng during print] 
[Platen too low sensor] 
[Retry after height error] 
[Platen break-in run] 

[Low Temperature Mode] 
[Enable(Normal)] 
[Disable] 

[Low Humidity Mode] 
[Printing at Low Humidity] 
[No Printing at Low Humidity] 
[Select Everyday] 

[Post-circulation Auto Cleaning] 

[Before Next Printing] 
[Soon after if within 30 min.] 
[Soon after if within 1 hr.] 
[Soon after if within 90 min.] 

[Auto Cleaning Setting] 1 to 72 
[Auto Cleaning Start Timing] 
 
 
 
 
 

[Conduct before Printing] 

[Conduct after Printing] 
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Menu Setting screen Description 

[Printer Setting] 

[Auto Multiple Pass Setting] 

[Always ON] 
[White Ink 6 cc or More] 
[White Ink 16 cc or More (Standard)]
[White Ink 26 cc or More] 
[Always OFF] 

[Flushing Interval Setting] 
[normal 42 lines] 
[every 22 lines] 
[every 6 lines] 

[Flushing Volume Setting] 
[More] 
[Standard] 

[Auto Job Delete] 
[OFF] 
[ON] 

[Reserve Print during Receiving] 
[Make a print reservation] 
[No printing reservation] 

[Network filtering] 
[Enable] 
[Disable] 

[IP Address Set] 
[Automatic acquisition] 
[Manual setting] 

[Shortcut button setting] 

[Normal Cleaning] 
[Auto cleaning] 
[Print Data Load] 
[White Ink Circulation] 
[Platen Height Adjustment] 

[Total Print]   
[Temperature/Humidity Info]   

[Confirm network setting] 

[IP Address]  
[Subnet Mask]  
[Default Gateway]  
[Host name]  
[MAC address]  

[Check circulation schedule]   
[Check humidification schedule]   

[Language] 

[English]  
[Español]  

[Français]  

[Deutsch]  

[Italiano]  

[Türkçe]  

[Русский]  

[한국어]  

[中文]  

[日本語]  

[Prepare Power OFF]   

[Version] 

[Firm Version]  
[Data Info]  
[Serial No.]  
[Head information]  
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7-1.  Setting the print direction 

(1) From the menu, select [Printer Setting] > [Print Direction], and press . 

(2) Select your desired print direction of the print heads, and press . 

<TIPS> 
 The print direction is displayed here in the form of either bi-directional or the uni-directional icon . 

 Note that the setting of the print direction gives priority to the printer's setting over the setting of the printer driver. 

 The setting content will be kept intact until it is changed for the next printing job. 

 
 

7-2.  Screen back light adjustment 

(1) From the menu, select [Printer Setting] > [Back Light], and press . 

(2) Select your desired brightness of Liquid crystal panel, and press . 

<TIPS> 
 During this menu selection process, the screen is displayed with the selected brightness. 

 
 

Back Light
Light High 
Light Medium 
Light Low 

OK

Print Direction
Auto 
Always Bi-Directional 
Always Uni-Directional 

OK
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7-3.  Setup of Auto Screen Erase Time 

(1) From the menu, select [Printer Setting] > [Auto Screen Erase Time], and press . 

(2) Select your desired time until the liquid crystal panel and print button become unlit, and press . 

<TIPS> 
 During this menu selection process, the currently selected set value is displayed. 

 
 

7-4.  Setting the menu timeout period 

(1) From the menu, select [Printer Setting] > [Menu TimeOut Setting], and press . 

(2) Select the time before the display screen returns to the standby mode screen, and press . 

<TIPS> 
 During this menu selection process, the currently selected set value is displayed. 

 
 

Menu TimeOut Setting
1 min 
3 min 
5 min 

OK

Auto Screen Erase Time
No Auto Screen Erase 
5 min 
10 min 
15 min 
30 min 

OK
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7-5.  Speaker volume setting 

(1) From the menu, select [Printer Setting] > [Speaker Volume], and press . 

(2) Adjust the speaker volume in an eight-step scale from 0 to 7, and press . 

<TIPS> 
 You can adjust the volume while checking it. 

 
 

7-6.  Setup of temperature indication 

(1) From the menu, select [Printer Setting] > [Temperature], and press . 

(2) Select your desired unit of ambient temperature to be shown on the liquid crystal panel, and press . 

 

Temperature
Fahrenheit 
Centigrade 

OK

Speaker Volume

Set to OK to Confirm
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7-7.  Preview display settings 

Set the display direction of the preview image. 

(1) From the menu, select [Printer Setting] > [Preview display settings], and press . 

(2) Select the display direction and press . 

<TIPS> 
 During this menu selection process, the currently selected set value is displayed. 

 
 

7-8.  File name display setting 

Make file name display settings of print data. 
The display name you set is reflected in the selection screen of standby mode or receiving history or the USB flash 
memory loading screen. 

(1) From the menu, select [Printer Setting] > [File name display setting], and press . 

(2) Select the display method and press . 

<TIPS> 
 The job name is set automatically by the image editing application. 

 
 

File name display setting
Priority to file name display 
Priority to job name display 

OK

Preview display settings
Normal 
Inverted 

OK
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7-9.  Standby Display Icon Settings 

Make standby display icon settings. 

(1) From the menu, select [Printer Setting] > [Standby mode icon settings], and press . 

(2) Select the icon you want to display on the standby screen and press . 

 

No. Function 
1 Auto cleaning will start at the next printing if the icon and frame are yellow. 
2 Number of sheets printed since the last cleaning. 
3 Number of sheets set for auto cleaning. 

4 
The current platen height is displayed. 
If the current platen height differs from the platen height specified in the loaded print data, the icon will be 
displayed in yellow. 

5 The print direction is displayed. 
6 The printing resolution is displayed. 
7 The time of the next white ink circulation is displayed. 

With [Auto cleaning icon] set With [Platen height icon] set 

With [Print data information icon] set With [Circulation schedule icon] set 

Standby 

00/72 

1 2 3 

Standby 

A 

4 

Standby 

1200dpi

5 6 

Standby 

12:30 

7 

Standby mode icon settings
Auto cleaning icon 
Platen height icon 
Print data information icon 
Circulation schedule icon 

OK
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7-10.  Platen Setting 

7-10-1.  User settings for height 

There are custom positions that can be set to any height. 

(1) From the menu, select [Printer Setting] > [Platen settings] > [Height settings by user], and press . 

(2) Set the desired position. 

 

7-10-2.  Configuring the obstacle sensor to work during the printing process 

Specify the detection mode of the obstacle sensor by selecting either [Check when platen is loading] or [Check during 
printing as well]. 

(3) From the menu, select [Printer Setting] > [Platen Setting] > [Obstcl sensr settng during print], and press . 

(4) Select the obstacle sensor setting and press . 

<TIPS> 
 During this menu selection process, the currently selected set value is displayed. 
 The obstacle sensor is intended to detect wrinkles of the print media or foreign object on it to prevent the print head from 

contacting wrinkles or foreign matter or minimize the time during which the contact continues. 
 If the print head comes into contact with wrinkles or foreign object, a failure to eject ink-jet droplets or a mechanical failure may 

occur. 
  If the obstacle sensor detects a foreign object, the printing process and the platen operation are immediately stopped. 
 If you select [Check when platen is loading], the obstacle sensor works only while the platen is moving from the front to the rear. 
 If you select [Check during printing as well], the obstacle sensor works during the period from when you press the print button to 

when the printing process completes. 

 

Obstcl sensr settng during print
Check when platen is loading 
Check during printing as well 

OK

Height settings by user
User settings 1 
User settings 2 
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7-10-3.  Platen too low sensor setting 

The sensor is activated if it detects that the print medium is far because the platen is too low. 
Enable or disable this function when using the printer. 

(1) From the menu, select [Printer Setting] > [Platen Setting] > [Platen too low sensor], and press . 

(2) Select the "Platen too low" sensor function and press . 

<TIPS> 
 The "Platen too low" sensor checks if the platen is too low when it is completely inserted. 
 If the "Platen too low" sensor is activated, the printing process and the platen operation are stopped. 

 

7-10-4.  Retry settings after height error 

You can set whether to use the function that automatically lowers the platen slightly and restarts printing when the 
obstacle sensor detects wrinkles or foreign objects. 

(1) From the menu, select [Printer Setting] > [Platen Setting] > [Retry after height error], and press . 

(2) Select the function for retrying on height error and press . 

<TIPS> 
 The obstacle sensor is intended to detect wrinkles of the print media or foreign object on it to prevent the print head from 

contacting wrinkles or foreign matter or minimize the time during which the contact continues. 
 If the print head comes into contact with wrinkles or a foreign object, a failure to eject ink-jet droplets or a mechanical failure may 

occur. 
 Selecting [Retry] will perform up to two retries of [Retry after height error] during printing, and if unsuccessful, the printing will be 

stopped. 

 
 

Retry after height error
Retry 
No retry 

OK

Platen too low sensor
Enable 
Disable 

OK
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7-11.  Print Operation Settings Under Low Temperature 

Configure the printer with automatic switching to low temperature operation mode for ensuring print quality when [Temp 
Low] is displayed on the liquid crystal panel. It is set to [Enable(Normal)], by default. 
If the low temperature operation mode is enabled, the printer will automatically be switched to the low temperature 
operation. Although it can assure print quality, it may take longer time for printing. 
If the low temperature operation mode is disabled, print speed will not slow down; however, poor ejection may occur. 

(1) From the menu, select [Printer Setting] > [Low Temperature Mode], and press . 

(2) Select the print mode under low temperature and press . 

<TIPS> 
 When [Disable] is selected, white ink injection may become unstable when trying to print a wide area. 

 
 

Low Temperature Mode
Enable (Normal) 
Disable 

OK
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7-12.  Print Operation Settings Under Low Humidity 

(1) From the menu, select [Printer Setting] > [Low Humidity Mode], and press . 

(2) Select the setup items and press . 

 
<TIPS> 
 You can print even in a low humidity environment if you select [Printing at Low Humidity].  

However, the frequency of auto-cleaning and the amount of waste liquid will increase if you print in a low humidity 
environment. 

 You cannot print in a low humidity environment if you select [No Printing at Low Humidity]. 
 The following confirmation screen will be displayed once a day at the first timing when you try to print in a low humidity 

environment if you select [Select Everyday]. 

 

Low Humidity Mode
Printing at Low Humidity 
No Printing at Low 
Humidity 

OK

Low Humidity Mode
Printing at Low Humidity 
No Printing at Low 
Humidity 
Select Everyday 

OK
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7-13.  Auto Cleaning Setting 

Post-circulation Auto Cleaning 
Specify your desired auto cleaning start timing after circulation. 

(1) From the menu, select [Printer Setting] > [Post-circulation Auto Cleaning], and press . 

(2) Select your desired post-circulation auto cleaning start timing, and press . 

 

Setting the Number of Printed Sheets for Auto Cleaning 
Specify the number of printed sheets as the frequency of Auto Cleaning; where head cleaning is automatically 
performed every time a predetermined number of sheets are printed in order to protect the printer and provide stable 
printing quality. If the printing quality deteriorates in continuous printing, decrease the number of printed sheets for Auto 
Cleaning. The default value is 72. 

(1) From the menu, select [Printer Setting] > [Auto Cleaning Setting], and press . 

(2) Press  to set up the number of sheets to be printed in the range between 1 and 72, and press . 

<TIPS> 
 The printing quality tends to deteriorate if the humidity is low. 
 If the auto cleaning is performed more frequently, the Wiper cleaner and flushing foam will need to be replaced with a new one 

earlier. 

 
 

Auto Cleaning Setting

Set to OK to Confirm

/7212

Post-circulation Auto Cleaning
Before next print 
Soon after if within 30 min. 
Soon after if within 1 hr. 
Soon after if within 90 min. 

OK
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Auto Cleaning Start Timing 
Specify your desired auto cleaning start timing. 

(1) From the menu, select [Printer Setting] > [Auto Cleaning Start Timing], and press . 

(2) Select your desired auto cleaning start timing, and press . 

<TIPS> 
 Even when [Conduct after Printing] is selected, Auto Cleaning may be performed before printing, depending on the state of use. 

 

7-14.  Setting Automatic Multiple Pass Settings 

Perform this if the white printing quality deteriorates while printing. 

(1) From the menu, select [Printer Setting] > [Auto Multiple Pass Setting], and press . 

(2) Select the amount of white ink used for multiple pass printing and press . 

<TIPS> 
 The printing quality tends to deteriorate while printing if the temperature is low. 
 Although automatic multiple pass printing can assure print quality, it may take a longer time for printing. 

 
 

Auto Multiple Pass Setting
Always ON 
White Ink 6 cc or More 
White Ink 16 cc or More (Standard) 
White Ink 26 cc or More 
Always OFF 

OK

Auto Cleaning Start Timing
Conduct before Printing 
Conduct after Printing 

OK
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7-15.  Flushing Interval Setting 

Perform this if the printing quality deteriorates during printing operations. 

(1) From the menu, select [Printer Setting] > [Flushing Interval Setting], and press . 

(2) Select the desired number of scanning operations until the flushing starts, and press . 

<TIPS> 
 The printing quality tends to deteriorate during the printing operation if the humidity is low. 
 Setting shorter flushing intervals improves the printing quality, however, increases the ink consumption and increases the time 

required for printing. 

 
 

7-16.  Flushing Volume Setting 

Perform this if the printing quality deteriorates at the startup of the printing operation. 

(1) From the menu, select [Printer Setting] > [Flushing Volume Setting], and press . 

(2) Select your desired volume of ink to be ejected from the print heads during the flushing operation before the 

printing operation starts, and press . 

<TIPS> 
 The printing quality tends to deteriorate at the startup of the printing operation if the humidity is low. 
 Setting larger flushing volume improves the printing quality, however, increases the ink consumption. 

 

Flushing Volume Setting
More 
Standard 

OK

Flushing Interval Setting
Normal 42 lines 
Every 22 lines 
Every 6 lines 

OK
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7-17.  Automatic deletion of print data 

(1) From the menu, select [Printer Setting] > [Auto Job Delete], and press . 

(2) Select the desired function of Auto Job Delete, and press . 

 

7-18.  Print scheduling while receiving data 

Set whether to schedule printing when pressing the print button while receiving print data. ☞"5-8. Scheduling a print 
>>P.174" 

(1) From the menu, select [Printer Setting] > [Reserve Print during Receiving], and press . 

(2) Select the print scheduling function while receiving data, and press . 

<TIPS> 
 If the print scheduling function while receiving data is used, the platen height setting in the print data will be disabled for that print. 

 

Reserve Print during Receiving
Make a print reservation 
No printing reservation 

OK

Auto Job Delete
OFF 
ON 

OK
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7-19.  Network filtering settings 

This function will enhance LAN security. Enable or disable this function when using the printer. Setting this function to 
[Enable] will allow only specific PC access. It is set to [Disable], by default. 

(1) From the menu, select [Network filtering setting], and press . 

(2) Select either [Enable] or [Disable], and press . 

 

Network filtering
Enable 
Disable 

OK
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7-20.  Static IP address setting 

In the [IP Address Set] window, select the automatic acquisition or manual setting, and set up the [IP Address], [Subnet 
Mask] and [Default Gateway] when you select the manual setting. 

(1) From the menu, select [Printer Setting] > [IP Address Set], and press . 

(2) Select either [Automatic acquisition] or [Manual setting] and press . 

<TIPS> 
 If you select [Automatic acquisition], the screen will go back to the standby mode screen after the settings are automatically 

acquired. 

 

(3) To make manual settings, press  to move to and select your desired position. 

(4) To make manual settings, press  to specify your desired numeric value. 

(5) When the  button is pressed, the selected value is accepted, and the display screen goes to the [IP 

Address], [Subnet Mask] and [Default Gateway] in sequence. 

<TIPS> 
 The display screen shown here has been taken as an example. 

 
 
 

IP Address Set 

OK to Subnet Mask Screen 

IP Address 

1 92.168.000.001 

IP Address Set 

OK to Gateway Screen 

Subnet Mask 

2 55.255.255.000 

IP Address Set 

Set OK 

Default Gateway 

0 00.000.000.000 

IP Address Set
Automatic acquisition 
Manual setting 
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7-21.  Shortcut button setting 

You can set the operation that takes place when the shortcut button on the operation panel is pressed. 

(1) From the menu, select [Printer Setting] > [Shortcut button setting], and press . 

(2) Select the function and press . 

<TIPS> 
 During this menu selection process, the currently selected set value is displayed. 
 If you select [Normal Cleaning], you will be presented with the Normal Cleaning Head Selection menu. 
 If you select [Auto cleaning], Auto cleaning begins. 
 If you select [Print Data Load], you will be presented with the screen to select the print data to load. 
 If you select [White Ink Circulation], the white ink circulation begins. 

 
 

7-22.  Display of total printed sheets 

On this display screen, the total number of printed sheets is shown. 

(1) From the menu, select [Total Print], and press . 

(2) Then, the total number of printed sheets is displayed. 
<TIPS> 
 Only the number of printed sheets of which printing has succeeded is counted, in which the canceled number of sheets is 

not included. 
 All the printed sheets involved in printing operation, including test print, are counted. 
 The display screen shown here has been taken as an example. 
 The count of total number of printed sheets cannot be reset. 

 
 
 

Total Print

Press OK to Return

530

Shortcut button setting
Normal cleaning 
Auto cleaning 
Print Data Load 
White Ink Circulation 
Platen Height Adjustment 

OK
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7-23.  Display of Temperature/Humidity Info 

Then, the ambient temperature and humidity are displayed. 

(1) From the menu, select [Temperature/Humidity Info], and press . 

(2) Then, the ambient temperature and humidity are displayed. 

<TIPS> 
 Make the setting of temperature indication unit in the Temperature window. 
 The display screen shown here has been taken as an example. 

 
 
 

Temperature/Humidity Info

Press OK to Return

Outer side 
Right side 
Left side 

[24°C (75°F)] 
[42%] 
[22°C (72°F)] 
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7-24.  Confirm network setting 

In the [Confirm network setting] window, display the [IP Address], [Subnet Mask], [Default Gateway], [Host name], and 
[MAC address]. 

(1) From the menu, select [Confirm network setting], and press . 

(2) Select one out of the [IP Address], [Subnet Mask], [Default Gateway], [Host name], and [MAC address], and press 

. 

 
(3) Display [IP Address], [Subnet Mask], [Default Gateway], [Host name], or [MAC address]. 

<TIPS> 
 The display screen shown here has been taken as an example. 

 

IP Address 

Press OK to Return 

192.168.000.001 

Subnet Mask

Press OK to Return 

255.255.255.000 

Default Gateway 

Press OK to Return 

000.000.000.000 

Host name

Press OK to Return 

GTX6-XXXXXX 

MAC Address

Press OK to Return

00:1B:A9:FD:BC:27 

Confirm network setting
IP Address 
Subnet Mask 
Default Gateway 
Host name 
MAC Address 
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7-25.  Check circulation schedule 

White ink circulation can be performed at a specified time. 

(1) From the menu, select [Check circulation schedule], and press . 

(2) Display the circulation schedule. 

<TIPS> 
 If the scheduled time of white ink circulation is not set with the maintenance tool, the circulation schedule will not be displayed. 

 
 

7-26.  Check humidification schedule 

(1) From the menu, select [Check humidification schedule] and press . 

(2) The day of the week, start time, and end time for humidification will be displayed. 

<TIPS> 
 If the scheduled time of humidification is not set with the maintenance tool, the humidification schedule will not be displayed. 

 

Check humidification schedule
Sun. 09:00 ~ 18:00 
Mon. 09:00 ~ 18:00 
Tue. 09:00 ~ 18:00 
Wed. 09:00 ~ 18:00 
Thu. 09:00 ~ 18:00 

Check circulation schedule
Current time 17:44 

00:30 (Long) 
07:00 
18:30 
--:-- 

03:00 
12:30 
23:00 
--:-- 
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7-27.  Language setting 

Select your desired language to be shown on the liquid crystal panel. 

(1) From the menu, select [Language], and press . 

(2) Select your desired language in the [Language] window, and finalize your setting by pressing . 

(3) Follow the on-screen message, and turn off the power and on again. 

 
 

Language
English 
Español 
Français 
Deutsch 
Italiano 

OK
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7-28.  Display of version 

On this display screen, the firmware's version information, [Firm Version], as well as [Data Info], [Serial No.], and [Head 
information] are shown. 

(1) From the menu, select [Version], and press . 

(2) Select [Firm Version], [Data Info], [Serial No.], or [Head information] and press . 

 
(3) Then, [Firm Version], [Data Info], [Serial No.], or [Head information] will appear. 

<TIPS> 
 Pressing the  button causes the currently displayed window to go back to the [Version] window. 
 The display screen shown here has been taken as an example. 

 

Firm Version 
Main 0.42.9601 
ACT 0.33.0000 
LCD 0.33.0000 
Head 0.31.0000/ 0.31.0000 

Data Info
Message 0.19.0000 
Font 1.00.0000 
Test Print 0.00.0007 

Serial No. 

Serial No.  ABCDEFG1 
 
Hardware ID      1.0 

Head information
W_A No:6CM1234 V.Rating:  11 
W_B No:6CM1235 V.Rating:  9 
C_A No:6CM1234 V.Rating:  11 
C_B No:6CM1235 V.Rating:  9 

Version information
Firm Version 
Data Info 
Serial No. 
Head information 
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7-28-1.  Updating of firmware 

When a new firmware is released, please update the firmware. 
<TIPS> 
 To check any release information of a new firmware, please visit the website of Brother Industries, Ltd. 
 

(1) Download the firmware's updated data from the website of Brother Industries, Ltd. 

(2) On the PC, from [All Programs] in the Start menu, select the "GTX-6 Firmware Update" from "Brother GTX-6 

Tools". 

(3) Specify the firmware's updated data (.bwf). 

 
 

(4) Make a connection of the USB 3.0 cable or LAN cable between your PC and the printer, and update your firmware 

by performing the on-screen procedures. 
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CAUTION 

 
Ensure there is adequate space left in front of the printer and avoid placing any objects. Otherwise your hand 
may get caught between the platen and an object, which may result in injury. 

 
Do not handle the platen while printing. If your hand gets caught between the platen or the T-shirt tray and 
the covers, it may be injured. 

 Do not put your hands inside the covers while the printer's power is turned on. Otherwise your hands may 
touch against moving parts and this may result in injury. 

 Be careful not to pinch your fingers when closing each door and cover. You may get injured if you pinch your 
fingers. 

 
When you mount or replace the head, be careful not to get your hands or fingers caught. Otherwise you may 
be injured. 

 
Do not drink liquids such as the ink, cleaning solution, pretreatment, or waste. They may cause diarrhea or 
vomiting. 
When handling liquids, such as the ink, cleaning solution, pretreatment, and waste, use protective glasses 
and gloves to avoid causing your eyes and skin to contact the liquids. It may cause inflammation. In case of 
contact with eyes, do not rub but immediately rinse the eyes with water. 
Keep the liquids out of the reach of children. 

 
Be sure to wear protective goggles and gloves when handling the grease, so that it does not get into your 
eyes or onto your skin. 
It can cause inflammation. Do not drink or eat the grease. It may cause diarrhea or vomiting. 
Keep the liquids out of the reach of children. 

 
When replacing parts and installing optional accessories, be sure to use only genuine Brother parts. Brother 
will not be held responsible for any accidents or problems resulting from the use of non-genuine parts. 

 
When replacing parts or installing optional accessories, be sure to follow the procedures described in the 
Instruction Manual. Incorrect procedures could cause injuries or problems. 

 

IMPORTANT 

 
Do not move the platen by hand. Otherwise the printer may be mechanically and electrically damaged. 
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8-1.  Troubleshooting instructions 

With reference to the descriptions below, troubleshoot your problem. 

No print data can be sent from PC 
Probable Cause Remedy Reference 

Have you selected an incorrect 
printer or not? 

From the menu for printing, check your printer 
name. 

- 

Has a USB or LAN cable been 
connected properly? 

Check the connection of the USB 3.0 cable or 
LAN cable (category 5e or higher). 

- 

Are you using such PC or OS 
that is outside the specification?

Check your PC's operating environment. "10-2. Software >>P.309" 

Has any noise been produced 
between the printer and your 
PC? 

Remove the USB 3.0 cable/LAN cable first, then 
make a connection of it once again in five 
seconds. If the problem continues, power off the 
printer first, then reactivate it in five seconds. 

- 

Does your PC function 
properly? 

Restart the PC. 
- 

Has any other USB device been 
connected to your PC?  

Remove the other USB device, restart the PC, 
and check to see if the printer functions properly.

- 

Has the USB 3.0 cable/LAN 
cable been damaged? 

Use a different LAN cable. 
- 

 

No printing job gets started even after pressing the print button 
Probable Cause Remedy Reference 

Are you pressing the print 
buttons properly? 

Press and hold two print buttons at the same 
time. 

- 

Check if the print is scheduled 
(the button is flashing fast). 

The print begins as soon as the printer becomes 
available. Wait for a while. 

- 

Is any error message 
displayed? 

Eliminate the cause of the error, and perform 
printing once more. 

"9. Error message >>P.285" 

Does the menu screen still 
appear on the screen, or are 
you performing the maintenance 
operation from the menu? 

Please exit the menu. Alternatively, please wait 
until the maintenance operation will come to an 
end. 

- 

Is the automatic head cleaning 
operation underway? 

Please wait until the ongoing head cleaning 
operation is completed. 

- 

Is the printer in the white ink 
circulation stage? 

Please wait until the ongoing white ink circulation 
is completed. 

- 

Is the room temperature suited 
to the usage conditions? 

Check for your printer's operating environment 
and adjust the room temperature. 

"10-1. Apparatus >>P.308" 

Does the printer receive no print 
data, or is it in the state to 
receive such data (the print 
button is not illuminating)? 

Send the print data to the printer. Alternatively, 
please wait until the reception of print data is 
completed. 

- 
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Probable Cause Remedy Reference 
Do you find that the temperature 
of print heads are becoming 
high, and [Color Head Getting 
Warm] or [W Head Temp Rising] 
message appears? 

There may be the possibility that the flat cables 
of print heads have not been put in place and 
the temperature of print heads has become high.
Turn off the power, make sure that the flat cable 
is in place, and wait until the temperature 
decreases. 

- 

Is the printer cover open? Close the printer cover and try printing again. - 
Is the mist fan door open? Close the mist fan door and try printing again. "6-1-10. Replacing the mist fan 

filter >>P.205" 
Is the mist fan filter set correctly? Set the mist fan filter correctly and close the mist 

fan door. Then try printing. 
"6-1-10. Replacing the mist fan 
filter >>P.205" 

Are you pressing the print 
buttons properly? 

①Press and hold two print buttons at the same 
time.  
②Keep pressing them until the second sound is 
heard. 

"5-7. Executing a printing job 
>>P.171" 

 

The power cannot be turned on 
Probable Cause Remedy Reference 

Is the power cord connected to 
the printer? 

Make sure that the power cord is connected to 
the printer. 

- 

 

An error occurs immediately after activating the printer 
Probable Cause Remedy Reference 

Is any error message 
displayed? 

Check the content of the error, and restart the 
printer. If the error is still not eliminated, please 
contact your dealer or Brother. 

"9. Error message >>P.285" 

 

No print data can be loaded from USB flash memory 
Probable Cause Remedy Reference 

Is the applicable file ARP or 
AR3 file? 

This printer cannot print out the print data of 
GT-541/GT-782/GT-3. Recreate the print data. 

- 

 

Neither uni-directional printing nor bi-directional printing can be performed 
Probable Cause Remedy Reference 

Do the settings of printer driver 
and printer agree with each 
other? 

Note that the setting of the printer's setting has 
priority over the setting of printer driver. The 
printer driver's setup value takes effect only if the 
printer's setting is [Auto]. 

"7-1. Setting the print direction 
>>P.244" 

 

The depletion of ink in an ink tank cannot be detected 
Probable Cause Remedy Reference 

Check if the remaining ink level 
correction was skipped or an 
incorrect value was entered for 
the correction. 

Perform the remaining ink level correction again. "6-1-4. Correcting the remaining 
ink level >>P.187" 
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"x" is displayed for the remaining ink level after refilling ink. 
Probable Cause Remedy Reference 

Is ink of a wrong color refilled? Refill the right ink. If ink colors are mixed in the 
ink tank as the result of refilling ink of a wrong 
color, contact your dealer. 

- 

 

The remaining volume indication of the ink tank does not reflect the actual status 
Probable Cause Remedy Reference 

Check if the remaining ink level 
correction was skipped or an 
incorrect value was entered for 
the correction. 

Perform the remaining ink level correction 
again. 

"6-1-4. Correcting the remaining 
ink level >>P.187" 

 

Ink is leaking from the lower right side of the printer 
Probable Cause Remedy Reference 

Is the degassing module not out 
of order? 

For help, please contact your dealer. 
- 

 

Water supply error 
Probable Cause Remedy Reference 

Is a humidifier water supply error 
displayed? 

If a water supply error occurs, the humidifier will 
stop working. Perform [Humidification start] from 
the menu. 

- 

Start humidification from the menu after 
confirming the following two points. If the 
problem persists, contact your dealer.  
①Make sure the water tank is filled with water. 
②Make sure that the main faucet of the water 

supply section (pure water equipment and 
tank) is open. 

Is a water supply shortage error 
or a water supply failure error 
displayed? 

If you are using a tap water supply, make sure 
that the main tap and water supply pressure are 
sufficient. 
If you are using a water tank, make sure the 
water tank is filled with water. 
Ascertain the water supply tube is not broken or 
crushed. 
Check if the installation height of the water 
supply tank is appropriate. 

"1-5. About the humidifier 
>>P.33" 
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Initial humidifier operation failed. 
Probable Cause Remedy Reference 

Initial humidifier operation failed? Perform initial humidifier operation from the 
menu after confirming the following two points. If 
the problem persists, contact your dealer.  
①Make sure that the amount of water in the 

tank and the installation height of the tank are 
appropriate.  

②Check if there are any problems with the 
piping from the water supply section (pure 
water equipment and tank), such as 
disconnected tubing or forgetting to open the 
main faucet. If you supply water from a tank, 
make sure it is a new tube. 

- 
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8-2.  Solutions to print quality problems 

With reference to the descriptions below, troubleshoot your problem. 

Print is too light 
Probable Cause Remedy Reference 

Is the setting of an image editing 
software application made 
improperly, or is an image 
placed in CMYK mode? 

Edit the image. "4-3. Using other applications 
>>P.88" 

Have the printing conditions 
been applied improperly, or 
does your image data have 
insufficient color saturation?  

Using [Color Processing], adjust saturation or 
contrast as appropriate. 

"4-4-11. Set up the image quality 
>>P.121" 
"4-5-7. Set up the image quality 
>>P.132" 

Is there any nozzle that does not 
eject ink-jet droplets? 

Perform [Head Cleaning] from the menu. 
If no improvement is attained, follow the 
referenced instructions. 

"8-2-1. Recovery action to be 
taken for such a nozzle that is 
unable to eject ink-jet droplets 
>>P.277" 

Is initial settings after head 
replacement configured? 

Perform the initial settings after head 
replacement configuration. 

"3-6-1. Initial settings after head 
replacement >>P.69" 

Is the [Low Temperature Mode] 
set to [Disable]? 

Change the setting to [Enable (Normal)]. "7-11. Print Operation Settings 
Under Low Temperature 
>>P.251" 

 

Horizontal stripe (banding) is found on printed material 
Probable Cause Remedy Reference 

Is there any nozzle that does not 
eject ink-jet droplets? 

Perform [Head Cleaning] from the menu. 
If no improvement is attained, follow the 
referenced instructions. 

"8-2-1. Recovery action to be 
taken for such a nozzle that is 
unable to eject ink-jet droplets 
>>P.277" 

Do you print ink dots on a highly 
water-absorbing print medium? 

Set the print head's print direction to [Always 
Uni-Directional]. 
Also, combine the color multiple pass printing 
with the printing. 

"7-1. Setting the print direction 
>>P.244" 

Is the platen positioned at a level 
that is too low? 

Adjust the height of the platen corresponding to 
the print medium before using it. 
You can use the platen height adjustment lever 
from the menu to adjust the height of platen. 
As a rough indication, adjust the height so that it 
is lowered by one step from the limit height 
detected by the obstacle sensor, and check that 
the platen is not detected by the sensor. 

"5-5. Placing print medium in 
position >>P.159" 

Is the ejection timing correct? Adjust the ejection timing again. It is likely that 
the setup value is incorrectly set after replacing a 
print head or the platen with a new one, or after 
adjusting the platen height. 

"3-6-3. Firing adjustment >>P.71"

Check if the temperature is low. Change the auto multiple pass settings. "7-14. Setting Automatic Multiple 
Pass Settings >>P.254" 

Is the [Low Temperature Mode] 
set to [Disable]? 

Change the setting to [Enable (Normal)]. "7-11. Print Operation Settings 
Under Low Temperature >>P.251"
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Blurring is observed (when printed with [Color Ink Only]) 
Probable Cause Remedy Reference 

Isn't the amount of ink excessive 
against the print media? 

Print the ink volume and check the blurring, and 
select appropriate set value for [Ink Volume:]. 

"4-6-5. Adjust the ink volume 
>>P.138" 
"4-5-6. Set up the color ink 
>>P.130" 

 

Blurring is observed (when printed with [Color+White Ink]) 
Probable Cause Remedy Reference 

Is the [Highlight:] of [White Ink 
Settings:] too high? 
 

Print the highlight check pattern to check the 
blurring, and select appropriate set value for 
[Highlight:]. 

"4-6-6. Print out of highlight 
check pattern/mask check 
pattern >>P.139" 
"4-4-7. Set up the white ink 
>>P.113" 

By turning ON the [White/Color Pause] or [Color 
Multiple Pass Printing] checkbox, extend time 
before the color ink settles onto the white ink, to 
prevent blurring. Try this method to eliminate 
blurring without weakening the highlight. 

"4-4-7. Set up the white ink 
>>P.113" 

 

Ink sticks to such an area where no print data exists (ink stain, horizontal stripe, etc.) 
Probable Cause Remedy Reference 

Is the area around the print 
heads soiled with waste ink 
spilled from the head cap?  

Clean the head section and suction cap. "6-2-1. Cleaning the nozzle 
guard and suction cap >>P.225" 

Is any lint attached to the nozzle 
surface? 

Clean the nozzle guard. "6-2-1. Cleaning the nozzle 
guard and suction cap >>P.225" 

Is the carriage foam 
contaminated? 

Replace the carriage foam with a new one. "6-1-9. Replacing the carriage 
foam >>P.197" 

Do the print heads rub against a 
T-shirt? 

Flatten the surface of T-shirt, and adjust the 
platen's height as required. 

"5-5. Placing print medium in 
position >>P.159" 

Has the flushing foam become 
dirty? 

Replace the flushing foam with a new one. "6-1-8. Replacing the flushing 
foam >>P.194" 

Has the platen sheet become 
dirty? 

Replace the platen sheet with a new one. "6-1-11. Replacing the platen 
sheet >>P.207" 

Has any ink attached to the 
carriage that secures the print 
heads in place or is it dripping 
off? 

Replace the carriage foam with a new one. "6-1-9. Replacing the carriage 
foam >>P.197" 
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The edges of the image are blurred, characters and straight lines are doubly printed and printed 

result appears too granular 
Probable Cause Remedy Reference 

Is the platen positioned at a level 
that is too low? 

Adjust the height of the platen corresponding to 
the print medium before using it. 
You can use the platen height adjustment lever 
from the menu to adjust the height of platen. 
As a rough indication, adjust the height so that it 
is lowered by one step from the limit height 
detected by the obstacle sensor, and check that 
the platen is not detected by the sensor. 

"5-5. Placing print medium in 
position >>P.159" 

Is the ejection timing correct? Adjust the ejection timing again. It is likely that 
the setup value is incorrectly set after replacing a 
print head or the platen with a new one, or after 
adjusting the platen height. 

"3-6-3. Firing adjustment >>P.71"

Is the image enlarged on the 
printer setting screen? 

When a low resolution image is enlarged on the 
printer setting screen, it may blur or angle the 
image. Pattern data should be enlarged on an 
image editing application, and its roughness 
should be checked. 

- 

 

Thin color cannot be printed out well gradually 
Probable Cause Remedy Reference 

Is the ambient atmosphere at a 
high temperature and very dry, 
which in turn tends to cause the 
nozzle surface to dry up? 

Perform the flushing more frequently. In addition, 
increase the flushing volume. 

"7-15. Flushing Interval Setting 
>>P.255" 
"7-16. Flushing Volume Setting 
>>P.255" 

 

White ink is not printed out evenly 
Probable Cause Remedy Reference 

Has the pretreatment been 
applied unevenly? 

Apply the recommended amount of 
pretreatment evenly to the target area. 

"5-3-3. Application of 
pretreatment >>P.151" 

Has the pretreatment caused 
any change in hardness or 
deformation of the pretreatment 
roller? (This applies to the case 
where the pretreatment roller is 
used.) 

After the pretreatment roller is used, put it in a 
plastic bag or the like hermetically to prevent it 
from drying up, and keep it in a flat place in an 
upright position. 
Also, when it remains unused for two weeks or 
longer, wash it well with running water, and let it 
dry in a shaded area. 

- 

Is any water content attached to 
the pretreatment roller after the 
pretreatment is fixated? 

Prevent water content from being attached to 
the roller after the pretreatment is fixated.  

"5-3-4. Fixation of pretreatment 
>>P.154" 

Is there any lint, yarn waste, 
dust, etc. that are attached to 
the surface of pretreatment 
roller? (This applies to the case 
where the pretreatment roller is 
used.) 

Clean the surface of the pretreatment roller. "5-3-3. Application of 
pretreatment >>P.151" 
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Probable Cause Remedy Reference 
Did you shake the pretreatment 
after its dilution? 

Shake the pretreatment sufficiently. "5-3-2. Dilution of pretreatment 
>>P.149" 

Is the [Low Temperature Mode] 
set to [Disable]? 

Change the setting to [Enable (Normal)]. "7-11. Print Operation Settings 
Under Low Temperature 
>>P.251" 

Has the pretreatment been 
fixated insufficiently? 

Check on an actual temperature of the heat 
press and its pressure during the fixation stage. 
Always keeping the lower iron (where media is 
placed) of the heat press at heated temperature 
with a heating source may solve this problem. 

"5-3-4. Fixation of pretreatment 
>>P.154" 

 

Whiteness of print result is insufficient 
Probable Cause Remedy Reference 

Has the pretreatment been 
applied insufficiently? 

Apply a proper amount of pretreatment. "5-3-3. Application of 
pretreatment >>P.151" 

Has the pretreatment been 
fixated insufficiently?  

Check on an actual temperature of the heat 
press and its pressure during the fixation stage.

"5-3-4. Fixation of pretreatment 
>>P.154" 

Is there any nozzle that does not 
eject ink-jet droplets? 

Perform [Head Cleaning] from the menu. 
If no improvement is attained, follow the 
referenced instructions. 

"8-2-1. Recovery action to be 
taken for such a nozzle that is 
unable to eject ink-jet droplets 
>>P.277" 

Is the white ink circulated 
insufficiently? 

From the menu, select [Maintenance] > [White 
Ink Circulation] to circulate the white ink 
properly. 

- 

Is the [Low Temperature Mode] 
set to [Disable]? 

Change the setting to [Enable (Normal)]. "7-11. Print Operation Settings 
Under Low Temperature 
>>P.251" 

Is the dilution rate of the 
pretreatment correct? 

Dilute the pretreatment appropriately. "5-3-2. Dilution of pretreatment 
>>P.149" 

Is the [Highlight:] of [White Ink 
Settings:] too low? 

Print the highlight check pattern to check the 
blurring, and select appropriate set value for 
[Highlight:]. 

"4-6-6. Print out of highlight 
check pattern/mask check 
pattern >>P.139" 
"4-4-7. Set up the white ink 
>>P.113" 

 
Too much luster 

Probable Cause Remedy Reference 
Are you using Teflon-treated 
peel-off sheet for fixation? 

Use a silicon coated peel off sheet when curing 
the ink to reduce the gloss. 

- 

 
Too fuzzy 

Probable Cause Remedy Reference 
Did you touch the print media 
(T-shirt) just before printing? 

Excessively touching the media (T-shirt) on the 
platen by trying to flatten the media before 
printing could cause fuzziness. Make sure not to 
touch the media surface too much after the 
pretreatment is fixated. 

- 
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Probable Cause Remedy Reference 
Does it take a long time before 
printing, after the pretreatment 
fixation? 

Leaving the print media (T-shirt) after fixing the 
pretreatment may cause fuzziness, because the 
media would absorb water. Print the 
pretreatment fixated media as soon as possible.

- 

Is the upper iron on the heat 
press contaminated during the 
pretreatment fixation process? 

If the upper iron is contaminated, it could 
roughen the print media (T-shirt) surface by a 
heat press process, to cause fuzziness. Clean 
the upper iron of the heat press with a cloth. 
If the condition persists, try using a peel-off 
sheet during the pretreatment fixation process, 
to probably improve the condition. 

- 

Unevenly dried during the 
fixation process? 

It may be solved by inserting a silicone foam 
between the heat press lower iron and a print 
media (T-shirt) during ink fixation. 

- 

 
Background white ink spreads out when printed with [Color+White Ink] 

Probable Cause Remedy Reference 
[White/Color Alignment] 
misaligned? 

Misalignment of white and color inks can occur 
when the media thickness or the platen height is 
changed. Adjust the platen height first for the 
actual media to be printed, and align the white 
and color inks positions. 

"3-6-6. White/color alignment 
>>P.74" 

Is the media easy to stretch 
when wet? 

Print misalignment may occur between white 
and color inks when the media stretches when 
wet with white ink. Increasing [Choke Width:] 
can prohibit spreading of the background white 
ink. 

"4-4-7. Set up the white ink 
>>P.113" 

 
Printed surface cracks after fixation 

Probable Cause Remedy Reference 
Isn't the print surface folded 
before fixation is completed? 

Try not to touch the print surface until the 
fixation process is completed. 

- 

 

The lower left side area of the printer's main unit is soiled with ink 
Probable Cause Remedy Reference 

Is the waste ink tube dismounted 
from the maintenance unit? 

For help, please contact your dealer. 
- 

Is the waste ink tube clogged 
causing the waste ink to flow 
reversely? 

Straighten the waste ink tube to remove the 
clog. - 
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The cleaning solution is leaked from the cleaning solution tank 
Probable Cause Remedy Reference 

Is the main body of printer put 
aslant? 

Place the printer horizontally. 
If the problem is still not remedied, please 
contact your dealer. 

"3-1. Installation of printer 
>>P.40" 

 

Takes longer print time than before 
Probable Cause Remedy Reference 

Is the ambient temperature 
under 18°C (64.4°F)? 

Adjust the room temperature to 18°C (64.4°F) or 
more. 
If it is difficult to adjust the room temperature, set 
the operational configuration under low 
temperature to [Disable]. 

"7-11. Print Operation Settings 
Under Low Temperature 
>>P.251" 

Is your printing under a low 
humidity environment? 

Wait for the humidity inside the printer to reach 
50% or higher. 

- 
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8-2-1.  Recovery action to be taken for such a nozzle that is unable to eject ink-jet droplets 

Please verify the followings when any nozzle is not ejecting ink droplets. 
Items to be checked Description Remedy Document 

Is the lip of the suction cap 
dirty? 

If the lip of the suction cap is dirty, the 
suction cap may not be able to adhere to the 
print head, and ink may not be sucked. 

Clean the 
suction cap 

"6-2-1. Cleaning the nozzle 
guard and suction cap 
>>P.225" 

Is ink accumulated in the 
nozzle guard? 

The suction cap may not be in close contact 
with the print head and ink may not be 
sucked if the space between the nozzle 
guard and the nozzle is contaminated. 

Nozzle guard 
Cleaning 

"6-2-1. Cleaning the nozzle 
guard and suction cap 
>>P.225" 

Is there any deposit of ink 
around the nozzle 
surface? 

When the surrounding area of nozzle 
surface is contaminated, it could lead to 
ejection failure since the wiper cannot clean 
the nozzle surface properly. Or, it could 
reduce the adhesion between the nozzle 
and suction cap, thereby causing ink suction 
failure. 

Cleaning the 
surrounding area 
of nozzle surface 

"6-2-3. Cleaning the 
surrounding area of nozzle 
surface >>P.236" 

Is the wiper contaminated? 

The wiper may become dirty, and the nozzle 
surface may not be wiped cleanly if the 
wiper cleaning solution is not sufficiently 
filled in the wiper cleaning tank. 

Introduction of 
wiper cleaning 
solution 

From the menu, select 
[Maintenance] -> [Operate 
wiper cleaning tank] -> 
[Add cleaning solution]. 

Is the wiper cleaning 
solution contaminated? 

The wiper may not be sufficiently cleaned 
and the nozzle surface may not be wiped 
cleanly if the wiper cleaning solution is dirty.

Replacement of 
wiper cleaning 
solution 

From the menu, select 
[Maintenance] -> [Operate 
wiper cleaning tank] -> 
[Change cleaning solution].

Is there any indication of 
scar or deformation on the 
wiper? 

If the wiper has any scar or deformation, the 
wiper cannot clean the nozzle surface. 

Replace the 
wiper 

"6-1-6. Replacing the wiper 
>>P.189" 

Is the flushing foam 
installed correctly? 

If the flushing foam is not placed 
appropriately with no rise, it may touch the 
nozzle surface to stop ejection from the 
nozzle. 

Mount the 
flushing foam 

"6-1-8. Replacing the 
flushing foam >>P.194" 

Is the ink accumulated on 
the flushing foam? 

If an ink accumulates on the flushing foam, 
the ink may touch the nozzle surface to 
prevent ink from ejecting. 

Replace the 
flushing foam 

"6-1-8. Replacing the 
flushing foam >>P.194" 

Is the tube correctly 
connected to the head? 

If they are loosely mated, it may allow air to 
enter into the head section during the head 
cleaning operation, to cause non-ejection 
condition of the nozzle. 

Verify connection 
between the 
head and the 
tube 

"6-1-12. Replacement of 
print head >>P.209" 

Is the tube filled with ink? 
If a large amount of air exists in the tube, 
that air will go into the head to cause 
non-ejection condition of the nozzle. 

Bleed ink air in 
the tube 

From the menu, select 
[Maintenance] > [Tube air 
bleed] and select the 
corresponding head and 
color. 

 
After carrying out appropriate remedial measures listed above, make sure the non-firing nozzle has been recovered. If it 
has not, perform the steps 1 to 5 to recover the non-firing nozzle. 
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Step 1: Print out a nozzle check pattern 

(1) Print out a nozzle check pattern (1st time). ☞"6-1-17. Print out the nozzle check pattern (checking on the print 

heads) >>P.222" 

(2) Check the result of the printed nozzle check pattern (1st time), and carry out the following procedures. ☞"6-1-17. 

Print out the nozzle check pattern (checking on the print heads) >>P.222" 
<TIPS> 
• Even if the white print result is weak, since the white ink is ejected on one same spot through multiple nozzles, a relatively 

large amount of ink volume will be used, and the firing problem of a single nozzle will not affect the print quality so much. 
Even in a condition with weak lines, the print is performed without a problem. 

 
Existence or nonexistence of a 
nozzle that does not eject any 

ink-jet droplets 

Recovery action 

Such a nozzle does not exist that 
does not eject any ink-jet droplets 

Contact your dealer if there is no non-ejection when printing the nozzle 
check pattern, but a large amount of non-ejection occurs during printing. 

Such a nozzle exists that does not 
eject any ink-jet droplets 

Proceed to Step 2. 

 

Step 2: Perform the head cleaning 

(1) Perform a normal cleaning. ☞"6-1-15. Head cleaning >>P.219" 

(2) Print out a nozzle check pattern (2nd time). 

(3) Check the result of the printed nozzle check pattern (2nd time), and carry out the following procedures. 
Existence or nonexistence of a 
nozzle that does not eject any 

ink-jet droplets 

Recovery action 

Such a nozzle does not exist that 
does not eject any ink-jet droplets 

Exit 

Ten-or-less nozzles exist that do 
not eject any ink-jet droplets 

Perform the normal cleaning once again. Subsequently, proceed to (4). 

Ten-or-more nozzles exist that do 
not eject any ink-jet droplets 

Perform the powerful cleaning. Subsequently, proceed to (4). 

More than half of the nozzles do 
not eject any ink-jet droplets 

Perform air bleeding in the tube. From the menu, select [Maintenance] > 
[Tube air bleed] and select the corresponding head and color. 

(4) Print out a nozzle check pattern (3rd time). 

(5) Check the result of the printed nozzle check pattern (3rd time), and carry out the following procedures. 
Existence or nonexistence of a 
nozzle that does not eject any 

ink-jet droplets 

Recovery action 

Such a nozzle does not exist that 
does not eject any ink-jet droplets 

Exit 

Such a nozzle exists that does not 
eject any ink-jet droplets 

Proceed to Step 3. 
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Step 3: Check that no ink-jet droplets are ejected from the applicable nozzle 

(1) Check locations of the non-ejecting nozzles on the result of the printed nozzle check pattern (1st to 3rd time), and 

carry out the following procedures. 
Comparison of non-ejection nozzle 

positions 
Recovery action 

The same nozzle always does not 
eject ink-jet droplets 

Perform the super cleaning -> print out of nozzle check pattern for the third 
time in a row. 

A different nozzle does not eject 
ink-jet droplets 

Leave the printer as it is for about 30 minutes, and perform the normal 
cleaning -> print out of nozzle check pattern for the third time in a row. 

(2) Check a result of the resultant nozzle check patterns, and carry out the following procedures. 
Existence or nonexistence of a 
nozzle that does not eject any 

ink-jet droplets 

Recovery action 

Such a nozzle does not exist that 
does not eject any ink-jet droplets 

Exit 

Such a nozzle exists that does not 
eject any ink-jet droplets 

Proceed to Step 4. 

 

Step 4: Clean the nozzle surface 

(1) Clean the nozzle surface of the print heads. 

(2) Make the clean stick R, cleaning cup, gloves and cleaning solution, which come standard with the printer, available 

for use. 
<IMPORTANT> 
• Use a new clean stick R when you start cleaning. 
• Never touch the tip end of clean stick R with your hand. If any sebaceous matter is attached to the head nozzle, it may 

result in the printer malfunction. 

(3) From the menu, select [Maintenance] > [Maintenance Part Clean/Replace] > [Clean nozzle guard and cap], and 

press . 

<IMPORTANT> 
• If any other error or message is displayed on the operation panel or warning message window, follow the message to solve 

the problem, then perform the cleaning. 
• Please complete the task within 15 minutes, in order to prevent the print heads from drying up. 
• Then, the head cleaning will be performed to prevent any ink from drying up. 

(4) Unlock and open the right-hand-side cover. 

 

Keyhole 
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(5) Put a proper amount of cleaning solution into the cleaning cup. 

(6) Moisten a clean stick R with the cleaning solution. 
<IMPORTANT> 
• Be sure to use a different clean stick R separately for the color head and the white head. Use a new clean stick R when you 

start cleaning. 
• Do not use other fluids (water, etc.), because they may damage the print heads. 
• Do not return the cleaning solution which has been put in the cleaning cup to the cleaning solution bottle. 
• Do not shed cleaning solution in the maintenance unit. 
<NOTE> 
• For a proper work operation, be sure to wear the printer-provided gloves. 

X1000 

 

Do not drain waste ink. 

Cleaning cup

Cleaning solution 

Clean stick R 

Cleaning cup
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(7) With a clean stick R, clean the nozzle surface of print head. 
<IMPORTANT> 
• Be sure not to bring corner edges of the clean stick R into contact with the nozzle surface. 
• Avoid roughly rubbing the nozzle surface. 
• The used clean stick R should be disposed of, and should not be reused. 

 

(8) Close the right-side cover and press  in response to the instructions on the screen. 

<NOTE> 
• Dispose of any waste resulting from the cleaning in accordance with applicable laws and ordinances. 
<TIPS> 
• Because the cleaning cup will be reused, rinse it in clean cleaning solution and store it in a safe place. 

(9) Print out a nozzle check pattern. 

(10) Check a result of the resultant nozzle check patterns, and carry out the following procedures. 
Existence or nonexistence of a 
nozzle that does not eject any 

ink-jet droplets 

Recovery action 

Such a nozzle does not exist that 
does not eject any ink-jet droplets 

Exit 

Such a nozzle exists that does not 
eject any ink-jet droplets 

Proceed to Step 5. 

 
<IMPORTANT> 
• Even if the nozzles on the white side have a bit of problem concerning firing, since the white ink is ejected on one same 

spot through multiple nozzles, relatively large amount of ink volume will be used, and firing problem of a single nozzle will 
not affect the print quality so much. Even in a condition with a problem concerning firing as shown in (a), print is performed 
without a problem as shown in (b). 

 

(a) (b) 

  

Clean stick R

Nozzle surface

Print head
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Step 5: Head Replacement 

(1) Replace the print head with a new one. ☞"6-1-12. Replacement of print head >>P.209" 

(2) If the non-ejection state persists after replacing the head, contact your dealer. 
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8-3.  Acquisition of log file 

In cases where the printer malfunctions, you may be required by our service personnel to obtain your printer's log file.  
For this reason, please save your printer's log file to a file. 
<TIPS> 
To the resultant file, such filename (.log) that automatically identifies your printer will be given. 
 

Fetch a log file from USB flash memory 

(1) Insert a USB flash memory into the insertion slot of the printer. 

(2) Press  on the operation panel located on the left side of printer to go to the menu. 

(3) Press , select [Maintenance] > [Log copy to USB], and press . 

 

 

 

(4) Then, the print button stops blinking, and the log file writing operation will be completed when you hear the sound of 

pong. 
<IMPORTANT> 
• Never remove the USB flash memory from the printer when the print button is blinking. Otherwise, the USB flash memory 

may be damaged, rendering its internal data to be unreadable. 

(5) Obtain the log file saved to the USB flash memory, and send such file to our service personnel. 

Log copy to USB

Set USB flash drive 

Press OK to Start 
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Fetch a log file via USB/LAN connection 

(1) On the PC, from [All Programs] in the Start menu, select the "GTX-6 Maintenance" from "Brother GTX-6 Tools". 

(2) After the window shown below appears, select the [Log Data Retrieval] and click [Next]. 

 

(3) Perform the required operation by following the on-screen instructions in the dialog box. 
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Error message 

What is shown below is the error message list of the GTX-6 printer. Any error message is displayed on the liquid crystal 
panel. 
 
Error code Error message Description Remedy 

0001 
[I failed in initialization. 
Turn off and on] 

No communication is 
established between the 
main board and panel board 
when the power is turned on.
(Displayed in English 
regardless of the selected 
language.) 

Check and see if any source produces a loud 
noise near the printer. 
If the problem persists even after reactivating 
the printer, please contact your dealer. 

0011 [Machine Error] 

No communication is 
established between the 
main board and color head 
board A when the power is 
turned on. 

Check and see if any source produces a loud 
noise near the printer.  
If the problem persists even after reactivating 
the printer, please contact your dealer. 

0012 [Machine Error] 

No communication is 
established between the 
main board and color head 
board B when the power is 
turned on. 

Check and see if any source produces a loud 
noise near the printer.  
If the problem persists even after reactivating 
the printer, please contact your dealer. 

0013 [Machine Error] 

No communication is 
established between the 
main board and white head 
board A when the power is 
turned on. 

Check and see if any source produces a loud 
noise near the printer.  
If the problem persists even after reactivating 
the printer, please contact your dealer. 

0014 [Machine Error] 

No communication is 
established between the 
main board and white head 
board B when the power is 
turned on. 

Check and see if any source produces a loud 
noise near the printer.  
If the problem persists even after reactivating 
the printer, please contact your dealer. 

0021 [Machine Error] 

No communication is 
established between the 
main board and actuator 
board 1 when the power is 
turned on. 

Check and see if any source produces a loud 
noise near the printer.  
If the problem persists even after reactivating 
the printer, please contact your dealer. 

0022 [Machine Error] 

No communication is 
established between the 
main board and actuator 
board 2 when the power is 
turned on. 

Check and see if any source produces a loud 
noise near the printer.  
If the problem persists even after reactivating 
the printer, please contact your dealer. 

0023 [Machine Error] 

No communication is 
established between the 
main board and actuator 
board 3 when the power is 
turned on. 

Check and see if any source produces a loud 
noise near the printer.  
If the problem persists even after reactivating 
the printer, please contact your dealer. 
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Error code Error message Description Remedy 

0042 [Machine Error] 

No communication is 
established between the 
main board and platen 
servomotor when the power 
is turned on. 

Check and see if any source produces a loud 
noise near the printer.  
If the problem persists even after reactivating 
the printer, please contact your dealer. 

0043 [Machine Error] 

No communication is 
established between the 
main board and carriage 
servomotor when the power 
is turned on. 

Check and see if any source produces a loud 
noise near the printer.  
If the problem persists even after reactivating 
the printer, please contact your dealer. 

0044 [Machine Error] 

No communication is 
established between the 
main board and white 
circulation solenoid board 
when the power is turned on.

Check and see if any source produces a loud 
noise near the printer.  
If the problem persists even after reactivating 
the printer, please contact your dealer. 

0110 [Machine Error] 

A communication error 
occurred between the main 
circuit board and the actuator 
circuit board (LEFT) while the 
printer was in operation. 

Check and see if any source produces a loud 
noise near the printer.  
If the problem persists even after reactivating 
the printer, please contact your dealer. 

0111 [Machine Error] 

A communication error 
occurred between the main 
circuit board and the actuator 
circuit board (BOTTOM) 
while the printer was in 
operation. 

Check and see if any source produces a loud 
noise near the printer.  
If the problem persists even after reactivating 
the printer, please contact your dealer. 

0112 [Machine Error] 

A communication error 
occurred between the main 
circuit board and the actuator 
circuit board (RIGHT) while 
the printer was in operation. 

Check and see if any source produces a loud 
noise near the printer.  
If the problem persists even after reactivating 
the printer, please contact your dealer. 

0120 [Machine Error] 

A communication error with 
the hardware in the actuator 
circuit board (LEFT) occurred 
while the printer was in 
operation. 

Check and see if any source produces a loud 
noise near the printer.  
If the problem persists even after reactivating 
the printer, please contact your dealer. 

0121 [Machine Error] 

A communication error with 
the hardware in the actuator 
circuit board (BOTTOM) 
occurred while the printer 
was in operation. 

Check and see if any source produces a loud 
noise near the printer.  
If the problem persists even after reactivating 
the printer, please contact your dealer. 

0122 [Machine Error] 

A communication error with 
the hardware in the actuator 
circuit board (RIGHT) 
occurred while the printer 
was in operation. 

Check and see if any source produces a loud 
noise near the printer.  
If the problem persists even after reactivating 
the printer, please contact your dealer. 
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Error code Error message Description Remedy 

0144 [Machine Error] 

A communication error 
occurred between the main 
circuit board and the white 
circulation circuit board while 
the printer was in operation. 

Check and see if any source produces a loud 
noise near the printer.  
If the problem persists even after reactivating 
the printer, please contact your dealer. 

1010 [Tank correction timing] 
The main tank remaining 
volume sensor needs to be 
corrected. 

Select [Correct tank volume sensor] menu item 
and correct the ink tank remaining volume 
sensor. 

1011 
[The tank needs 
corrections 
Execute correction] 

The ink tank remaining 
volume sensor needs to be 
corrected. 

Correct the ink tank remaining volume sensor 
following the instructions on the screen. 

1031 
[Color Head Getting 
Warm] 

The temperature of color 
head A is rising. 

Please wait until the temperature decreases.  
If the problem persists, please contact your 
dealer. 

1032 
[Color Head Getting 
Warm] 

The temperature of color 
head B is rising. 

Please wait until the temperature decreases.  
If the problem persists, please contact your 
dealer. 

1033 [W Head Temp Rising] 
The temperature of white 
head A is rising. 

Please wait until the temperature decreases.  
If the problem persists, please contact your 
dealer. 

1034 [W Head Temp Rising] 
The temperature of white 
head B is rising. 

Please wait until the temperature decreases.  
If the problem persists, please contact your 
dealer. 

1060 [Temp Low] 

The ambient temperature is 
lower than the scope covered 
by its warranty for the best 
print result. 

Raise your room temperature. 

1061 [Temp High] 

The ambient temperature is 
higher than the scope 
covered by its warranty for 
the best print result. 

Lower your room temperature. 

1064 [Humidity too Low] 

The humidity is lower than 
the scope covered by its 
warranty for the best print 
result. 

Turn on the humidification function and wait for 
a while. 

1065 [Humidity too High] 

The humidity is higher than 
the scope covered by its 
warranty for the best print 
result. 

Lower your room humidity. 

1070 
[Battery Needs to Be 
Replaced] 

It is time to replace the 
battery on the main board. 

Note the error code and error message, and 
notify your dealer. 

1080 [Please Adjust RTC] 
The built-in clock has not 
been set up. 

Note the error code and error message, and 
notify your dealer. 

1085 [Please Adjust RTC] 
The built-in clock has not 
been set up. 

Note the error code and error message, and 
notify your dealer. 

1090 
[Clean nozzle guard and 
cap] 

The cap needs to be 
cleaned. 

Select the [Clean nozzle guard and cap] menu 
item to perform cleaning. 

1091 
[Clean nozzle guard and 
cap] 

The cap needs to be 
cleaned. 

Select the [Clean nozzle guard and cap] menu 
item to perform cleaning. 



 

288 

Error message

Error code Error message Description Remedy 

1210 [Exhaust Fan Stop] 
The mist collection fan (right 
side) is not working. 

Note the error code and error message, and 
notify your dealer. 

1211 [Exhaust Fan Stop] 
The mist collection fan (left 
side) is not working. 

Note the error code and error message, and 
notify your dealer. 

1300 [Replace cap foam] 
The cap foam needs to be 
replaced. 

Select the [Replace maintenance unit parts] 
menu item and replace the cap foam. 

1301 [Replace cap foam] 
The cap foam needs to be 
replaced. 

Select the [Replace maintenance unit parts] 
menu item and replace the cap foam. 

1320 [Replace carriage foam] 
The carriage foam needs to 
be replaced. 

Select the [Replace maintenance unit parts] 
menu item and replace the carriage foam. 

1321 [Replace carriage foam] 
The carriage foam needs to 
be replaced. 

Select the [Replace maintenance unit parts] 
menu item and replace the carriage foam. 

1340 [Replace wiper] 
The wiper needs to be 
replaced. 

Select the [Replace maintenance unit parts] 
menu item and replace the wiper. 

1341 [Replace wiper] 
The wiper needs to be 
replaced. 

Select the [Replace maintenance unit parts] 
menu item and replace the wiper. 

1500 [Replace mist fan filter] 
The mist fan filter needs to be 
replaced. 

Select the [Replace mist fan filter] menu item 
and replace the mist fan filter. 

1501 [Replace mist fan filter] 
The mist fan filter needs to be 
replaced. 

Select the [Replace mist fan filter] menu item 
and replace the mist fan filter. 

1600 [Replace flushing foam] 
The flushing foam needs to 
be replaced. 

Select the [Replace maintenance unit parts] 
menu item and replace the flushing foam. 

1601 [Replace flushing foam] 
The flushing foam needs to 
be replaced. 

Select the [Replace maintenance unit parts] 
menu item and replace the flushing foam. 

1801 [None after head change] 

Because color head A has 
been replaced, the Install Ink 
after Replacing Head 
function needs to be put into 
execution. 

Select the [Install Ink after Replacing Head] 
menu item to install the ink for color head A. 

1802 [None after head change] 

Because color head B has 
been replaced, the Install Ink 
after Replacing Head 
function needs to be put into 
execution. 

Select the [Install Ink after Replacing Head] 
menu item to install the ink for color head B. 

1803 [None after head change] 

Because white head A has 
been replaced, the Install Ink 
after Replacing Head 
function needs to be put into 
execution. 

Select the [Install Ink after Replacing Head] 
menu item to install the ink for white head A. 

1804 [None after head change] 

Because white head B has 
been replaced, the Install Ink 
after Replacing Head 
function needs to be put into 
execution. 

Select the [Install Ink after Replacing Head] 
menu item to install the ink for white head B. 

1901 
[Perform Initial Ink 
Installation] 

Initial ink installation has not 
been performed yet. 

Select the [Initial Ink Installation] menu item to 
implement initial ink installation. 

1902 [Install initial ink (KYCM)] 
Initial ink installation for the 
color heads has not been 
performed yet. 

Install color ink using the [Initial Ink Installation] 
menu item and complete the process. 
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1903 [Install initial ink (W)] 
Initial ink installation for the 
white head has not been 
performed yet. 

Install white ink using the [Initial Ink Installation] 
menu item and complete the process. 

1910 
[Attach maintenance 
parts] 

Maintenance unit parts are 
not installed. 

Refer to the Setup Manual and use the 
[Replace maintenance unit parts] menu item to 
install wipers, flushing foam, carriage foam, etc.

1922 
[Time for technical 
maintenance  
Contact service engineer] 

Periodical maintenance and 
inspection are needed now. 

For help, please contact your dealer. 

1924 
[Time for technical 
maintenance  
Contact service engineer] 

Periodical maintenance and 
inspection are needed now. 

For help, please contact your dealer. 

1925 
[Time for technical 
maintenance  
Contact service engineer] 

Periodical maintenance and 
inspection are needed now. 

For help, please contact your dealer. 

1926 
[Time for technical 
maintenance  
Contact service engineer] 

Periodical maintenance and 
inspection are needed now. 

For help, please contact your dealer. 

2010 [Ink refill: Black] 
The remaining black ink 
volume is below the specified 
amount. 

Refill the black ink. 

2011 [Ink refill: Magenta] 
The remaining magenta ink 
volume is below the specified 
amount. 

Refill the magenta ink. 

2012 [Ink refill: Cyan] 
The remaining cyan ink 
volume is below the specified 
amount. 

Refill the cyan ink. 

2013 [Ink refill: Yellow] 
The remaining yellow ink 
volume is below the specified 
amount. 

Refill the yellow ink. 

2014 [Ink refill: White] 
The remaining white ink 
volume is below the specified 
amount. 

Refill the white ink. 

2015 
[Cleaning Solution Out - 
Add More] 

The remaining cleaning 
solution volume is below the 
specified amount. 

Refill cleaning solution. 

2050 [Temp Low] 

The ambient temperature 
decreases below the 
operation assurance range 
for the best print result. 

Raise your room temperature. 

2051 [Temp High] 

The ambient temperature 
rises above the operation 
assurance range for the best 
print result. 

Lower your room temperature. 

2055 [Humidity too Low] 
The humidity is lower than 
the operation assurance 
range for the best print result.

Turn on the humidification function and wait for 
a while. 
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2056 [Humidity too High] 
The humidity is higher than 
the operation assurance 
range for the best print result.

Lower your room humidity. 

2070 
[Obstacle Sensed on the 
Platen] 

The obstacle sensor has 
detected some obstacle on 
the platen or print medium. 

Remove such obstacle from the platen, flatten 
its surface, and press the OK button to clear the 
error. 

2071 
[Obstacle detected during 
print] 

The obstacle sensor has 
detected some obstacle on 
the platen or print medium 
while printing. 

Remove such obstacle from the platen, flatten 
its surface, and press the OK button to clear the 
error.  
Perform test printing and check the ejection 
from the head for any abnormalities.  
If the ejection is abnormal, immediately perform 
head cleaning to rectify the abnormality. 

2072 
[Platen is too low 
Adjust the position] 

The platen has been 
detected to be too low when 
attempting to start printing. 

The gap between the medium's print surface 
and the print head is too large. Make 
adjustments by raising the platen. 

2100 
[USB flash drive Not 
Ready] 

No USB flash memory has 
been inserted into its 
insertion slot. 

Use the supplied USB hub. 
Insert a USB flash memory into the slot, wait for 
a couple of seconds, and perform the operation. 
Insert a USB flash memory into the slot again. 
If the problem persists, check on the format and 
type of the USB flash memory. 

2101 [Not Enough Area] 

Writing is not possible 
because there is not enough 
free space in the USB flash 
memory. 

Use your PC to check free space on the USB 
flash memory. 
Insert the USB flash memory that has enough 
free space into the slot. 

2102 ― (Log only) 
The USB flash drive cannot 
be recognized. 

If the problem persists even after reactivating 
the printer, please contact your dealer. 

2105 [No Files Detected] 
No target file exists in a USB 
flash memory. 

Connect the USB flash memory to your PC for 
checking the information stored in it. 
If you have a saved file (ARX6 file or ARXP file 
or ARX4 file) in the USB flash memory, check 
the contents of the USB flash memory with a file 
viewer. 

2110 
[Receiving History W/O 
Error1] 

There has been no receiving 
history since the power was 
turned on. 

Press the OK button to clear the error. 

2120 
[Activate Print Data Auto 
Delete] 

Because the Print Data Auto 
Delete Enable function 
remains active, no receiving 
history menu is available. 

Press the OK button to clear the error. 
When you use the receiving history, disable the 
Print Data Auto Delete option. 

2230 
[Detected refilling of ink 
tank] 

Black ink was refilled to the 
main tank in an incorrect way.

Refill the ink following the on-screen 
instructions. 
To refill the ink, be sure to select the [Ink refill] 
menu item. 

2231 
[Detected refilling of ink 
tank] 

Magenta ink was refilled to 
the main tank in an incorrect 
way. 

Refill the ink following the on-screen 
instructions. 
To refill the ink, be sure to select the [Ink refill] 
menu item. 
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2232 
[Detected refilling of ink 
tank] 

Cyan ink was refilled to the 
main tank in an incorrect way.

Refill the ink following the on-screen 
instructions. 
To refill the ink, be sure to select the [Ink refill] 
menu item. 

2233 
[Detected refilling of ink 
tank] 

Yellow ink was refilled to the 
main tank in an incorrect way.

Refill the ink following the on-screen 
instructions. 
To refill the ink, be sure to select the [Ink refill] 
menu item. 

2234 
[Detected refilling of ink 
tank] 

White ink was refilled to the 
main tank in an incorrect way.

Refill the ink following the on-screen 
instructions. 
To refill the ink, be sure to select the [Ink refill] 
menu item. 

2235 
[Detected refilling of ink 
tank] 

Cleaning solution was refilled 
to the main tank in an 
incorrect way. 

Refill the ink following the on-screen 
instructions. 
To refill the ink, be sure to select the [Ink refill] 
menu item. 

2300 [Special work mode] 
Under the operation by the 
service engineer 

If the problem persists even after reactivating 
the printer, please contact your dealer. 

2330 

[Power was off for long 
time 
Executing recovery 
operation] 

The power has been turned 
off for a long time and a 
recovery operation is 
required. 

Follow the on-screen instructions and click the 
OK button to execute the recovery sequence.  
The recovery sequence depends on the length 
of time the printer is left turned off. 

2335 
[Long Power―OFF 
Detection] 

A state in which no recovery 
operation has been executed 
since the power was turned 
off for a long time. 

Follow the on-screen instructions and click the 
OK button to execute the recovery sequence.  
The recovery sequence depends on the length 
of time the printer is left turned off. 

2340 [Waste ink tank full] The waste ink tank is full. Empty the waste ink tank. 

2341 [Waste ink tank full] 
The waste ink tank will be full 
soon. 

Empty the waste ink tank. 

2342 
[Waste ink tank not in 
position] 

The waste ink tank is not 
installed. 

Install the waste ink tank. 

2345 [Right door open] The right door is open. Close the right door. 

2346 [Left door open] The left door is open. Close the left door. 

2347 [Upper door open] The upper door is open. Close the upper door. 

2350 [Right mist fan door open] 
The mist fan door on the right 
side is open. 

Close the mist fan door on the right side. 

2351 [Left mist fan door open] 
The mist fan door on the left 
side is open. 

Close the mist fan door on the left side. 

2355 [Door opened] 
Door opening while printing 
has caused an emergency 
stop of the printer. 

Follow the on-screen instructions after closing 
all doors and restart when the heads are 
capped. 
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3000 
[PC Communication 
Error] 

Data reception from the PC 
has been suspended. 

Make sure that your PC is connected to the 
printer, and resend the print data. If you have 
trouble, restart your PC and the printer.  
This error will also occur "when the cable is 
removed during data reception" or "when the 
ongoing operation is canceled on the PC during 
data reception". 

3001 
[PC Communication 
Error] 

Data transmission to the PC 
has been suspended. 

Make sure that your PC is connected to the 
printer, and start operating the PC tool over from 
the beginning. If you have trouble, restart your 
PC and the printer.  
This error may also occur "when the cable is 
removed during data transmission" or "when the 
PC tool is caused to stop running on the PC 
during data transmission". 

3002 [PC Data Error] 
Abnormal data has been 
received from the PC. 

Make sure that your PC is connected to the 
printer, and resend the print data. If you have 
trouble, restart your PC and the printer. 

3003 [PC Data Error] 
Unsupported data has been 
received from the PC. 

Update both the printer driver installed on the 
PC and the firmware of the printer to the latest 
version. 

3004 [PC Data Error] 
A communication error 
between the PC and printer. 

Ascertain whether the updated data of firmware 
you try to send is correct or not.  
Make sure that your PC is connected to the 
printer, and start communication between your 
PC and the printer once again. If the problem is 
still not remedied, restart your PC and the 
printer.  
If the problem persists, please contact your 
dealer. 

3005 [PC Data Error] 
A communication error 
between the PC and printer. 

Ascertain whether the updated data of firmware 
you try to send is correct or not.  
Make sure that your PC is connected to the 
printer, and start communication between your 
PC and the printer once again. If the problem is 
still not remedied, restart your PC and the 
printer.  
If the problem persists, please contact your 
dealer. 

3010 [PC Data Error] 
A communication error 
between the PC and printer. 

Make sure that your PC is connected to the 
printer, and start communication between your 
PC and the printer once again. If the problem is 
still not remedied, restart your PC and the 
printer.  
If the problem persists, please contact your 
dealer. 
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3013 [PC Data Error] 
A communication error 
between the PC and printer. 

Make sure that your PC is connected to the 
printer, and start communication between your 
PC and the printer once again. If the problem is 
still not remedied, restart your PC and the 
printer.  
If the problem persists, please contact your 
dealer. 

3014 [PC Data Error] 
A communication error 
between the PC and printer. 

Make sure that your PC is connected to the 
printer, and start communication between your 
PC and the printer once again. If the problem is 
still not remedied, restart your PC and the 
printer.  
If the problem persists, please contact your 
dealer. 

3015 
[Can no longer receive 
data] 

Too much print data has 
been sent from the PC during 
the print operation. 

Number of the print data sent from the PC 
during any print operation should be up to 99. 

3400 [PC Data Error] 
Abnormal data has been 
received from the PC. 

Check on the ARX6 file by means of "GTX-6 
File Viewer".  
Create the print data once again.  
If the problem persists, please contact your 
dealer. 

3401 [PC Data Error] 
Abnormal data has been 
received from the PC. 

Check on the ARX6 file by means of "GTX-6 
File Viewer".  
Create the print data once again.  
If the problem persists, please contact your 
dealer. 

3402 [PC Data Error] 
Abnormal data has been 
received from the PC. 

Check on the ARX6 file by means of "GTX-6 
File Viewer".  
Create the print data once again.  
If the problem persists, please contact your 
dealer. 

3407 [No Data in Print File] 
Print data with no images 
contained has been received 
from the PC. 

Check on the ARX6 file by means of "GTX-6 
File Viewer".  
For example, please confirm the print range and 
paper size for your software application through 
the Print Preview function, etc. of Photoshop. 

3408 [PC Data Error (too large)] 
Abnormal data has been 
received from the PC. 

Note the error code and error message, and 
notify your dealer. 

3410 [PC Data Error] 
Abnormal data has been 
received from the PC. 

Check on the ARX6 file by means of "GTX-6 
File Viewer".  
Make sure that your PC is connected to the 
printer, and start communication between your 
PC and the printer once again.  
Restart your PC and the printer.  
If the problem persists, please contact your 
dealer. 
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3411 [PC Data Error] 
Abnormal data has been 
received from the PC. 

Check on the ARX6 file by means of "GTX-6 
File Viewer".  
Make sure that your PC is connected to the 
printer, and start communication between your 
PC and the printer once again.  
Restart your PC and the printer.  
If the problem persists, please contact your 
dealer. 

3412 [PC Data Error] 
Abnormal data has been 
received from the PC. 

Check on the ARX6 file by means of "GTX-6 
File Viewer".  
Make sure that your PC is connected to the 
printer, and start communication between your 
PC and the printer once again.  
Restart your PC and the printer.  
If the problem persists, please contact your 
dealer. 

4100 
[USB flash drive Access 
Error] 

The file in the USB flash 
memory is not accessible. 

Check on the content of USB flash memory.  
Insert a USB flash memory into the slot again, 
and perform the required operation once more. 
If the problem is still not remedied, restart the 
printer and try to operate it once again. 

4101 
[USB flash drive Access 
Error] 

File creation is not possible in 
USB flash memory. 

Check on the content of USB flash memory.  
Insert a USB flash memory into the slot again, 
and perform the required operation once more. 
If the problem is still not remedied, restart the 
printer and try to operate it once again. 

4103 
[USB flash drive Access 
Error] 

The file in the USB flash 
memory is not accessible. 

Check on the content of USB flash memory.  
Insert a USB flash memory into the slot again, 
and perform the required operation once more. 
If the problem is still not remedied, restart the 
printer and try to operate it once again. 

4104 
[USB flash drive Access 
Error] 

The file in the USB flash 
memory is not readable. 

Check on the content of USB flash memory.  
Insert a USB flash memory into the slot again, 
and perform the required operation once more. 
If the problem is still not remedied, restart the 
printer and try to operate it once again. 

4105 
[USB flash drive Access 
Error] 

The file in the USB flash 
memory is not writable. 

Check on the content of USB flash memory.  
Insert a USB flash memory into the slot again, 
and perform the required operation once more. 
If the problem is still not remedied, restart the 
printer and try to operate it once again. 

4106 [Illegal Format] 
The file in the USB flash 
memory is not accessible. 

Check on the content of USB flash memory.  
Insert a USB flash memory into the slot again, 
and perform the required operation once more. 
If the problem is still not remedied, restart the 
printer and try to operate it once again. 
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4108 
[USB flash drive Access 
Error] 

The file in the USB flash 
memory is not readable. 

Check on the content of USB flash memory.  
Insert a USB flash memory into the slot again, 
and perform the required operation once more. 
If the problem is still not remedied, restart the 
printer and try to operate it once again. 

4200 [Machine Error] 
An error has been detected 
in the display data on the 
LCD screen. 

In the event that this error is displayed after 
suspending the updating of firmware, please 
start the updating operation over from the 
beginning.  
If the problem persists, please contact your 
dealer. 

4201 [Machine Error] 
An error has been detected 
in the display data on the 
LCD screen. 

In the event that this error is displayed after 
suspending the updating of firmware, please 
start the updating operation over from the 
beginning.  
If the problem persists, please contact your 
dealer. 

4202 [Machine Error] 
An error has been detected 
in the display data on the 
LCD screen. 

In the event that this error is displayed after 
suspending the updating of firmware, please 
start the updating operation over from the 
beginning.  
If the problem persists, please contact your 
dealer. 

4400 [Test print data Error] 
An error has been detected 
in the built-in test print data. 

In the event that this error is displayed after 
suspending the updating of firmware, please 
start the updating operation over from the 
beginning.  
If the problem persists, please contact your 
dealer. 

4401 [Test print data Error] 
An error has been detected 
in the built-in test print data. 

In the event that this error is displayed after 
suspending the updating of firmware, please 
start the updating operation over from the 
beginning.  
If the problem persists, please contact your 
dealer. 

4402 [Test print data Error] 
An error has been detected 
in the built-in test print data. 

In the event that this error is displayed after 
suspending the updating of firmware, please 
start the updating operation over from the 
beginning.  
If the problem persists, please contact your 
dealer. 

4500 [Machine Error] 
Network-related settings 
have been failed. 

Press the OK button to clear the error.  
Contact your network setup manager and 
network administrator.  
If the problem persists, please contact your 
dealer. 
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4501 [IP Address Setting Error] 
Network-related settings 
have been failed. 

Press the OK button to clear the error.  
Use the maintenance tool to set up a correct 
static IP address and subnet mask value once 
again. 

4502 [Machine Error] 
Network-related settings 
have been failed. 

Press the OK button to clear the error.  
Contact your network setup manager and 
network administrator.  
If the problem persists, please contact your 
dealer. 

4503 [Machine Error] 
Network-related settings 
have been failed. 

Press the OK button to clear the error.  
Use the maintenance tool to set up a correct 
static IP address of default gateway once again.

4504 [IP Address Setting Error] 
Network-related settings 
have been failed. 

Press the OK button to clear the error.  
Use the maintenance tool to set up a correct 
static IP address and subnet mask value once 
again. 

4505 [Machine Error] 
Network-related settings 
have been failed. 

Press the OK button to clear the error. 

4510 [Machine Error] 
Network-related settings 
have been failed. 

Press the OK button to clear the error.  
Make sure that the network settings are correct. 
Restart the printer and redo the network filtering 
settings if the settings are correct. 

5010 [PC Data Error] 
An error has been detected 
in the current print data being 
run. 

Press the OK button to clear the error.  
Create the print data again on the PC to load it 
to the printer, and try the print operation again. 

5020 [Machine Error] 
An error has been detected 
during carriage control. 

If the problem persists even after reactivating 
the printer, please contact your dealer. 

5021 [Machine Error] 
An error has been detected 
during the operation of the 
heads. 

If the problem persists even after reactivating 
the printer, please contact your dealer. 

5022 [Machine Error] 
An error has been detected 
during the operation of the 
heads. 

If the problem persists even after reactivating 
the printer, please contact your dealer. 

5080 [Machine Error] 
An error has been detected 
during maintenance unit 
control. 

If the problem persists even after reactivating 
the printer, please contact your dealer. 

5081 [Machine Error] 
An error has been detected 
during maintenance unit 
control. 

If the problem persists even after reactivating 
the printer, please contact your dealer. 

5094 [Machine Error] 
An error has been detected 
during platen loading. 

If the problem persists even after reactivating 
the printer, please contact your dealer. 

5095 [Machine Error] 
An error has been detected 
during platen unloading. 

If the problem persists even after reactivating 
the printer, please contact your dealer. 

5096 [Machine Error] 
An error has been detected 
while the platen is in 
operation during printing. 

If the problem persists even after reactivating 
the printer, please contact your dealer. 
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5200 [Machine Error] 
An error has been detected 
when the color 1 wiper was 
operated. 

Check and see if any source produces a loud 
noise near the printer.  
If the problem persists even after reactivating 
the printer, please contact your dealer. 

5201 [Machine Error] 
An error has been detected 
when the color 2 wiper was 
operated. 

Check and see if any source produces a loud 
noise near the printer.  
If the problem persists even after reactivating 
the printer, please contact your dealer. 

5202 [Machine Error] 
An error has been detected 
when the white 1 wiper was 
operated. 

Check and see if any source produces a loud 
noise near the printer.  
If the problem persists even after reactivating 
the printer, please contact your dealer. 

5203 [Machine Error] 
An error has been detected 
when the white 2 wiper was 
operated. 

Check and see if any source produces a loud 
noise near the printer. If the problem persists 
even after reactivating the printer, please 
contact your dealer. 

5210 [Machine Error] 
An error has been detected 
when the cap was operated. 

Check and see if any source produces a loud 
noise near the printer.  
If the problem persists even after reactivating 
the printer, please contact your dealer. 

5211 [Machine Error] 
An error has been detected 
when the cap was operated. 

Check and see if any source produces a loud 
noise near the printer.  
If the problem persists even after reactivating 
the printer, please contact your dealer. 

5221 [Machine Error] 

An error has been detected 
when the color 1 suction 
pump of the maintenance 
unit was operated. 

Check and see if any source produces a loud 
noise near the printer.  
If the problem persists even after reactivating 
the printer, please contact your dealer. 

5222 [Machine Error] 

An error has been detected 
when the color 2 suction 
pump of the maintenance 
unit was operated. 

Check and see if any source produces a loud 
noise near the printer.  
If the problem persists even after reactivating 
the printer, please contact your dealer. 

5223 [Machine Error] 

An error has been detected 
when the white 1 suction 
pump of the maintenance 
unit was operated. 

Check and see if any source produces a loud 
noise near the printer.  
If the problem persists even after reactivating 
the printer, please contact your dealer. 

5224 [Machine Error] 

An error has been detected 
when the white 2 suction 
pump of the maintenance 
unit was operated. 

Check and see if any source produces a loud 
noise near the printer.  
If the problem persists even after reactivating 
the printer, please contact your dealer. 

5229 [Machine Error] 

An error has been detected 
while checking the operation 
of the suction pump of the 
maintenance unit. 

Check and see if any source produces a loud 
noise near the printer.  
If the problem persists even after reactivating 
the printer, please contact your dealer. 

5600 [Machine Error] 
An error has been detected 
during IC stick control. 

Check that the IC stick is inserted correctly.  
If the problem persists even after reactivating 
the printer, please contact your dealer. 
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5601 [Machine Error] 
An error has been detected 
during IC stick control. 

Check that the IC stick is inserted correctly.  
If the problem persists even after reactivating 
the printer, please contact your dealer. 

5602 [Machine Error] 
An error has been detected 
during IC stick control. 

Check that the IC stick is inserted correctly.  
If the problem persists even after reactivating 
the printer, please contact your dealer. 

5951 [Machine Error] 
An error was detected in the 
platen servo motor. 

Restart the printer.  
If the problem persists even after reactivating 
the printer, please contact your dealer. 

5953 [Machine Error] 
An error was detected in the 
platen servo motor. 

Restart the printer.  
If the problem persists even after reactivating 
the printer, please contact your dealer. 

5954 [Platen motor power is off] 
The power to the platen 
servo motor has been cut off.

Release the power cut-off input to the platen 
motor amplifier. 

6004 [Machine Error] 
An error in the platen 
obstacle sensor has been 
detected. 

Check to see if the obstacle sensor is covered 
with something.  
If the problem persists even after reactivating 
the printer, please contact your dealer. 

6006 [Machine Error] 
The platen motor stopped 
abnormally. 

Check and see if any source produces a loud 
noise near the printer. 
Restart the printer, and from the menu, select 
[Printer Setting] > [Platen settings] > [Platen 
Break-in Run]. If the problem persists after three 
platen break-in runs, please contact your dealer.

6007 [Machine Error] 

An error has been detected 
while checking the 
mechanism for loading and 
unloading the platen. 

Check and see if any source produces a loud 
noise near the printer.  
If the problem persists even after reactivating 
the printer, please contact your dealer. 

6008 [Machine Error] 

An error has been detected 
while checking the 
mechanism for raising and 
lowering the platen. 

Check and see if any source produces a loud 
noise near the printer.  
If the problem persists even after reactivating 
the printer, please contact your dealer. 

6010 [Machine Error] 
An error has been detected 
when writing to the EEPROM 
on the main board. 

Check and see if any source produces a loud 
noise near the printer.  
If the problem persists even after reactivating 
the printer, please contact your dealer. 

6011 [Machine Error] 
An error has been detected 
when writing to the flash 
ROM on the main board. 

Check and see if any source produces a loud 
noise near the printer.  
If the problem persists even after reactivating 
the printer, please contact your dealer. 

6012 [Machine Error] 
An error has been detected 
when writing to the flash 
ROM on the main board. 

Check and see if any source produces a loud 
noise near the printer.  
If the problem persists even after reactivating 
the printer, please contact your dealer. 

6016 
[Do Not Allow Restore 
Data] 

An error has been detected 
when reading from the flash 
ROM on the panel board. 

Check and see if any source produces a loud 
noise near the printer.  
If the problem persists even after reactivating 
the printer, please contact your dealer. 
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Error code Error message Description Remedy 

6021 [No Battery Detected] 
The battery on the main 
board is dead. 

For help, please contact your dealer. 

6031 [Machine Error] 
An error has been detected 
in the platen button at the 
startup. 

Make sure that no buttons on the operation 
panel are pressed.  
If the problem persists, please contact your 
dealer. 

6033 [Machine Error] 
An error has been detected 
in the Cancel button at the 
startup. 

Make sure that no buttons on the operation 
panel are pressed.  
If the problem persists, please contact your 
dealer. 

6034 [Machine Error] 
An error has been detected 
in the Left-arrow button at the 
startup. 

Make sure that no buttons on the operation 
panel are pressed.  
If the problem persists, please contact your 
dealer. 

6035 [Machine Error] 
An error has been detected 
in the Right-arrow button at 
the startup. 

Make sure that no buttons on the operation 
panel are pressed.  
If the problem persists, please contact your 
dealer. 

6036 [Machine Error] 
An error has been detected 
in the Down-arrow button at 
the startup. 

Make sure that no buttons on the operation 
panel are pressed.  
If the problem persists, please contact your 
dealer. 

6037 [Machine Error] 
An error has been detected 
in the Up-arrow button at the 
startup. 

Make sure that no buttons on the operation 
panel are pressed.  
If the problem persists, please contact your 
dealer. 

6038 [Machine Error] 
An error has been detected 
in the head cleaning button at 
the startup. 

Make sure that no buttons on the operation 
panel are pressed.  
If the problem persists, please contact your 
dealer. 

6039 [Machine Error] 
An error has been detected 
in the MENU/OK button at 
the startup. 

Make sure that no buttons on the operation 
panel are pressed.  
If the problem persists, please contact your 
dealer. 

6040 [Machine Error] 
An error has been detected 
in the print button on the right 
side at the startup. 

Make sure that the corresponding button is not 
pressed.  
If the problem persists, please contact your 
dealer. 

6041 [Machine Error] 
An error has been detected 
in the print button on the left 
side at the startup. 

Make sure that the corresponding button is not 
pressed.  
If the problem persists, please contact your 
dealer. 

6042 [Machine Error] 
An error has been detected 
in the platen stop button on 
the right side at the startup. 

Make sure that the corresponding button is not 
pressed.  
If the problem persists, please contact your 
dealer. 
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6043 [Machine Error] 
An error has been detected 
in the platen stop button on 
the left side at the startup. 

Make sure that the corresponding button is not 
pressed.  
If the problem persists, please contact your 
dealer. 

6045 [Machine Error] 
A panel board for a different 
model is installed. 

Restart the printer and update the firmware 
again. Check if the firmware update file is for the 
model of your printer.  
If the problem persists, please contact your 
dealer. 

6046 [Machine Error] 
The main board firmware and 
panel board firmware are not 
compatible. 

Restart the printer and update the firmware 
again. Check if the firmware update file is for the 
model of your printer.  
If the problem persists, please contact your 
dealer. 

6070 [Machine Error] 

An error has been detected 
in the connector connection 
of the platen stop button on 
the right side. 

Check and see if any source produces a loud 
noise near the printer.  
If the problem persists even after reactivating 
the printer, please contact your dealer. 

6071 [Machine Error] 

An error has been detected 
in the connector connection 
of the platen stop button on 
the left side. 

Check and see if any source produces a loud 
noise near the printer.  
If the problem persists even after reactivating 
the printer, please contact your dealer. 

6105 [Machine Error] 
Carriage initialization has 
been failed. 

Check to see if something gets caught in the 
carriage or any foreign object exists inside the 
printer. Also, clean the printer interior.  
If the problem persists, please contact your 
dealer. 

6109 [Machine Error] Printing stopped abnormally. 

Check and see if any source produces a loud 
noise near the printer.  
If the problem persists even after reactivating 
the printer, please contact your dealer. 

6130 
[Machine Error  
Adjust CR] 

Abnormal decrease in the 
carriage speed has been 
detected. 

Clean the carriage.  
Refer to ☞"How to resolve carriage errors 6130 
and 6131 >>P.312" 
If the problem persists, please contact your 
dealer. 

6131 
[Machine Error  
Adjust CR] 

Abnormal decrease in the 
carriage speed has been 
detected. 

Clean the carriage.  
Refer to ☞"How to resolve carriage errors 6130 
and 6131 >>P.312" 
If the problem persists, please contact your 
dealer. 

6150 [Machine Error] 
Error detected in the carriage 
drive. 

Make sure you are powering the printer from a 
stable power source.  
Check and see if any source produces a loud 
noise near the printer.  
If the problem persists even after reactivating 
the printer, please contact your dealer. 
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Error code Error message Description Remedy 

6151 [Machine Error] 
An error was detected in the 
carriage servomotor. 

Restart the printer.  
If the problem persists even after reactivating 
the printer, please contact your dealer. 

6153 [Machine Error] 
An error was detected in the 
carriage servomotor. 

Restart the printer.  
If the problem persists even after reactivating 
the printer, please contact your dealer. 

6154 
[Carriage motor power is 
off] 

The power to the carriage 
servomotor has been cut off.

Release the power cut-off input to the platen 
motor amplifier. 

6221 [Machine Error] 
An error has been detected 
in the temperature of color 
head A. 

Ascertain whether or not the cable for the heads 
is disconnected.  
If the problem persists even after reactivating 
the printer, please contact your dealer. 

6222 [Machine Error] 
An error has been detected 
in the temperature of color 
head B. 

Ascertain whether or not the cable for the heads 
is disconnected.  
If the problem persists even after reactivating 
the printer, please contact your dealer. 

6223 [Machine Error] 
An error has been detected 
in the temperature of white 
head A. 

Ascertain whether or not the cable for the heads 
is disconnected.  
If the problem persists even after reactivating 
the printer, please contact your dealer. 

6224 [Machine Error] 
An error has been detected 
in the temperature of white 
head B. 

Ascertain whether or not the cable for the heads 
is disconnected.  
If the problem persists even after reactivating 
the printer, please contact your dealer. 

6231 [Machine Error] 
An error has been detected 
in the voltage of color head A.

Ascertain whether or not the cable for the heads 
is disconnected.  
If the problem persists even after reactivating 
the printer, please contact your dealer. 

6232 [Machine Error] 
An error has been detected 
in the voltage of color head B.

Ascertain whether or not the cable for the heads 
is disconnected.  
If the problem persists even after reactivating 
the printer, please contact your dealer. 

6233 [Machine Error] 
An error has been detected 
in the voltage of white head 
A. 

Ascertain whether or not the cable for the heads 
is disconnected.  
If the problem persists even after reactivating 
the printer, please contact your dealer. 

6234 [Machine Error] 
An error has been detected 
in the voltage of white head 
B. 

Ascertain whether or not the cable for the heads 
is disconnected.  
If the problem persists even after reactivating 
the printer, please contact your dealer. 

6241 [Machine Error] 
An error has been detected 
in the FFC connection of 
color head A. 

Ascertain whether or not the cable for the heads 
is disconnected.  
If the problem persists even after reactivating 
the printer, please contact your dealer. 

6242 [Machine Error] 
An error has been detected 
in the FFC connection of 
color head B. 

Ascertain whether or not the cable for the heads 
is disconnected.  
If the problem persists even after reactivating 
the printer, please contact your dealer. 
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6243 [Machine Error] 
An error has been detected 
in the FFC connection of 
white head A. 

Ascertain whether or not the cable for the heads 
is disconnected.  
If the problem persists even after reactivating 
the printer, please contact your dealer. 

6244 [Machine Error] 
An error has been detected 
in the FFC connection of 
white head B. 

Ascertain whether or not the cable for the heads 
is disconnected.  
If the problem persists even after reactivating 
the printer, please contact your dealer. 

6251 [Machine Error] 
An error has been detected 
in the fan of color head A. 

Check and see if any source produces a loud 
noise near the printer.  
If the problem persists even after reactivating 
the printer, please contact your dealer. 

6252 [Machine Error] 
An error has been detected 
in the fan of color head B. 

Check and see if any source produces a loud 
noise near the printer.  
If the problem persists even after reactivating 
the printer, please contact your dealer. 

6253 [Machine Error] 
An error has been detected 
in the fan of white head A. 

Check and see if any source produces a loud 
noise near the printer.  
If the problem persists even after reactivating 
the printer, please contact your dealer. 

6254 [Machine Error] 
An error has been detected 
in the fan of white head B. 

Check and see if any source produces a loud 
noise near the printer.  
If the problem persists even after reactivating 
the printer, please contact your dealer. 

6261 [48V Error (CL_A)] 
The power connection to the 
head control circuit board is 
incorrect. 

For help, please contact your dealer. 

6262 [48V Error (CL_B)] 
The power connection to the 
head control circuit board is 
incorrect. 

For help, please contact your dealer. 

6263 [48V Error (W_A)] 
The power connection to the 
head control circuit board is 
incorrect. 

For help, please contact your dealer. 

6264 [48V Error (W_B)] 
The power connection to the 
head control circuit board is 
incorrect. 

For help, please contact your dealer. 

7000 [Machine Error] 
The software detected an 
internal error. 

Check and see if any source produces a loud 
noise near the printer.  
If the problem persists even after reactivating 
the printer, please contact your dealer. 

7012 [Machine Error] 
The software detected an 
internal error. 

Check and see if any source produces a loud 
noise near the printer.  
If the problem persists even after reactivating 
the printer, please contact your dealer. 

7013 [Machine Error] 
The software detected an 
internal error. 

Check and see if any source produces a loud 
noise near the printer.  
If the problem persists even after reactivating 
the printer, please contact your dealer. 
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7015 [Machine Error] 
The software detected an 
internal error. 

Check and see if any source produces a loud 
noise near the printer.  
If the problem persists even after reactivating 
the printer, please contact your dealer. 

7020 [Machine Error] 
The software detected an 
internal error. 

Check and see if any source produces a loud 
noise near the printer.  
If the problem persists even after reactivating 
the printer, please contact your dealer. 

7021 [Machine Error] 
The software detected an 
internal error. 

Check and see if any source produces a loud 
noise near the printer.  
If the problem persists even after reactivating 
the printer, please contact your dealer. 

8040 [Machine Error] 
An error has been detected 
in the sensor of the black sub 
tank. 

Check and see if any source produces a loud 
noise near the printer.  
If the problem persists even after reactivating 
the printer, please contact your dealer. 

8041 [Machine Error] 
An error has been detected 
in the sensor of the yellow 
sub tank. 

Check and see if any source produces a loud 
noise near the printer.  
If the problem persists even after reactivating 
the printer, please contact your dealer. 

8042 [Machine Error] 
An error has been detected 
in the sensor of the cyan sub 
tank. 

Check and see if any source produces a loud 
noise near the printer. If the problem persists 
even after reactivating the printer, please 
contact your dealer. 

8043 [Machine Error] 
An error has been detected 
in the sensor of the magenta 
sub tank. 

Check and see if any source produces a loud 
noise near the printer.  
If the problem persists even after reactivating 
the printer, please contact your dealer. 

8044 [Machine Error] 
An error has been detected 
in the sensor of white 1 sub 
tank. 

Check and see if any source produces a loud 
noise near the printer.  
If the problem persists even after reactivating 
the printer, please contact your dealer. 

8045 [Machine Error] 
An error has been detected 
in the sensor of white 2 sub 
tank. 

Check and see if any source produces a loud 
noise near the printer.  
If the problem persists even after reactivating 
the printer, please contact your dealer. 

8060 [Machine Error] 
Failed to fill the black sub 
tank with ink. 

Check and see if any source produces a loud 
noise near the printer.  
If the problem persists even after reactivating 
the printer, please contact your dealer. 

8061 [Machine Error] 
Failed to fill the yellow sub 
tank with ink. 

Check and see if any source produces a loud 
noise near the printer.  
If the problem persists even after reactivating 
the printer, please contact your dealer. 

8062 [Machine Error] 
Failed to fill the cyan sub tank 
with ink. 

Check and see if any source produces a loud 
noise near the printer.  
If the problem persists even after reactivating 
the printer, please contact your dealer. 



 

304 

Error message

Error code Error message Description Remedy 

8063 [Machine Error] 
Failed to fill the magenta sub 
tank with ink. 

Check and see if any source produces a loud 
noise near the printer.  
If the problem persists even after reactivating 
the printer, please contact your dealer. 

8064 [Machine Error] 
Failed to fill the white 1 sub 
tank with ink. 

Check and see if any source produces a loud 
noise near the printer.  
If the problem persists even after reactivating 
the printer, please contact your dealer. 

8065 [Machine Error] 
Failed to fill the white 2 sub 
tank with ink. 

Check and see if any source produces a loud 
noise near the printer.  
If the problem persists even after reactivating 
the printer, please contact your dealer. 

8069 [Machine Error] 
Failed to fill the cleaning 
solution sub tank with ink. 

Check and see if any source produces a loud 
noise near the printer.  
If the problem persists even after reactivating 
the printer, please contact your dealer. 

8070 [Machine Error] 
Failed to discharge ink from 
the black sub tank. 

Check and see if any source produces a loud 
noise near the printer.  
If the problem persists even after reactivating 
the printer, please contact your dealer. 

8071 [Machine Error] 
Failed to discharge ink from 
the yellow sub tank. 

Check and see if any source produces a loud 
noise near the printer.  
If the problem persists even after reactivating 
the printer, please contact your dealer. 

8072 [Machine Error] 
Failed to discharge ink from 
the cyan sub tank. 

Check and see if any source produces a loud 
noise near the printer.  
If the problem persists even after reactivating 
the printer, please contact your dealer. 

8073 [Machine Error] 
Failed to discharge ink from 
the magenta sub tank. 

Check and see if any source produces a loud 
noise near the printer.  
If the problem persists even after reactivating 
the printer, please contact your dealer. 

8074 [Machine Error] 
Failed to discharge ink from 
the white 1 sub tank. 

Check and see if any source produces a loud 
noise near the printer.  
If the problem persists even after reactivating 
the printer, please contact your dealer. 

8075 [Machine Error] 
Failed to discharge ink from 
the white 2 sub tank. 

Check and see if any source produces a loud 
noise near the printer.  
If the problem persists even after reactivating 
the printer, please contact your dealer. 
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8080 [Machine Error] 

An error has been detected 
in the remaining volume 
sensor of the black main 
tank. 

Check and see if any source produces a loud 
noise near the printer.  
If the problem persists even after reactivating 
the printer, please contact your dealer. 

8081 [Machine Error] 

An error has been detected 
in the remaining volume 
sensor of the yellow main 
tank. 

8082 [Machine Error] 
An error has been detected 
in the remaining volume 
sensor of the cyan main tank.

8083 [Machine Error] 

An error has been detected 
in the remaining volume 
sensor of the magenta main 
tank. 

8084 [Machine Error] 

An error has been detected 
in the remaining volume 
sensor of the white main 
tank. 

8089 [Machine Error] 

An error has been detected 
in the remaining volume 
sensor of the cleaning 
solution main tank. 

8094 [Machine Error] 
Unable to agitate the white 
main tank. 

Check and see if any source produces a loud 
noise near the printer.  
If the problem persists even after reactivating 
the printer, please contact your dealer. 

8100 [Machine Error] 
Failed to fill the black head 
with ink. 

Check and see if any source produces a loud 
noise near the printer.  
If the problem persists even after reactivating 
the printer, please contact your dealer. 

8101 [Machine Error] 
Failed to fill the yellow head 
with ink. 

8102 [Machine Error] 
Failed to fill the cyan head 
with ink. 

8103 [Machine Error] 
Failed to fill the magenta 
head with ink. 

8104 [Machine Error] 
Failed to fill the white A head 
with ink. 

8105 [Machine Error] 
Failed to fill the white B head 
with ink. 

8200 
[During humidifier water 
supply 
an error was detected] 

An error has been detected 
when water was supplied to 
the humidifier unit. 

Make sure the humidifier is supplied with water. 
Check and see if the water supply tube is 
disconnected, torn, broken, or contaminated 
with air.  
If the problem persists, please contact your 
dealer. 

8201 
[During humidifier water 
supply 
an error was detected] 

An error has been detected 
when water was supplied to 
the humidifier unit. 

8202 
[During humidifier water 
supply 
an error was detected] 

An error has been detected 
when water was supplied to 
the humidifier unit. 

Make sure that the water supply pressure to the 
humidifier is not too high.  
If the problem persists, please contact your 
dealer. 
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8203 [Humidifier drainage error] 
An error has been detected 
when draining from the 
humidifier unit. 

Check and see if any source produces a loud 
noise near the printer.  
If the problem persists even after reactivating 
the printer, please contact your dealer. 

8207 
[Humidification error 
(Left)] 

The humidity did not rise 
properly. 

If the problem persists even after reactivating 
the printer, please contact your dealer. 

8210 
[Humi. drain tank not in 
position] 

The humidifier drain tank is 
not installed. 

Make sure that the humidifier drain tank is 
installed.  
If the problem persists even after reactivating 
the printer, please contact your dealer. 

8211 [Humidifier drain tank full] 
The humidifier drain tank is 
full. 

Empty the humidifier drain tank. 
8212 [Humidifier drain tank full] 

The humidifier drain tank will 
be full soon. 

8220 [Humidification error] 
An error has been detected 
in the humidification fan. 

Check and see if any source produces a loud 
noise near the printer.  
If the problem persists even after reactivating 
the printer, please contact your dealer. 

8221 [Machine Error] 

An error has been detected 
in the remaining volume 
sensor of the water supply 
tank of the humidifier unit. 

Check and see if any source produces a loud 
noise near the printer.  
If the problem persists even after reactivating 
the printer, please contact your dealer. 

8235 
[Humidifier fan filter 
change] 

The humidifier fan filter needs 
to be replaced with a new 
one. 

For help, please contact your dealer. 

8236 
[Humidifier fan filter 
change 
Contact service engineer] 

The humidifier fan filter needs 
to be replaced with a new 
one. 

For help, please contact your dealer. 

8237 [Humidification paused] 

The humidifier stopped. 
The humidifier fan filter needs 
to be replaced with a new 
one. 

For help, please contact your dealer. 

 
In the event that other error codes than those that are mentioned above are displayed, please contact your dealer for 
help. 
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How to resolve carriage errors 6130 and 6131 

 

(1) Unlock and open the right-side cover. 

 

(2) Loosen the two bolts on the carriage belt holder. 

 

<IMPORTANT> 
• Loosen the two bolts until there is a gap between each bolt's face and the part. 

 

(3) Tighten the two bolts on the carriage belt holder to 3.5 N-m. 

(4) Close and lock the right-side cover. 

 
Contact your dealer if you have any questions. 

 
 
 

Keyhole 
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10 Specifications 

10-1.  Apparatus 

Printing method Direct cloth printing by color ink jet printing 
Head Quantity 4 pcs. 
Resolution Maximum 1200 dpi x 1200 dpi 

Ink 
Type Water-based ink 

Number of colors 5 colors of CMYKW 
Material supply method Platen transportation method 
Supported 
media 
(size/thickness) 

Size 14 in. (355.6 mm) × 16 in. (406.4 mm) (standard platen) 
Thickness Up to 1.2 in. (30 mm) 

Printable area Maximum 24.2 in. (615 mm) × 24.2 in. (615 mm) 
Interface USB3.0, LAN (10BASE-T, 100BASE-TX, 1000BASE-T), USB flash memory 

External dimensions 

73.6 in. (width) x 75.6 in. (depth) x 57.5 in. (height) (1870 mm (width) x 1920 
mm (depth) x 1460 mm (height)) (Platen is accommodated) 
73.6 in. (width) x 81.1 in. (depth) x 57.5 in. (height) (1870 mm (width) x 2060 
mm (depth) x 1460 mm (height)) (including platen) 

Weight 680 kg (1499 lb) (including platen) 

Installation 
conditions 
Environment 

Power Single phase, 200 V-240 V, 50/60 Hz 
Power 

consumptions 
When active: 5 A max. 

Temper
ature 
and 
humidity 
environ
ment 

Recomm
ended 
print 
environ
ment 

Temperature: 18 
to 30°C (64.4 to 
86°F) 
Humidity: 35 to 
85% 
(no condensation)
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Working 
Environ
ment 

Temperature: 10 
to 35°C (50 to 
95°F) 
Humidity: 20 to 
85% 
(no condensation)

Storage 
environ
ment 

Temperature: 0 to 
40°C (32 to 
104°F) 
Humidity: 20 to 
85% 
(no condensation)

Print direction Bidirectional, unidirectional 

Fixation conditions 
Conveyor oven (recommended): 160°C (320 °F) for 3.5 minutes, or heat press: 
180°C (356°F) for 35 seconds 
* The time taken for fixation differs depending on the fixation device. 

Pretreatment 
Pretreatment is required when you print using white ink. 
Apply pretreatment with a pretreatment device and dry it up with a heat press. 

 

Printing-guaranteed range
Recommended print environment 
Working environment 
Storage environment 

Temperature (°C)
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10-2.  Software 

OS 
Windows 10 (64bit), Windows 11 (64bit), macOS Monterey, macOS Ventura, 
macOS Sonoma 
* Both Intel and M1/M2 are supported for macOS. 

Min. operating environment 
CPU with 2 GHz or above 
RAM with 4 GB or above 

Display resolution SXGA (1280 x 1024) or higher 
Output Printer driver, GTX Graphics Lab 
Application software for high-level 
image editing 

Adobe® Photoshop CC, Adobe® Illustrator CC, CorelDRAW® 2020/2021 
(Windows) 
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10-3.  Ink, cleaning solution, pretreatment 

10-3-1.  Ink 

Name Black / Magenta / Cyan / Yellow / White 
Use expiration date Expiration date printed on the bottle (supposing storage at normal temperature)
Storage temperature 0 to 40°C (32 to 104°F) 

Cautions for storage 

- Store them in a place where they are not exposed to direct sunlight. 
- Keep them out of the reach of children. 
- Store them away from fire, heat and oxidized substance. 
• Take care not to lose the IC stick. 

Content 9 L 
External 
dimensions in 
transport 
condition 

9 L (1-piece set) 10.0 in. (width) x 10.0 in. (depth) x 15.9 in. (height) (254 mm (width) x 254 mm 
(depth) x 405 mm (height)) 

 

10-3-2.  Cleaning solution 

Name Cleaning solution (for GTX-6) 
Use expiration date Expiration date on the container (supposing storage at normal temperature) 
Storage temperature 0 to 40°C (32 to 104°F) 

Cautions for storage 

- Store them in a place where they are not exposed to direct sunlight. 
- Keep them out of the reach of children. 
- Store them away from fire, heat and oxidized substance. 
-Cap the container tightly, and keep it in a cool, dark place with good ventilation.

Content 9 L 
External 
dimensions in 
transport 
condition 

9 L (1-piece set) 10.0 in. (width) x 10.0 in. (depth) x 15.9 in. (height) (254 mm (width) x 254 mm 
(depth) x 405 mm (height)) 

 

10-3-3.  Pretreatment 

Name Pretreatment 
Use expiration date Expiration date on the outer case (supposing storage at normal temperature) 
Storage temperature 0 to 40°C (32 to 104°F) 

Cautions for storage 

- Store them in a place where they are not exposed to direct sunlight. 
- Keep them out of the reach of children. 
- Store them away from fire, heat and oxidized substance. 
-Cap the container tightly, and keep it in a cool, dark place with good ventilation.

Content 200 kg (440 lb), 20 kg (44 lb), 5 kg (11 lb) 

External 
dimensions in 
transport 
condition 

200 kg (440 lb) 
(2-piece set) 

46.5 in. (width) x 23.6 in. (depth) x 40.6 in. (height) (1180 mm (width) x 600 mm 
(depth) x 1030 mm (height)) 

20 kg (44 lb) 
(1-piece set) 

10.4 in. (width) x 10.4 in. (depth) x 15.9 in. (height) (265 mm (width) x 265 mm 
(depth) x 405 mm (height)) 

5 kg (11 lb) 
(4-piece set) 

12.6 in. (width) x 18.0 in. (depth) x 12.5 in. (height) (320 mm (width) x 456 mm 
(depth) x 318 mm (height)) 
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10-4.  About consumable supplies, optional items and replacement parts 

About consumable supplies, optional items and replacement parts 
• Consumable supplies: Components required for the printing operation 
• Optional items: Available items through purchase order according to customers' usage status 
• Replacement parts: Components for which periodic maintenance needs to be performed for you to optimize the 

printer's operation 
Consumable supplies Code No. Code No. 

Black ink bottle 9 L GCX-6K09L-1 Baby platen X 
SB7001   18 L GCX-6K18L-1 (7.0 in. (178 mm) × 8.0 in. (203 mm)) 

Magenta ink bottle 9 L GCX-6M09L-1 Platen sheet 7×8 SB7002 
  18 L GCX-6M18L-1 Platen size S 

SC4870 
Cyan ink bottle 9 L GCX-6C09L-1 (10.0 in. (254 mm) × 12.0 in. (305 mm)) 
  18 L GCX-6C18L-1 Platen sheet 10×12 SC3058 
Yellow ink bottle 9 L GCX-6Y09L-1 Platen size M (Provided with the printer) 

SC4871   18 L GCX-6Y18L-1 (14.0 in. (356 mm) × 16.0 in. (406 mm)) 
White ink bottle 9 L GCX-6W09L Platen sheet 14×16 SC4577 
  18 L GCX-6W18L Platen size L 

SC4872 
Cleaning solution (for GTX-6) 9 L GCX-6E09L (16.0 in. (406 mm) × 18.0 in. (457 mm)) 
 18 L GCX-6E18L Platen sheet 16×18 SC3060 
Pretreatment 5 kg (11 lb) GCX-4P05 Platen size XL 

SC4873   20 kg (44 lb) GCX-4P20 (18.0 in. (457 mm) × 22.0 in. (559 mm)) 
  200 kg(440 lb) GCX-4P2H Platen sheet 18×22 SC3541 
<US Only> 5 kg (11 lb) GCX-4PS05 Platen size XXL 

SC4874   20 kg (44 lb) GCX-4PS20 (24.0 in. (610 mm) × 24.0 in. (610 mm)) 
  200 kg(440 lb) GCX-4PS2H Platen sheet 24×24 SC3542 
Maintenance kit A  

SC5033 

Water tank supply ASSY SC5068 
<Printer-supplied items>  Water T6040 20M SC5070 

Wiper 4 pcs. L-shaped fitting 06-06 SC5071 
Cap foam/Cap chip 4 pcs each. AC cord PSE SC6043 
Flushing foam 2 pcs. AC cord UL/CSA SC6044 
Plastic gloves  2 AC cord EUR SC6045 
Clean stick R 10 pcs. AC cord China SC6047 
Clean stick T 10 pcs. AC cord AU SC6046 
Carriage foam  SC5026 Replacement parts Code No. 
Clean stick R 50-piece set SB7008 White head A 

SC3355 
Clean stick T 50-piece set SC0032 White head B 
Cap foam/Cap chip 4 pcs each. SC5084 Color head A 

SC3340 
Flushing foam 2 pcs. SC4848 Color head B 
Wiper 4 pcs. SC4894 Main tank filter (color) SB7680 
Mist fan filter set  

SC5066 

Main tank filter (cleaning solution) SB7680 
<Printer-supplied items>  Main tank filter (white) SC1643 

Mist fan filter 2-piece set Return filter (white) SC1695 
Plastic gloves 2 Circulation filter (white) SB7680 

  Head filter (color) SB7093 
  Head filter (white) SC1695 
  Cleaning cup SB6925 
  Waste ink tank 

SC4946   Waste water tank 
  Humidifier fan filter SC5138 
  Encoder strip SC2555 
  Encoder sensor board SC3262 
  CR origin sensor LG2239 
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X1173 

 

 

Ink bottle for each color 
9 L 

Maintenance kit A Mist fan filter set 

Cleaning solution 
(for GTX-6) 9 L 

Pretreatment 
5 kg (11 lb)

Pretreatment
20 kg (44 lb)

Water tank supply ASSY 
White head Color head

Main tank filter 
(white) 

Carriage foam Clean stick R Clean stick T
Cap foam
Cap chip Flushing foam

Pretreatment 
200 kg (440 lb) 

Cleaning solution 
(for GTX-6) 18 L 

Ink bottle for each color
18 L 
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Open Source Licensing Remarks 
 
This product uses one or more of the following open software, depending on the features which each product has. 
 
gSOAP / SNMP Software from West Hawk / OpenSSL / Lua This software is used in all our products. 
 
MIT Kerberos 
This software is used in the product which supports the Kerberos Authentication. 
 
Cyrus SASL / OpenLDAP 
This software is used in the product which supports LDAP. 
 
expat/ LibTIFF/ libjpeg/ libpng 
This software is used in the product which supports RSS Reader, XPS emulation for Direct Print feature, or PDF 
creation module. 
 
libstrophe/json-c 
This software is used in the product which supports Google Cloud Print. 
 
Open SSH 
This software is used in the product which supports Secure Scan FTP. 
 
Open NFC / linux_libnfc-nci 
This software is used in the product which supports NFC. 
 
USB Host Driver (in FreeBSD) 
This software is used in the product which supports Direct Print / Scan to USB. 
 
mDNSResponder 
This software is used in the product which supports mDNS. 
 
wpa_supplicant and hostapd 
This software is used in the product which supports Wireless LAN or IEEE802.1X. 
  
 
T-Kernel 
This software is used in the product as Operating System. 
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The following is the full text. 
========================================================================================= 
Part of the software embedded in this product is gSOAP software. 
 
Portions created by gSOAP are Copyright (C) 2001 2004 Robert A. van Engelen, Genivia inc. All Rights Reserved. 
 
THE SOFTWARE IN THIS PRODUCT WAS IN PART PROVIDED BY GENIVIA INC AND ANY EXPRESS OR 
IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF 
MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE 
AUTHOR BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL 
DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; 
LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY 
THEORY OF LIABILITY,  WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR 
OTHERWISE) ARISING IN ANYWAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE 
POSSIBILITY OF SUCH DAMAGE. 
 
Permission to use, copy, modify, and distribute this software for any purpose and without fee is hereby granted, provided 
that the above copyright notices appear in all copies and that both the copyright notice and this permission notice appear 
in supporting documentation. This software is provided "as is" without express or implied warranty. 
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========================================================================================= 
This product includes SNMP software from WestHawk Ltd.  
 
Copyright (C) 2000, 2001, 2002 by Westhawk Ltd 
 
Permission to use, copy, modify, and distribute this software for any purpose and without fee is hereby granted, provided 
that the above copyright notices appear in all copies and that both the copyright notice and this permission notice appear 
in supporting documentation. This software is provided "as is" without express or implied warranty. 
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========================================================================================= 
MIT Kerberos statements 
 
 
--------------------------------------------------------------------------------------------------------- 
MIT Kerberos license copyright Version 1.6.3 
 
Copyright (C) 1985-2007 by the Massachusetts Institute of Technology. All rights reserved. 
 
Export of this software from the United States of America may require a specific license from the United States 
Government. It is the responsibility of any person or organization contemplating export to obtain such a license before 
exporting. 
 
WITHIN THAT CONSTRAINT, permission to use, copy, modify, and distribute this software and its documentation for 
any purpose and without fee is hereby granted, provided that the above copyright notice appear in all copies and that 
both that copyright notice and this permission notice appear in supporting documentation, and that the name of M.I.T. 
not be used in advertising or publicity pertaining to distribution of the software without specific, written prior permission. 
Furthermore if you modify this software you must label your software as modified software and not distribute it in such a 
fashion that it might be confused with the original MIT software. M.I.T. makes no representations about the suitability of 
this software for any purpose. 
It is provided "as is" without express or implied warranty. 
 
THIS SOFTWARE IS PROVIDED "AS IS" AND WITHOUT ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, 
WITHOUT LIMITATION, THE IMPLIED WARRANTIES OF MERCHANTIBILITY AND FITNESS FOR A PARTICULAR 
PURPOSE. 
 
Copyright (C) 1998 by the FundsXpress, INC. All rights reserved. 
 
Export of this software from the United States of America may require a specific license from the United States 
Government. It is the responsibility of any person or organization contemplating export to obtain such a license before 
exporting. 
 
WITHIN THAT CONSTRAINT, permission to use, copy, modify, and distribute this 
software and its documentation for any purpose and without fee is hereby granted, provided that the above copyright 
notice appear in all copies and that both that copyright notice and this permission notice appear in supporting 
documentation, and that the name of FundsXpress. not be used in advertising or publicity pertaining to distribution of the 
software without specific, written prior permission. FundsXpress makes no representations about the suitability of this 
software for any purpose. It is provided "as is" without express or implied warranty. 
 
THIS SOFTWARE IS PROVIDED "AS IS" AND WITHOUT ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, 
WITHOUT LIMITATION, THE IMPLIED WARRANTIES OF MERCHANTIBILITY AND FITNESS FOR A PARTICULAR 
PURPOSE. 
 
Copyright 1993, 1995 by OpenVision Technologies, Inc. 
 
Permission to use, copy, modify, distribute, and sell this software and its documentation for any purpose is hereby 
granted without fee, provided that the above copyright notice appears in all copies and that both that copyright notice 
and this permission notice appear in supporting documentation, and that the name of OpenVision not be used in 
advertising or publicity pertaining to distribution of the software without specific, written prior permission. OpenVision 
makes no representations about the suitability of this software for any purpose. It is provided "as is" without express or 
implied warranty. 
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OPENVISION DISCLAIMS ALL WARRANTIES WITH REGARD TO THIS SOFTWARE, INCLUDING ALL IMPLIED 
WARRANTIES OF MERCHANTABILITY AND FITNESS, IN NO EVENT SHALL OPENVISION BE 
LIABLE FOR ANY SPECIAL, INDIRECT OR CONSEQUENTIAL DAMAGES OR ANY DAMAGES WHATSOEVER 
RESULTING FROM LOSS OF USE, DATA OR PROFITS, WHETHER IN AN ACTION OF CONTRACT, NEGLIGENCE 
OR OTHER TORTIOUS ACTION, ARISING OUT OF OR IN CONNECTION WITH THE USE OR PERFORMANCE OF 
THIS SOFTWARE. 
 
Copyright 2000 by Zero-Knowledge Systems, Inc. 
 
Permission to use, copy, modify, distribute, and sell this software and its documentation for any purpose is hereby 
granted without fee, provided that the above copyright notice 
appear in all copies and that both that copyright notice and this permission notice appear in supporting documentation, 
and that the name of Zero-Knowledge Systems, Inc. not be used in advertising or publicity pertaining to distribution of 
the software without specific, written prior permission. Zero-Knowledge Systems, Inc. makes no representations about 
the suitability of this software for any purpose. It is provided ‘’as is’’ without express or implied warranty. 
 
ZERO-KNOWLEDGE SYSTEMS, INC. DISCLAIMS ALL WARRANTIES WITH REGARD TO THIS SOFTWARE, 
INCLUDING ALL IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS, IN NO EVENT SHALL 
ZERO-KNOWLEDGE SYSTEMS, INC. BE LIABLE FOR ANY SPECIAL, INDIRECT OR CONSEQUENTIAL 
DAMAGES OR ANY DAMAGES WHATSOEVER RESULTING FROM LOSS OF USE, DATA OR PROFITS, 
WHETHER IN AN ACTION OF CONTRACT, NEGLIGENCE OR OTHER TORTUOUS ACTION, ARISING OUT OF OR 
IN CONNECTION WITH THE USE OR PERFORMANCE OF THIS SOFTWARE. 
 
Copyright (c) 2006 Red Hat, Inc. 
 
Portions copyright (c) 2006 Massachusetts Institute of Technology All Rights Reserved. 
 
Redistribution and use in source and binary forms, with or without modification, are permitted provided that the following 
conditions are met: 
 
* Redistributions of source code must retain the above copyright notice, this list of conditions and the following 
disclaimer. 
 
* Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the following 
disclaimer in the documentation and/or other materials provided with the distribution. 
 
* Neither the name of Red Hat, Inc., nor the names of its contributors may be used to endorse or promote products 
derived from this software without specific prior written permission. 
 
THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS "AS IS" AND ANY 
EXPRESS OR IMPLIED WARRANTIES, 
  
 
INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A 
PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT OWNER OR 
CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT,  INCIDENTAL, SPECIAL, EXEMPLARY, OR 
CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS 
OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND 
ON ANY THEORY OF LIABILITY,  WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING 
NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF 
ADVISED OF THE POSSIBILITY OF SUCH DAMAGE. 
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Copyright 1995,1996,2003,2004 by Sun Microsystems, Inc. 
 
Permission to use, copy, modify, distribute, and sell this software and its documentation for any purpose is hereby 
granted without fee, provided that the above copyright notice appears in all copies and that both that copyright notice 
and this permission notice appear in supporting documentation, and that the name of Sun Microsystems not be used in 
advertising or publicity pertaining to distribution of the software without specific, written prior permission. Sun 
Microsystems makes no representations about the suitability of this software for any purpose. It is provided "as is" 
without express or implied warranty. 
 
SUN MICROSYSTEMS DISCLAIMS ALL WARRANTIES WITH REGARD TO THIS SOFTWARE, INCLUDING ALL 
IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS, IN NO EVENT SHALL SUN MICROSYSTEMS BE 
LIABLE FOR ANY SPECIAL, INDIRECT OR CONSEQUENTIAL DAMAGES OR ANY DAMAGES WHATSOEVER 
RESULTING FROM LOSS OF USE, DATA OR PROFITS, WHETHER IN AN ACTION OF CONTRACT, NEGLIGENCE 
OR OTHER TORTIOUS ACTION, ARISING OUT OF OR IN CONNECTION WITH THE USE OR PERFORMANCE OF 
THIS SOFTWARE. 
 
COPYRIGHT (C) 2006-2007 
 
THE REGENTS OF THE UNIVERSITY OF MICHIGAN ALL RIGHTS RESERVED. 
  
 
Permission is granted to use, copy, create derivative works and redistribute this software and such derivative works for 
any purpose, so long as the name of The University of Michigan is not used in any advertising or publicity pertaining to 
the use of distribution of this software without specific, written prior authorization. If the above copyright notice or any 
other identification of the University of Michigan is included in any copy of any portion of this software, then the 
disclaimer below must also be included. 
THIS SOFTWARE IS PROVIDED AS IS, WITHOUT REPRESENTATION FROM THE UNIVERSITY OF MICHIGAN 
AS TO ITS FITNESS FOR ANY PURPOSE, AND WITHOUT WARRANTY BY THE UNIVERSITY OF MICHIGAN OF 
ANY KIND, EITHER EXPRESS OR IMPLIED, INCLUDING WITHOUT LIMITATION THE IMPLIED WARRANTIES OF 
MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE. THE REGENTS OF THE UNIVERSITY OF 
MICHIGAN SHALL NOT BE LIABLE FOR ANY DAMAGES, INCLUDING SPECIAL, INDIRECT, INCIDENTAL, OR 
CONSEQUENTIAL DAMAGES, WITH RESPECT TO ANY CLAIM ARISING OUT OF OR IN CONNECTION WITH 
THE USE OF THE SOFTWARE, EVEN IF IT HAS BEEN OR IS HEREAFTER ADVISED OF THE POSSIBILITY OF 
SUCH DAMAGES. 
 
Copyright (c) 2002 Naval Research Laboratory (NRL/CCS) 
 
Permission to use, copy, modify and distribute this software and its documentation is hereby granted, provided that both 
the copyright notice and this permission notice appear in all copies of the software, derivative works or modified versions, 
and any portions thereof. 
 
NRL ALLOWS FREE USE OF THIS SOFTWARE IN ITS "AS IS" CONDITION AND DISCLAIMS ANY LIABILITY OF 
ANY KIND FOR ANY DAMAGES WHATSOEVER RESULTING FROM THE USE OF THIS SOFTWARE. 
 
Copyright (C) 1986 Gary S. Brown. You may use this program, or code or tables extracted from it, as desired without 
restriction. 
 
Copyright (c) 1994 CyberSAFE Corporation  
 
Copyright (c) 1993 Open Computing Security Group 
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========================================================================================= 
Cyrus SASL statements 
 
 
--------------------------------------------------------------------------------------------------------- 
The Cyrus SASL License 
 
Copyright (c) 1998-2003 Carnegie Mellon University. All rights reserved. 
 
Redistribution and use in source and binary forms, with or without modification, are permitted provided that the following 
conditions are met: 
 
1. Redistributions of source code must retain the above copyright notice, this list of conditions and the following 
disclaimer. 
 
2. Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the following 
disclaimer in the documentation and/or other materials provided with the distribution. 
 
3. The name "Carnegie Mellon University" must not be used to endorse or promote products derived from this software 
without prior written permission. For permission or any other legal details, please contact. 
 
Office of Technology Transfer  
Carnegie Mellon University  
5000 Forbes Avenue  
Pittsburgh, PA 15213-3890 
 
(412) 268-4387, fax: (412) 268-7395 
tech-transfer@andrew.cmu.edu 
 
4. Redistributions of any form whatsoever must retain the following acknowledgment: "This product includes software 
developed by Computing Services at Carnegie Mellon University (http://www.cmu.edu/computing/)." 
 
CARNEGIE MELLON UNIVERSITY DISCLAIMS ALL WARRANTIES WITH REGARD TO HIS SOFTWARE, 
INCLUDING ALL IMPLIED WARRANTIES OF 
MERCHANTABILITY AND FITNESS, IN NO EVENT SHALL CARNEGIE MELLON UNIVERSITY BE LIABLE FOR 
ANY SPECIAL, INDIRECT OR CONSEQUENTIAL DAMAGES OR ANY DAMAGES WHATSOEVER RESULTING 
FROM LOSS OF USE, DATA OR PROFITS, WHETHER IN AN ACTION OF CONTRACT, NEGLIGENCE OR OTHER 
TORTIOUS ACTION, ARISING OUT OF OR IN CONNECTION WITH THE USE OR PERFORMANCE OF THIS 
SOFTWARE. 
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========================================================================================= 
OpenSSL statements 
 
 
--------------------------------------------------------------------------------------------------------- 
OpenSSL License 
 
Copyright (c) 1998-2019 The OpenSSL Project. All rights reserved. 
 
Redistribution and use in source and binary forms, with or without modification, are permitted provided that the following 
conditions are met: 
 
1. Redistributions of source code must retain the above copyright notice, this list of conditions and the following 
disclaimer. 
 
2. Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the following 
disclaimer in the documentation and/or other materials provided with the distribution. 
 
3. All advertising materials mentioning features or use of this software must display the following acknowledgment: "This 
product includes software developed by the OpenSSL Project for use in the OpenSSL Toolkit. (http://www.openssl.org/)" 
 
4. The names "OpenSSL Toolkit" and "OpenSSL Project" must not be used to endorse or promote products derived 
from this software without prior written permission. For written permission, please contact opensslcore@openssl.org. 
 
5. Products derived from this software may not be called "OpenSSL" nor may "OpenSSL" appear in their names without 
prior written permission of the OpenSSL Project. 
 
6. Redistributions of any form whatsoever must retain the following acknowledgment: "This product includes software 
developed by the OpenSSL Project for use in the OpenSSL Toolkit (http://www.openssl.org/)" 
 
THIS SOFTWARE IS PROVIDED BY THE OpenSSL PROJECT “AS IS” AND ANY EXPRESSED OR IMPLIED 
WARRANTIES, INCLUDING, BUT NOT LIMITED TO, 
THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE 
DISCLAIMED. IN NO EVENT SHALL THE OpenSSL PROJECT OR ITS CONTRIBUTORS BE LIABLE FOR ANY 
DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT 
NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR 
PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, 
WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING 
IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH 
DAMAGE. 
 
This product includes cryptographic software written by Eric Young (eay@cryptsoft.com).  
This product includes software written by Tim Hudson (tjh@cryptsoft.com). 
 
--------------------------------------------------------------------------------------------------------- 
Original SSLeay License 
 
Copyright (c) 1995-1998 Eric Young (eay@cryptsoft.com) All rights reserved. 
 
This package is an SSL implementation written by Eric Young (eay@cryptsoft.com). The implementation was written so 
as to conform with Netscapes SSL. 
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This library is free for commercial and non-commercial use as long as the following conditions are aheared to. The 
following conditions apply to all code found in this distribution, be it the RC4, RSA, lhash, DES, etc., code; not just the 
SSL code. The SSL documentation included with this distribution is covered by the same copyright terms except that the 
holder is Tim Hudson (tjh@cryptsoft.com). 
 
Copyright remains Eric Young's, and as such any Copyright notices in the code are not to be removed. If this package is 
used in a product, Eric Young should be given attribution as the author of the parts of the library used. This can be in the 
form of a textual message at program startup or in documentation (online or textual) provided with the package. 
 
Redistribution and use in source and binary forms, with or without modification, are permitted provided that the following 
conditions are met: 
 
1. Redistributions of source code must retain the copyright notice, this list of conditions and the following disclaimer. 
 
2. Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the following 
disclaimer in the documentation and/or other materials provided with the distribution. 
 
3. All advertising materials mentioning features or use of this software must display the following acknowledgement: 
"This product includes cryptographic software written by Eric Young (eay@cryptsoft.com)" The word 'cryptographic' can 
be left out if the rouines from the library being used are not cryptographic related :-). 
 
4. If you include any Windows specific code (or a derivative thereof) from the apps directory (application code) you must 
include an acknowledgement: "This product includes software written by Tim Hudson (tjh@cryptsoft.com)" 
 
THIS SOFTWARE IS PROVIDED BY ERIC YOUNG “AS IS” AND ANY EXPRESS OR IMPLIED WARRANTIES, 
INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A 
PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE AUTHOR OR CONTRIBUTORS BE 
LIABLE FOR ANY DIRECT, INDIRECT,  INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES 
(INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, 
DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY,  
WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING 
IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH 
DAMAGE. 
 
The licence and distribution terms for any publically available version or derivative of this code cannot be changed. i.e. 
this code cannot simply be copied and put under another distribution licence [including the GNU Public Licence.] 
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========================================================================================= 
OpenLDAP Statements 
 
 
--------------------------------------------------------------------------------------------------------- 
This product includes software developed by the OpenLDAP Project. 
 
Unless otherwise expressly stated herein, The OpenLDAP Public License Version 2.8 shall be applied to individual files. 
 
Copyright 1998-2007 The OpenLDAP Foundation All rights reserved. 
 
Redistribution and use in source and binary forms, with or without modification, are permitted only as authorized by the 
OpenLDAP Public License. 
 
A copy of this license is available in the file LICENSE in the top-level directory of the distribution or, alternatively, at 
<http://www.OpenLDAP.org/license.html>. 
 
Portions Copyright 1999 Lars Uffmann. 
 
All rights reserved. 
 
Redistribution and use in source and binary forms, with or without modification, are permitted only as authorized by the 
OpenLDAP Public License. 
 
Portions Copyright (c) 1990, 1993-1996 Regents of the University of Michigan. All rights reserved. 
 
Redistribution and use in source and binary forms are permitted provided that this notice is preserved and that due credit 
is given to the University of Michigan at Ann Arbor. The name of the University may not be used to endorse or promote 
products derived from this software without specific prior written permission. This software is provided “as is” without 
express or implied warranty. 
 
Portions Copyright (c) 1999, 2000 Novell, Inc. All Rights Reserved. 
 
THIS WORK IS SUBJECT TO U.S. AND INTERNATIONAL COPYRIGHT LAWS AND 
TREATIES. USE, MODIFICATION, AND REDISTRIBUTION OF THIS WORK IS SUBJECT TO VERSION 2.0.1 OF 
THE OPENLDAP PUBLIC LICENSE, A COPY OF WHICH IS AVAILABLE AT 
HTTP://WWW.OPENLDAP.ORG/LICENSE.HTML OR IN THE FILE "LICENSE" IN THE TOP-LEVEL DIRECTORY OF 
THE DISTRIBUTION. ANY USE OR EXPLOITATION OF THIS WORK OTHER THAN AS AUTHORIZED IN VERSION 
2.0.1 OF THE OPENLDAP PUBLIC LICENSE, OR OTHER PRIOR WRITTEN CONSENT FROM NOVELL, COULD 
SUBJECT THE PERPETRATOR TO CRIMINAL AND CIVIL LIABILITY. 
 
Portions Copyright (c) The Internet Society (1997).  
 
See RFC 2251 for full legal notices. 
 
--------------------------------------------------------------------------------------------------------- 
The OpenLDAP Public License Version 2.8, 17 August 2003 
 
Redistribution and use of this software and associated documentation ("Software"), with or without modification, are 
permitted provided that the following conditions are met: 
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1. Redistributions in source form must retain copyright statements and notices, 
 
2. Redistributions in binary form must reproduce applicable copyright statements and notices, this list of conditions, and 
the following disclaimer in the documentation and/or other materials provided with the distribution, and 
 
3. Redistributions must contain a verbatim copy of this document. 
 
The OpenLDAP Foundation may revise this license from time to time. Each revision is distinguished by a version 
number. You may use this Software under terms of this license revision or under the terms of any subsequent revision of 
the license. 
 
THIS SOFTWARE IS PROVIDED BY THE OPENLDAP FOUNDATION AND ITS CONTRIBUTORS “AS IS” AND ANY 
EXPRESSED OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF 
MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE 
OPENLDAP FOUNDATION, ITS 
CONTRIBUTORS, OR THE AUTHOR(S) OR OWNER(S) OF THE SOFTWARE BE LIABLE FOR ANY DIRECT, 
INDIRECT,INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT 
LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR 
BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN 
CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY 
OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE. 
 
The names of the authors and copyright holders must not be used in advertising or otherwise to promote the sale, use or 
other dealing in this Software without specific, written prior permission. Title to copyright in this Software shall at all times 
remain with copyright holders. 
 
OpenLDAP is a registered trademark of the OpenLDAP Foundation. Copyright 1999-2003 The OpenLDAP Foundation, 
Redwood City,California, USA. All Rights Reserved. 
 
Permission to copy and distribute verbatim copies of this document is granted.  
 
A number of files contained in OpenLDAP Software contain a statement: 
 
USE, MODIFICATION, AND REDISTRIBUTION OF THIS WORK IS SUBJECT TO VERSION 2.0.1 OF THE 
OPENLDAP PUBLIC LICENSE, A COPY OF WHICH IS AVAILABLE AT 
HTTP://WWW.OPENLDAP.ORG/LICENSE.HTML OR IN THE FILE "LICENSE" IN THE TOP-LEVEL DIRECTORY OF 
THE DISTRIBUTION. 
 
The following is a verbatim copy of version 2.0.1 of the OpenLDAP Public License referenced in the above statement. 
 
--------------------------------------------------------------------------------------------------------- 
The OpenLDAP Public License 
 
Version 2.0.1, 21 December 1999 
Copyright 1999, The OpenLDAP Foundation, Redwood City, California, USA. All Rights 
Reserved. 
Redistribution and use of this software and associated documentation ("Software"), with or without modification, are 
permitted provided that the following conditions are met: 
 
1. Redistributions of source code must retain copyright statements and notices. Redistributions must also contain a 
copy of this document. 
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2. Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the following 
disclaimer in the documentation and/or other materials provided with the distribution. 
 
3. The name "OpenLDAP" must not be used to endorse or promote products derived from this Software without prior 
written permission of the OpenLDAP Foundation. For written permission, please contact foundation@openldap.org. 
 
4. Products derived from this Software may not be called "OpenLDAP" nor may "OpenLDAP" appear in their names 
without prior written permission of the OpenLDAP Foundation. OpenLDAP is a trademark of the OpenLDAP Foundation. 
 
5. Due credit should be given to the OpenLDAP Project (http://www.openldap.org/). 
 
THIS SOFTWARE IS PROVIDED BY THE OPENLDAP FOUNDATION AND CONTRIBUTORS “AS IS” AND ANY 
EXPRESSED OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF 
MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE 
OPENLDAP FOUNDATION OR ITS CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT,  INCIDENTAL, 
SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT 
OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) 
HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY,  WHETHER IN CONTRACT, STRICT LIABILITY, OR 
TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS 
SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE. 
 
--------------------------------------------------------------------------------------------------------- 
RFC 2251 Full Copyright Statement 
 
Copyright (c) The Internet Society (1997). All Rights Reserved. 
 
This document and translations of it may be copied and furnished to others, and derivative works that comment on or 
otherwise explain it or assist in its implementation may be prepared, copied, published and distributed, in whole or in part, 
without restriction of any kind, provided that the above copyright notice and this paragraph are included on all such 
copies and derivative works. However, this document itself may not be modified in any way, such as by removing the 
copyright notice or references to the Internet Society or other Internet organizations, except as needed for the purpose of 
developing Internet standards in which case the procedures for copyrights defined in the Internet Standards process 
must be followed, or as required to translate it into languages other than English. 
 
The limited permissions granted above are perpetual and will not be revoked by the Internet Society or its successors or 
assigns. 
 
This document and the information contained herein is provided on an "AS IS" basis and THE INTERNET SOCIETY 
AND THE INTERNET ENGINEERING TASK FORCE DISCLAIMS ALL WARRANTIES, EXPRESS OR IMPLIED, 
INCLUDING BUT NOT LIMITED TO ANY WARRANTY THAT THE USE OF THE 
INFORMATION HEREIN WILL NOT INFRINGE ANY RIGHTS OR ANY IMPLIED WARRANTIES OF 
MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE. 
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========================================================================================= 
expat 
 
Copyright (C) 1998, 1999, 2000 Thai Open Source Software Center Ltd and Clark Cooper 
Copyright (C) 2001, 2002, 2003, 2004, 2005, 2006 Expat maintainers. 
 
Permission is hereby granted, free of charge, to any person obtaining a copy of this software and associated 
documentation files (the "Software"), to deal in the Software without restriction, including without limitation the rights to 
use, copy, modify, merge, publish, distribute, sublicense, and/or sell copies of the Software, and to permit persons to 
whom the Software is furnished to do so, subject to the following conditions: 
 
The above copyright notice and this permission notice shall be included in all copies or substantial portions of the 
Software. 
 
THE SOFTWARE IS PROVIDED "AS IS", WITHOUT WARRANTY OF ANY KIND, EXPRESS OR IMPLIED, 
INCLUDING BUT NOT LIMITED TO THE WARRANTIES OF MERCHANTABILITY, FITNESS FOR A PARTICULAR 
PURPOSE AND NONINFRINGEMENT. IN NO EVENT SHALL THE AUTHORS OR COPYRIGHT HOLDERS BE 
LIABLE FOR ANY CLAIM, DAMAGES OR OTHER LIABILITY, WHETHER IN AN ACTION OF CONTRACT, TORT OR 
OTHERWISE, ARISING FROM, OUT OF OR IN CONNECTION WITH THE SOFTWARE OR THE USE OR OTHER 
DEALINGS IN THE SOFTWARE. 
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========================================================================================= 
Libtiff Copyright and License  
 
Use and Copyright 
 
Copyright (c) 1988-1997 Sam Leffler  
Copyright (c) 1991-1997 Silicon Graphics, Inc. 
 
Permission to use, copy, modify, distribute, and sell this software and its documentation for any purpose is hereby 
granted without fee, provided that (i) the above copyright notices and this permission notice appear in all copies of the 
software and related documentation, and (ii) the names of Sam Leffler and Silicon Graphics may not be used in any 
advertising or publicity relating to the software without the specific, prior written permission of Sam Leffler and Silicon 
Graphics. 
 
THE SOFTWARE IS PROVIDED "AS-IS" AND WITHOUT WARRANTY OF ANY KIND, EXPRESS, IMPLIED OR 
OTHERWISE, INCLUDING WITHOUT LIMITATION, ANY WARRANTY OF MERCHANTABILITY OR FITNESS FOR A  
PARTICULAR PURPOSE. 
 
IN NO EVENT SHALL SAM LEFFLER OR SILICON GRAPHICS BE LIABLE FOR ANY SPECIAL, INCIDENTAL, 
INDIRECT OR CONSEQUENTIAL DAMAGES OF ANY KIND, OR ANY DAMAGES WHATSOEVER RESULTING 
FROM LOSS OF USE, DATA OR PROFITS, WHETHER OR NOT ADVISED OF THE POSSIBILITY OF DAMAGE, 
AND ON ANY THEORY OF LIABILITY,  ARISING OUT OF OR IN CONNECTION WITH THE USE OR 
PERFORMANCE OF THIS SOFTWARE. 
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=========================================================================================l 
libjpeg 
 
this software is based in part on the work of the Independent JPEG Group 
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========================================================================================= 
libpng 
 
This copy of the libpng notices is provided for your convenience.  In case of 
any discrepancy between this copy and the notices in the file png.h that is 
included in the libpng distribution, the latter shall prevail. 
 
COPYRIGHT NOTICE, DISCLAIMER, and LICENSE: 
 
If you modify libpng you may insert additional notices immediately following 
this sentence. 
 
This code is released under the libpng license. 
 
libpng versions 1.2.6, August 15, 2004, through 1.6.2, April 25, 2013, are 
Copyright (c) 2004, 2006-2012 Glenn Randers-Pehrson, and are 
distributed according to the same disclaimer and license as libpng-1.2.5 
with the following individual added to the list of Contributing Authors 
 
   Cosmin Truta 
 
libpng versions 1.0.7, July 1, 2000, through 1.2.5 - October 3, 2002, are 
Copyright (c) 2000-2002 Glenn Randers-Pehrson, and are 
distributed according to the same disclaimer and license as libpng-1.0.6 
with the following individuals added to the list of Contributing Authors 
 
   Simon-Pierre Cadieux 
   Eric S. Raymond 
   Gilles Vollant 
 
and with the following additions to the disclaimer: 
 
   There is no warranty against interference with your enjoyment of the 
   library or against infringement.  There is no warranty that our 
   efforts or the library will fulfill any of your particular purposes 
   or needs.  This library is provided with all faults, and the entire 
   risk of satisfactory quality, performance, accuracy, and effort is with 
   the user. 
 
libpng versions 0.97, January 1998, through 1.0.6, March 20, 2000, are 
Copyright (c) 1998, 1999 Glenn Randers-Pehrson, and are 
distributed according to the same disclaimer and license as libpng-0.96, 
with the following individuals added to the list of Contributing Authors: 
 
   Tom Lane 
   Glenn Randers-Pehrson 
   Willem van Schaik 
 
libpng versions 0.89, June 1996, through 0.96, May 1997, are 
Copyright (c) 1996, 1997 Andreas Dilger 
Distributed according to the same disclaimer and license as libpng-0.88, 
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with the following individuals added to the list of Contributing Authors: 
 
   John Bowler 
   Kevin Bracey 
   Sam Bushell 
   Magnus Holmgren 
   Greg Roelofs 
   Tom Tanner 
 
libpng versions 0.5, May 1995, through 0.88, January 1996, are 
Copyright (c) 1995, 1996 Guy Eric Schalnat, Group 42, Inc. 
 
For the purposes of this copyright and license, "Contributing Authors" 
is defined as the following set of individuals: 
 
   Andreas Dilger 
   Dave Martindale 
   Guy Eric Schalnat 
   Paul Schmidt 
   Tim Wegner 
 
The PNG Reference Library is supplied "AS IS".  The Contributing Authors 
and Group 42, Inc. disclaim all warranties, expressed or implied, 
including, without limitation, the warranties of merchantability and of 
fitness for any purpose.  The Contributing Authors and Group 42, Inc. 
assume no liability for direct, indirect, incidental, special, exemplary, 
or consequential damages, which may result from the use of the PNG 
Reference Library, even if advised of the possibility of such damage. 
 
Permission is hereby granted to use, copy, modify, and distribute this 
source code, or portions hereof, for any purpose, without fee, subject 
to the following restrictions: 
 
1. The origin of this source code must not be misrepresented. 
 
2. Altered versions must be plainly marked as such and must not 
   be misrepresented as being the original source. 
 
3. This Copyright notice may not be removed or altered from any 
   source or altered source distribution. 
 
The Contributing Authors and Group 42, Inc. specifically permit, without 
fee, and encourage the use of this source code as a component to 
supporting the PNG file format in commercial products.  If you use this 
source code in a product, acknowledgment is not required but would be 
appreciated. 
 
 
A "png_get_copyright" function is available, for convenient use in "about" 
boxes and the like: 
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   printf("%s",png_get_copyright(NULL)); 
 
Also, the PNG logo (in PNG format, of course) is supplied in the 
files "pngbar.png" and "pngbar.jpg (88x31) and "pngnow.png" (98x31). 
 
Libpng is OSI Certified Open Source Software.  OSI Certified Open Source is a 
certification mark of the Open Source Initiative. 
 
Glenn Randers-Pehrson 
glennrp at users.sourceforge.net 
April 25, 2013  
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========================================================================================= 
libstrophe 
 
Copyright (c) 2005-2009 Collecta, Inc. 
 
Permission is hereby granted, free of charge, to any person obtaining a copy of this software and associated 
documentation files (the "Software"), to deal in the Software without restriction, including without limitation the rights to 
use, copy, modify, merge, publish, distribute, sublicense, and/or sell copies of the Software, and to permit persons to 
whom the Software is furnished to do so, subject to the following conditions: 
 
The above copyright notice and this permission notice shall be included in all copies or substantial portions of the 
Software. 
 
THE SOFTWARE IS PROVIDED "AS IS", WITHOUT WARRANTY OF ANY KIND, EXPRESS OR IMPLIED, 
INCLUDING BUT NOT LIMITED TO THE WARRANTIES OF MERCHANTABILITY, FITNESS FOR A PARTICULAR 
PURPOSE AND NONINFRINGEMENT. IN NO EVENT SHALL THE AUTHORS OR COPYRIGHT HOLDERS BE 
LIABLE FOR ANY CLAIM, DAMAGES OR OTHER LIABILITY, WHETHER IN AN ACTION OF CONTRACT, TORT OR 
OTHERWISE, ARISING FROM, OUT OF OR IN CONNECTION WITH THE SOFTWARE OR THE USE OR OTHER 
DEALINGS IN THE SOFTWARE. 
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========================================================================================= 
json-c 
 
Copyright (c) 2004, 2005 Metaparadigm Pte Ltd 
 
Permission is hereby granted, free of charge, to any person obtaining a copy of this software and associated 
documentation files (the "Software"), to deal in the Software without restriction, including without limitation the rights to 
use, copy, modify, merge, publish, distribute, sublicense, and/or sell copies of the Software, and to permit persons to 
whom the Software is furnished to do so, subject to the following conditions: 
 
The above copyright notice and this permission notice shall be included in all copies or substantial portions of the 
Software. 
 
THE SOFTWARE IS PROVIDED "AS IS", WITHOUT WARRANTY OF ANY KIND, EXPRESS OR IMPLIED, 
INCLUDING BUT NOT LIMITED TO THE WARRANTIES OF MERCHANTABILITY, FITNESS FOR A PARTICULAR 
PURPOSE AND NONINFRINGEMENT. IN NO EVENT SHALL THE AUTHORS OR COPYRIGHT HOLDERS BE 
LIABLE FOR ANY CLAIM, DAMAGES OR OTHER LIABILITY, WHETHER IN AN ACTION OF CONTRACT, TORT OR 
OTHERWISE, ARISING FROM, OUT OF OR IN CONNECTION WITH THE SOFTWARE OR THE USE OR OTHER 
DEALINGS IN THE SOFTWARE. 
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========================================================================================= 
Open SSH 
 
This file is part of the OpenSSH software. 
 
The licences which components of this software fall under are as follows. First, we will summarize and say 
that all components are under a BSD licence, or a licence more free than that. 
 
OpenSSH contains no GPL code. 
 
 
1) 

* Copyright (c) 1995 Tatu Ylonen <ylo@cs.hut.fi>, Espoo, Finland 
* All rights reserved 
* 
* As far as I am concerned, the code I have written for this software 
* can be used freely for any purpose. Any derived versions of this 
* software must be clearly marked as such, and if the derived work is 
* incompatible with the protocol description in the RFC file, it must be 
* called by a name other than "ssh" or "Secure Shell". 
 
[Tatu continues] 
* However, I am not implying to give any licenses to any patents or 
* copyrights held by third parties, and the software includes parts that 
* are not under my direct control. As far as I know, all included 
* source code is used in accordance with the relevant license agreements 
* and can be used freely for any purpose (the GNU license being the most 
* restrictive); see below for details. 
 
[However, none of that term is relevant at this point in time. All of these restrictively licenced software 
components which he talks about have been removed from OpenSSH, i.e., 
 
- RSA is no longer included, found in the OpenSSL library 
- IDEA is no longer included, its use is deprecated 
- DES is now external, in the OpenSSL library 
- GMP is no longer used, and instead we call BN code from OpenSSL 
- Zlib is now external, in a library 
- The make-ssh-known-hosts script is no longer included 
- TSS has been removed 
- MD5 is now external, in the OpenSSL library 
- RC4 support has been replaced with ARC4 support from OpenSSL 
- Blowfish is now external, in the OpenSSL library  
 
[The licence continues] 
 
Note that any information and cryptographic algorithms used in this software are publicly available on the 
Internet and at any major bookstore, scientific library, and patent office worldwide. More information can be 
found e.g. at "http://www.cs.hut.fi/crypto". 
 
The legal status of this program is some combination of all these permissions and restrictions. Use only at 
your own responsibility. You will be responsible for any legal consequences yourself; I am not making any 
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claims whether possessing or using this is legal or not in your country, and I am not taking any responsibility 
on your behalf. 

 
 

NO WARRANTY 
 
BECAUSE THE PROGRAM IS LICENSED FREE OF CHARGE, THERE IS NO WARRANTY 
FOR THE PROGRAM, TO THE EXTENT PERMITTED BY APPLICABLE LAW. EXCEPT WHEN 
OTHERWISE STATED IN WRITING THE COPYRIGHT HOLDERS AND/OR OTHER PARTIES 
PROVIDE THE PROGRAM "AS IS" WITHOUT WARRANTY OF ANY KIND, EITHER EXPRESSED 
OR IMPLIED, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF 
MERCHANTABILITY  AND  FITNESS  FOR  A PARTICULAR PURPOSE. THE ENTIRE RISK AS 
  
 
TO THE QUALITY AND PERFORMANCE OF THE PROGRAM IS WITH YOU. SHOULD THE 
PROGRAM PROVE DEFECTIVE, YOU ASSUME THE COST OF ALL NECESSARY SERVICING, 
REPAIR OR CORRECTION. 
 
IN NO EVENT UNLESS REQUIRED BY APPLICABLE LAW OR AGREED TO IN WRITING 
WILL ANY COPYRIGHT HOLDER, OR ANY OTHER PARTY WHO MAY MODIFY AND/OR 
REDISTRIBUTE THE PROGRAM AS PERMITTED ABOVE, BE LIABLE TO YOU FOR DAMAGES, 
INCLUDING ANY GENERAL, SPECIAL, INCIDENTAL OR CONSEQUENTIAL DAMAGES ARISING 
OUT OF THE USE OR INABILITY TO USE THE PROGRAM (INCLUDING BUT NOT LIMITED 
TO LOSS OF DATA OR DATA BEING RENDERED INACCURATE OR LOSSES SUSTAINED BY 
YOU OR THIRD PARTIES OR A FAILURE OF THE PROGRAM TO OPERATE WITH ANY OTHER 
PROGRAMS), EVEN IF SUCH HOLDER OR OTHER PARTY HAS BEEN ADVISED OF THE 
POSSIBILITY OF SUCH DAMAGES. 
 
4) 

The Rijndael implementation by Vincent Rijmen, Antoon Bosselaers and Paulo Barreto is in the public domain 
and distributed 
with the following license: 
 
* @version 3.0 (December 2000) 
* 
* Optimised ANSI C code for the Rijndael cipher (now AES) 
* 
* @author Vincent Rijmen <vincent.rijmen@esat.kuleuven.ac.be> 
* @author Antoon Bosselaers <antoon.bosselaers@esat.kuleuven.ac.be> 
* @author Paulo Barreto <paulo.barreto@terra.com.br> 
* 
* This code is hereby placed in the public domain. 
* 
* THIS SOFTWARE IS PROVIDED BY THE AUTHORS ''AS IS'' AND ANY EXPRESS 
* OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED 
* WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE 
* ARE   DISCLAIMED. IN NO EVENT SHALL THE AUTHORS OR CONTRIBUTORS BE 
* LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR 
* CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF 
* SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; 
OR 
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* BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY 
OF LIABILITY, 
* WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE 
* OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, 
* EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE. 

 
 
5) 

One component of the ssh source code is under a 3-clause BSD license, held by the University of California, 
since we pulled these parts from original Berkeley code. 
 
* Copyright (c) 1983, 1990, 1992, 1993, 1995 
* The Regents of the University of California. All rights reserved. 
* 
* Redistribution and use in source and binary forms, with or without 
* modification, are permitted provided that the following conditions 
* are met: 
* 1. Redistributions of source code must retain the above copyright 
* notice, this list of conditions and the following disclaimer. 
* 2. Redistributions in binary form must reproduce the above copyright 
* notice, this list of conditions and the following disclaimer in the 
* documentation and/or other materials provided with the distribution. 
* 3. Neither the name of the University nor the names of its contributors 
* may be used to endorse or promote products derived from this software 
* without specific prior written permission. 
* 
* THIS SOFTWARE IS PROVIDED BY THE REGENTS AND CONTRIBUTORS 
``AS IS'' AND 
* ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE 
* IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE 
* ARE DISCLAIMED. IN    NO    EVENT  SHALL   THE REGENTS OR CONTRIBUTORS BE LIABLE 
* FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL 
* DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS 
* OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) 
* HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT 
* LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY 
* OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF 
* SUCH DAMAGE. 

 
6) 

Remaining components of the software are provided under a standard 2-term BSD licence with the following 
names as copyright holders: 
 

Markus Friedl 
Theo de Raadt  
Niels Provos  
Dug Song  
Aaron Campbell  
Damien Miller  
Kevin Steves  
Daniel Kouril  
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Wesley Griffin  
Per Allansson  
Nils Nordman 
Simon Wilkinson 

 
* Redistribution and use in source and binary forms, with or without 
* modification, are permitted provided that the following conditions 
* are met: 
* 1. Redistributions of source code must retain the above copyright 
* notice, this list of conditions and the following disclaimer. 
* 2. Redistributions in binary form must reproduce the above copyright 
* notice, this list of conditions and the following disclaimer in the 
* documentation and/or other materials provided with the distribution. 
* 
* THIS SOFTWARE IS PROVIDED BY THE AUTHOR ``AS IS'' AND ANY EXPRESS OR 
* IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES 
* OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. 
* IN NO EVENT SHALL THE AUTHOR BE LIABLE FOR ANY DIRECT, INDIRECT, 
* INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT 
* NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, 
* DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY 
* THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR 
TORT 
* (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF 
* THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE. 
 

------ 
$OpenBSD: LICENCE,v 1.19 2004/08/30 09:18:08 markus Exp $ 
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========================================================================================= 
Open NFC 
 

Copyright (c) 2007-2010 Inside Secure, All Rights Reserved. 
 
Licensed under the Apache License, Version 2.0 (the "License"); you may not use this file except in compliance with 
the License. 
You may obtain a copy of the License at  
 
http://www.apache.org/licenses/LICENSE-2.0 
 
Unless required by applicable law or agreed to in writing, software distributed under the License is distributed on an 
"AS IS" BASIS, 
WITHOUT WARRANTIES OR CONDITIONS OF ANY KIND, either express or 
implied. 
See the License for the specific language governing permissions and limitations under the License. 
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========================================================================================= 
linux_libnfc-nci 
 

The original Work has been changed by NXP Semiconductors.  
 
Copyright (C) 2015 NXP Semiconductors 
 
Licensed under the Apache License, Version 2.0 (the "License"); you may not use this file except in compliance with 
the License. You may obtain a copy of the License at 
 
http://www.apache.org/licenses/LICENSE-2.0 
 
Unless required by applicable law or agreed to in writing, software distributed under the License is distributed on an 
"AS IS" BASIS, 
WITHOUT WARRANTIES OR CONDITIONS OF ANY KIND, either express or 
implied. 
See the License for the specific language governing permissions and limitations under the License. 
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========================================================================================= 
Lua 
 
Permission is hereby granted, free of charge, to any person obtaining a copy of this software and associated 
documentation files (the "Software"), to deal in the Software without restriction, including without limitation the rights to 
use, copy, modify, merge, publish, distribute, sublicense, and/or sell copies of the Software, and to permit persons to 
whom the Software is furnished to do so, subject to the following conditions: 
 
The above copyright notice and this permission notice shall be included in all copies or substantial portions of the 
Software. 
 
THE SOFTWARE IS PROVIDED "AS IS", WITHOUT WARRANTY OF ANY KIND, EXPRESS OR IMPLIED, 
INCLUDING BUT NOT LIMITED TO THE WARRANTIES OF MERCHANTABILITY, FITNESS FOR A PARTICULAR 
PURPOSE AND NONINFRINGEMENT. IN NO EVENT SHALL THE AUTHORS OR COPYRIGHT HOLDERS BE 
LIABLE FOR ANY CLAIM, DAMAGES OR OTHER LIABILITY, WHETHER IN AN ACTION OF CONTRACT, TORT OR 
OTHERWISE, ARISING FROM, OUT OF OR IN CONNECTION WITH THE SOFTWARE OR THE USE OR OTHER 
DEALINGS IN THE SOFTWARE. 
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========================================================================================= 
USB Host Driver (in FreeBSD) 
 
Copyright (c) 1992-2013 The FreeBSD Project. All rights reserved. 
 
Redistribution and use in source and binary forms, with or without modification, are permitted provided that the following 
conditions are met: 
1. Redistributions of source code must retain the above copyright notice, this list of conditions and the following 
disclaimer. 
2. Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the following 
disclaimer in the documentation and/or other materials provided with the distribution. 
 
THIS SOFTWARE IS PROVIDED BY THE AUTHOR AND CONTRIBUTORS ``AS IS'' AND ANY EXPRESS OR 
IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF 
MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE 
AUTHOR OR CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, 
OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE 
GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER 
CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT 
(INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, 
EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE. 
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========================================================================================= 
mDNSResponder 
 
Copyright (c) 2002-2013 Apple Computer, Inc. All rights reserved. 
 
Licensed under the Apache License, Version 2.0 (the "License"); you may not use this file except in compliance with the 
License. You may obtain a copy of the License at 
 
http://www.apache.org/licenses/LICENSE-2.0 
 
Unless required by applicable law or agreed to in writing, software distributed under the License is distributed on an "AS 
IS" BASIS, 
WITHOUT WARRANTIES OR CONDITIONS OF ANY KIND, either express or 
implied. 
See the License for the specific language governing permissions and limitations under the License. 
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========================================================================================= 
wpa_supplicant and hostapd 
 
Copyright (c) 2002-2014, Jouni Malinen <j@w1.fi> and contributors All Rights Reserved. 
 
These programs are licensed under the BSD license (the one with advertisement clause removed). 
 
If you are submitting changes to the project, please see CONTRIBUTIONS file for more instructions. 
 
 
This package may include either wpa_supplicant, hostapd, or both. See README file respective subdirectories 
(wpa_supplicant/README or hostapd/README) for more details. 
 
Source code files were moved around in v0.6.x releases and compared to earlier releases, the programs are now built 
by first going to a subdirectory (wpa_supplicant or hostapd) and creating build configuration (.config) and running 'make' 
there (for Linux/BSD/cygwin builds). 
 
 
License 
------- 
 
This software may be distributed, used, and modified under the terms of BSD license: 
 
Redistribution and use in source and binary forms, with or without modification, are permitted provided that the following 
conditions are met: 
 
1. Redistributions of source code must retain the above copyright notice, this list of conditions and the following 

disclaimer. 
 
2. Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the following 

disclaimer in the documentation and/or other materials provided with the distribution. 
 
3. Neither the name(s) of the above-listed copyright holder(s) nor the names of its contributors may be used to endorse 

or promote products derived from this software without specific prior written permission. 
 
THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS 
"AS IS" AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED 
WARRANTIES OF MERCHANTABILITY AND FITNESS FOR 
A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT 
OWNER OR CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, 
SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT 
LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, 
DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY 
THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR 
OTHERWISE) ARISING IN ANY WAY OUT OF THE USE 
OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE. 
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========================================================================================= 
T-Kernel 
 
This Product uses the Source Code of T-Kernel under T-License 2.0 granted by the T-Engine Forum (www.tengine. org) 

 



 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
*Please note that the contents of this manual may differ slightly from the actual product purchased as a result of product 
improvements. 
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